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About this workbook 
Welcome to this Infor Education course! We hope you will find this learning experience enjoyable and 
instructive. This Training Workbook is designed to support the following forms of learning: 

• Classroom instructor-led training 
• Virtual instructor-led training 
• Self-directed learning 

This Training Workbook is not intended for use as a product user guide. 

Activity data 
You will be asked to complete some practice exercises during this course. Step-by-step instructions are 
provided in this guide to assist you with completing the exercises. Where necessary, data columns are 
included for your reference. 

Your instructor will provide more information on systems used in class, including server addresses, login 
IDs, and passwords. 

Self-directed learning (SDL) 
If you are taking this course as self-directed learning, there may be instructor-recorded presentations 
and/or simulations available to assist you.  

If instructor-recorded presentations are available, a hyperlink to the recording will be included on the first 
page of each corresponding Lesson. 

If simulations are available, the demos and exercises throughout this Training Workbook will include 
hyperlinks that allow you to view and/or practice the execution of the demo or exercise in a simulated 
training environment. 

Learning Libraries 
Learning Libraries in Infor Campus include learning materials that are available to you online, anytime, 
anywhere. These materials can supplement instructor-led training, providing you with additional learning 
resources to support your day-to-day business tasks and activities.  

Please note that if you accessed this Training Workbook directly via a Learning Library, you will not have 
access to the Infor Education Training Environment that is provided with all instructor-led and most SDL 
course versions, as referenced above. Therefore, you will not be able to practice the exercises in the 
specific Training Environment for which the exercises in this Training Workbook were written. 
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Symbols used in this workbook 
 

 

Hands-on exercise 
(“Exercise”) 

 
Your notes 

 
Question 

 

Instructor demonstration 
(“Demo”)  

Important note 
 

Answer 

 

Can be used for either 
(“Scenario” or “Discussion”) 

 
Critical note 

 
Task simulation 

 
For your reference 
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Course overview 
Estimated time 
.25 hours 

Learning objectives 
Upon completion of this course, you’ll be able to manage:  

• Users 
• Teams and departments 
• Maintenance 
• Security: Lan and Web 
• Enhancements and Integrations 
• Web Client customization 
• Installation of Client components 

Topics 
• Course description and agenda 

 



 

12  Course overview 
  

 © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

Course description and agenda 
The Infor CRM Client manages all aspects of the sales cycle. Certain features of the Infor CRM Client 
require advanced configuration and management from an administrator. This course identifies the 
different administration procedures completed by both the Infor CRM Administrator and the Infor CRM 
Web Administrator.  

The Infor CRM Administrator is a network based program that can be accessed from any network 
connected computer where the Infor CRM Administrator is installed and appropriate security rights are 
given to the user.  

The Web Administrator allows users to easily configure most of these options as well, but from the same 
website you use to access other Infor CRM Web Client features. It’s a special interface which can only be 
accessed by a user logged on to the Web Client with appropriate admin security credentials or who has 
an administrative role assigned to his or her profile.  

The recommended agenda suggests completing Lessons 1-5 on Day 1, Lessons 6-11 on Day 2, and 
Lessons 12-14 on Day 3. You are welcome to work ahead if you have time. This training is for Infor CRM 
v8.4.  

Prerequisite courses 
• Infor CRM: v8.x Using Web 

Course duration 
20 hours 

Prerequisite knowledge 
To optimize your learning experience, Infor recommends participants have the following knowledge prior 
to attending this course: 

• Knowledge of Microsoft Windows operating systems, Microsoft Windows server technology and 
security, and Microsoft Internet Information Services (IIS) Manager 

• Knowledge of Microsoft® SQL Server® and relational database 
• Basic networking skills such as sharing folders and setting permissions 
• Experience using the Infor CRM Windows or Web Clients 

Audience 
• Business Consultant 
• Technical Consultant  
• Support 
• System Administrator  

System requirements 
• Infor CRM Training Environment 

Reference materials 
Infor CRM reference materials are available from the following locations:  
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• Infor CRM Help menu 
• Infor Xtreme® 

Course agenda 
The agenda below details the contents of this course, including lesson-level learning objectives and 
supporting objectives. 
 

Lesson Lesson title Learning objectives Day 

Course overview Review course expectations. 1 

1 Introduction to the Infor 
CRM Web Client 

• Explain the training environment 

• Describe and explore the Infor CRM Web Client 

• Describe and explore the Infor CRM Windows 
Client 

• List what’s new in Infor CRM v8.4 

• Learn about Office Profiles 

1 

2 User setup • Describe a New User Checklist prior to creating 
user 

• Explain the differences between user types 

• Create new users 

1 

3 Team and department 
setup 

• Discuss creating and using teams 

• Discuss creating and using departments 

• Describe what a user’s manager can see 

• Discuss security in regards to teams 

1 

4 Introduction to Infor CRM 
security 

• Describe how Infor CRM handles security 

• Discuss web security – secured actions and roles 

• Discover network security – feature and function 
security 

• Demonstrate field security 

• Explain Account Ownership 

1 

5 Sync Server setup • Identify the prerequisites to setting up a 
Synchronization Server Profile. 

• Understand what happens on the sync server 
during the synchronization process. 

1 
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Lesson Lesson title Learning objectives Day 

• Summarize the benefits of using a 
synchronization schedule. 

• Describe a scenario in which a synchronization 
conflict might occur. 

• Explain the purpose of a sync transfer profile. 

6 Remote/Offline database 
setup 

• Summarize user profile sync options. 

• Attach a Remote Database. 

• Create a Remote Database link. 

2 

7 System maintenance • Discuss scenarios that might require a manual 
backup or restore of a database. 

• Summarize the available data maintenance tools 
and their purposes. 

• Identify where to find system upgrade 
documentation and installation files. 

• Explain how to create Windows and Web 
development environments. 

2 

8 Integrations and 
enhancements 

• Discuss the different integration options Infor 
CRM has: Ming.LE, ION, BOE. 

• Discuss the enhancements available for outlook 

• Discuss Web Integrations Nav Bar. 

• Discuss Administrator integrations. 

2 

9 Web security • Describe how Infor CRM handles security. 

• Discuss creating and using Roles. 

• Discuss creating and using Secured Actions. 

• Describe the Security Manager. 

2 

10 Personalizing the Infor 
CRM Web Client 

Use the Admin Nav Bar features for 
“Personalization” of the Infor CRM Web Client. 

2 

11 Customizing the Infor CRM 
Web Client 

• Use Form Manager to edit forms. 

• Use Entity Manager to edit entities. 

• Learn about advanced developer customizations. 

2 

12 Windows security • Explore the different security features. 

• Explain administrative roles. 

3 



 

  Infor CRM: v8.4 Administering Training Workbook 15 
   

  © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

Lesson Lesson title Learning objectives Day 

• Explore feature security. 

• Define field security. 

• Examine function security. 

• Apply security. 

13 Prepare the Windows 
Client 

• Setup the Windows Client. 

• Manage the functions within the Manage toolbar. 

• Manage the functions within the Tools toolbar. 

3 

14 Remote network client 
setup 

• List the programs installed in a Remote Client 
(Windows) installation. 

• Understand what happens on the remote machine 
during the synchronization process. 

3 

Course summary Debrief course 3 

 

Appendices 
This section contains information that is not part of the instructional content of this course, but provides 
additional related reference information. 
 

Appendix Appendix title Content description 

Appendix A User accounts This appendix provides a reference for student login 
credentials. 

Appendix B Building test 
environments 

This appendix provides a reference for building test 
environments. 
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Lesson 1: Introduction to the Infor CRM 
Web Client 
Estimated time 
1 hour 

Learning objectives 
After completing this lesson, you will be able to navigate through the Infor CRM Web and Windows 
Clients. In this lesson, you will: 

• Explain the training environment. 
• Describe and explore the Infor CRM Web Client. 
• Describe and explore the Infor CRM Windows Client. 
• List what’s new in Infor CRM v8.4. 
• Learn about Office Profiles. 

Topics 
• The Infor CRM environment 
• The training environment 
• Navigate within Infor CRM 
• What’s new in v8.4 
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The Infor CRM environment 
This course focuses on how to handle administration of Infor CRM within the Infor CRM Web and 
Windows Clients. Although the system you will be administering may only have some of these features 
installed, understanding the various parts of the Infor CRM environment can assist with the administration 
of a complete system. It’s important to have a general understanding of all the features available within 
Infor CRM. 

The Infor CRM environment may include several parts which depend on each company’s implementation 
needs. Users can implement an environment to support the Infor CRM Windows Client (installed 
program), Web Client (website), or Mobile Client (HTML5-compatible device). 

Each implementation requires several components. Some are unique to a deployment, while others 
overlap. The following diagram lists the main components for each implementation type and illustrates 
which overlap. Throughout this course, you will learn how to install, configure, and administer many of 
these components as you deploy Infor CRM in a demonstration environment. 

 

Web
Web Client Offline Web Client
Web Adminstrator Desktop Integration
Web Host Customer Portal
Process Orchestration Job Service

Mobile
Mobile Client

Windows
Windows Client Remote Client
Remote Office Architect

Sync Client 
Sync Server 
Outlook Sync 
SpeedSearch 

SData 
Administrator 

Database Server 
Application Server 

Application Architect 
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The following is a list of components and the descriptions of each: 
 

Server Description 

Database Server Contains a Database Management System (Microsoft® SQL Server®, 
Microsoft SQL Express, or Oracle) supporting the SALESLOGIX (blank) 
and SALESLOGIX_EVAL (demo) databases. The physical connection to 
your Infor CRM database uses OLE DB Connection Pooling. 

Application Server 
(Infor CRM Server) 

Manages user connections to the database and enforces licensing. 

SpeedSearch Server Build indexes allows users to locate information in Infor CRM, such as 
defects, tickets, and documents within their network. SpeedSearch is also 
required for Web implementations using Lead Import and Duplicate 
Checker tools. 

Web Server Hosts the Infor CRM website and other portals, such as SData™ 
ProcessHost, Customer Portal, Mobile, Outlook Sync, and Job Service. 

Administrative Tool Description 

Windows Client 
(Windows) 

An Infor CRM Client application running as an installed program. Users 
interact with sales, marketing, service, and support data. It also includes the 
SpeedSearch Client. 

Web Client An Infor CRM Client application running on the Web server and accessed 
through a web browser. Users interact with sales, marketing, service, and 
support data. 

Xbar and Desktop 
Integration 

An optional program allowing Web Client users to record history for Outlook 
email messages, synchronize Outlook and Infor CRM, and view Infor CRM 
data within the Outlook application. Xbar (which includes Desktop 
Integration) requires SData™. 

Server Description 

Outlook Sync An optional installed program allowing users to synchronize calendar items, 
tasks, and contacts between Outlook and Infor CRM. Outlook Sync is 
available for both Windows (network/remote) and Web Client (online/offline) 
environments. 

Synchronization 
Component 

Description 

Synchronization 
Server (Sync Server) 

Runs the synchronization process and agents between the main Infor CRM 
database and all remotes. 

Synchronization 
Client 

An installed program on each remote user’s computer which transfers 
changes between the user’s local database and the main office database. 
Use with the Remote Client (Windows) or Offline Web Client. 

Remote Client 
(Windows) 

An Infor CRM Client application running as an installed program which 
connects to a local database (a subset of the main office database).  
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Remote Office An installation of Infor CRM at a location other than the main office where 
multiple offsite users connect to the offside network. The remote office 
database synchronizes all changes with the main office database. 

Offline Web Client An Infor CRM Web Client application running on the user’s machine using 
Infor CRM Personal Web Server which connects to a local database (a 
subset of the main office database). Users access the local website through 
a web browser and interact with sales, marketing, service, and support 
data. 

 

In addition to the core components, the capabilities of Infor CRM can be extended by implementing 
additional integrations, such as Sync for Exchange or Back Office Extension. These integrations enable 
users to synchronize common data between Infor CRM and external systems often containing 
overlapping data. Additional integrations may also be available from third party vendors and Infor CRM 
partners.  
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The training environment 
Prior to using Infor CRM, users should familiarize themselves with the scenario used in this training 
course. This includes learning basic information about the sample data you will be working with 
throughout this course. 

Getting to know the sample data 
The Infor CRM evaluation database known as SALESLOGIX_EVAL includes sample data used in this 
training course. Sample data belongs to a fictitious company known as Phoenix Computers. Knowing how 
Phoenix Computers is set up helps learners understand concepts in future lessons. 

Phoenix Computers sells products and services related to computer software, hardware, and technical 
support. They service approximately 1,000 accounts with 1,000 contacts in over 18 countries. 

Their company, staffed of 27 people is divided into ten departments: Channel Sales, Customer Service, 
Development, Field Sales, Inside Sales, IS, Marketing, PSG, Sales, and Tech Support. Everyone in the 
company has access to Infor CRM. 

Phoenix Computers uses the term “teams” to group people from different departments by physical region 
or specialty: Asia/Pac, EMEA, Global, Midwest, Northeast, Northwest, Southeast, Southwest, Tech 
Support—Hardware, and Tech Support—Software. 

 

 

There are two primary accounts used during training: 

 The administrative account: 

Username: Admin 

Password: [blank] 

This is the main administrative account for Phoenix Computers which is reserved 
for the Infor CRM Administrative team.  

 The user account used during training is Lee Hogan. Lee is a Field Sales 
Executive on the Midwest team.  

Username: Lee 

Password: [blank] 

 

Lee Hogan reports to Lou Pizzutti (Sales Manager, Americas) who reports directly to Pam Schwartz (VP 
of Sales). This information can be used to setup manager relationships for use in Account Ownership 
scenarios. 

 

Follow these steps to sign in to the Infor CRM Web Client for the first time: 

 Open Internet Explorer.  
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Although you can use Chrome 23+ or Firefox 24+ to access most of the features in 
the core web application, CRM recommends using Internet Explorer because it 
supports Mail Merge which isn’t available when using other browsers. 

 Type http://srv10:3333/SlxClient into the URL field if the window doesn’t default to the Infor CRM 
Sign In screen. 

 

Replace SRV10 with your Training Environment’s server name if different than 
SRV10. 

 Type Lee in the Username field. No password is required.  

 Click Sign in. The Infor CRM Web Client opens. 

 

 

http://srv10:3333/SlxClient
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Navigate within Infor CRM 
 

Demo: Navigating Infor CRM 
This demonstration shows how to navigate through the Infor CRM Web Client, Windows 
Client, and Administrator. Major components are identified, such as how to access the Infor 
CRM Web Administrator, general screens available in each client, and various menu options. 
This video is intended as a refresher to the UI of the Infor CRM clients. 

Notes: 

• To prepare the system for future exercises, this demo must be completed. 

• If you are taking this course as classroom or virtual instructor-led training, your instructor 
will demonstrate this task.  

• If you are taking this course as self-directed learning, you must complete the steps in this 
demonstration. 

 

Prior to reviewing the features in the Infor CRM Client, it’s important to learn to navigate the workspace so 
you may find information quickly. The following figure identifies components of the workspace. The 
Abbott Ltd. Account Detail view is shown in the example. 

 

 

The following section focuses on browsing the Infor CRM Web Client. The Infor CRM 
Windows Client has a similar UI, however, there are slight differences between the two. 
Keep this in mind throughout the course and make sure you’re in the correct application 
for each exercise. 

 

 
Infor CRM Web workspace 
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Using the Nav Bar 
The Nav Bar is the vertical row of features grouped on the left side of the workspace. Each group in the 
Nav Bar contains links to various views for working with data. To access views and data relevant to a 
specific job function, expand the appropriate Nav Bar group and then click the desired view. 
 

Action Description 

Expand a Nav Bar group Click a Nav Bar to expand the group. 

Open a main view Click a group to open the corresponding main view. 

Right-clicking a Nav Bar group This action opens view-specific functions. 
 

Using the menu bar 
The menu bar contains commands for commonly used Infor CRM operations. Users can select a menu 
option by clicking the item.  

Two commonly used menus are Recently Viewed and Write. Recently Viewed is a used to quickly 
navigate to previously viewed pages. The Write menu is only available if Enhanced Features is installed. 
Note: Menu items can be disabled for users. 

Using shortcut/context menus (right-click)  
Right-clicking activates context menus in many areas of Infor CRM. Right-clicking these areas displays 
menus relevant to the current view, however, not all areas have context menus. 

Editing items in a grid 
When you see an item in a grid, click once inside the cell to edit data. Note: Not all data grids have 
editable cells. 
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Using the toolbar 
The toolbar provides quick access to common Infor CRM functions. Icons are context-sensitive, meaning 
some icons may not be visible if they aren’t applicable to the current view.  

 

Icon Function Description 

 List view Displays different views visited since your last sign in to Infor CRM. 

 Save Saves your changes. Infor CRM prompts users to save changes before 
navigating away from a view. 

 Reset Clears the current data in the view. 

 Delete Deletes the current record. 

 Copy Copies the current information to your Windows clipboard. 

 Help Opens Infor CRM Help for the current view. 
 

Views in the Web Client 
There are two main views within Infor CRM: 

 List view 

 Detail view  

List views display information like a grid with columns and rows. To sort the grid by a specific field, click 
one of the column headings. Users can also customize their list view to suit their needs. Infor CRM 
remembers these changes each time a user logs in using the same browser and computer. Users can 
also hide or show the list view check boxes.  

Note: Within a list view, users can use the Summary view to see commonly used information for each 
record type. The information and available features depend on the record type. Information in this view 
displays in three columns:  
 

Column Description/Action 

Left Displays primary record information.  
Depending on the record type, you can: 

• Click the record name to open the detail view. 

• Click an email address to send an email. 

• Click a Web address to open a Web site in a new browser window. 

• If you’re looking at activities, click Complete to finalize the activity. 

Middle Displays additional information about the record that may include links to related 
records or read-only information. 

Right Displays related record types. 
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Depending on the record type, you can: 

• Click hyperlinks to open the detail view with the appropriate tab selected. 

• Click numerical values to view a list of the related records. For example, 
contacts or tickets. The list that appears may have hyperlinks to open the detail 
view for the related record. 

 

Detail views allow users to see, add, or edit information for a selected record. It consists of information 
fields, tabs, and a user-defined middle section.  

• The upper section shows basic information about the selected record. When adding a new 
record, dialog boxes guide users through entering the information that appears in the Detail view. 
To edit information, click the field you want to change. 

 
• The middle section, also known as the user-defined area, allows users to keep tabs they use 

most often visible. To move a tab to the middle section, click one of the tabs in the bottom 
section, hold the mouse, drag the tab to this area, and release.  

 

 

A green check mark indicates you’re in the correct area and appears as you’re dragging 
the tab. A red X might also appear which indicates you cannot drop that tab into the area 
you are in. 

 

• The tab remains open in the user-defined area each time you use the Infor CRM Web Client. If 
you want to change the tab in the middle section, drag it to the bottom section and drag a new tab 
up. 

 

 
Users can drag as many tabs as they want into the middle section and in any order.  
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• The lower section, also known as the Tab area, contains a group of additional tabs. Each tab 

shows specific information users need for the related record. Note: An administrator can create 
custom tabs for their company. 

 

Using the status bar 
The status bar is located at the bottom of the workspace and displays information about the current 
session, such as date and time, username logged on, and time zone. The Log Off button is also displayed 
here. Users can click the time zone to change it while traveling. Note: By default, the system logs a user 
off after 30 minutes of inactivity. 

Using the task pane 
The task pane displays to the right of the main window pane. It consists of filters, common tasks, and 
other features designed to help users complete their work. The available options depend on the record 
type and type of view where they’re working. 

From a list view, users can: 

• Filter records 
• Perform common tasks 

From a detail view, users can: 

• Use the Group List 
• Perform common tasks 
• Perform process tasks 

o Process tasks are only available if an administrator configures process orchestration. 

Filters 
Filters narrow the list of records in a list view group. The available filters are based on the columns in the 
selected list view and the information contained in those columns. To customize the list of filters to only 
include the filters you use for each group, use the Edit Filters option.  
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Each filter consists of the criteria selected. When applying a filter, only the records that meet all the 
criteria display. For example: 

• Account filter criteria: A, M 
• City filter criteria: Ann Harbor, Atlanta 
• Records returned: All records starting with A or M and located in Ann Harbor or Atlanta 

Common tasks 
Common tasks help user’s complete routine tasks efficiently. The available options depend on the record 
type and type of view where they’re working. Note: If zero records are selected prior to performing a 
common task, the user is asked if all records in the group should be used. If they click OK, all group 
records are selected regardless of any filters and the action is applied to all records in the group. 

Navigating records 
When a main view is open for Accounts, Contacts, Leads, Opportunities, Campaigns, Contracts, 
Defects, Returns, or Tickets, users can quickly find records by using Lookup, Nav arrows, or Group 
tabs. 

Lookup 
Lookup searches for a specific record depending on the current view. It’s located on the title bar of a main 
view and is available in both detail and list view modes. 

 

The following are examples of a Lookup search: 

• A: Finds all accounts that start with the letter “A” 
• AB: Finds all accounts that start with the letters “Ab” 
• [blank]: Displays all records 

 

 

Asterisks (*) are not recognized within the Lookup search box. If users want to find 
results containing a certain letter or string of letters, CRM recommends using the Query 
Builder tool. 

 

Change the default Lookup Condition by clicking Tools > Options > Group tab. Available choices 
include: starting with, contains, equal to, and not equal to. 
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Nav arrows 
Navigation arrows scroll forward or back through records in a group or go directly to the first or last 
record. The total number of records in the current group appears between the icons. Nav arrows are only 
available from the detail view of a record. 

Group tabs 
Group tabs are used to switch to a different group of records by selecting the tab you want to view. The 
manage groups options in the upper right corner of the current view is used to either switch to a different 
group of records or show/hide groups. 

Infor CRM Help 
Context-sensitive online Help is available for all features in the Infor CRM client. This includes the many 
administrative features within the product. The Infor CRM Web Client offers a getting started guide, quick 
reference card, and an about page in addition to the standard Web Client Help.  

Using Help 
After opening the Infor CRM Web Client Help, users are brought to the Help screen. By default, these 
help files are stored within Infor and can be accessed through a web browser. Companies can bring the 
help files internal if they don’t want to use the help files stored on Infor’s servers. This allows them to be 
stored and accessed on an intranet system if desired. 

From the Help screen, users can view the complete contents and index, and search for a specific topic. 
Links are included frequently within help files to see related items based on the help file they’re looking at. 
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What’s new 
In addition to improved product stability due to defect fixes, v8.4, contains the following new functionality. 

General enhancements 
• Desktop Integration has been separated into Office Integration and Outlook Integration. Outlook 

Integration is now part of Infor CRM Xbar for Microsoft Outlook. Both can be downloaded by 
users from the Web Client Tools, General tab. 

• The service used for integration is now run as a job through the Job Manager. The SData 
Synchronization Server is no longer required. 

• The Remote Sales Client deployment now includes SData configuration. 
• IIS configuration now supports versions of IIS above version 8. 
• SData portal performance has been enhanced. 
• Field level security information can now be queried and returned through SData. 
• Web Client Job Server clustering allows load sharing across multiple machines or multiple nodes 

on the same machine and to monitor Job Server statistics using SData or Windows Performance 
Counters. 

• Users with appropriate permissions can now remove bad records from the Sync Digest table. 
• New CreateUnicodeDB.exe tool enables converting an ANSI database to a Unicode database. 

The converted database will be approximately double the size of the existing database and the 
tool requires three times the size of the existing database to be able to run correctly. After 
converting, you must pipe log information to a file. See task 29 for details. 

Web Client enhancements 
• There are now separate options for setting language and regional formats. The new Regional 

Formats option determines date, time, number, and currency formats. Account Hierarchy 
provides the following: The ability to view a hierarchy view of the parent and all children and 
grandchildren of an account from the Account detail view. 

• Access to a quick view of frequently used entities (contacts, opportunities, sales orders and 
activities). 

• The error message "Mail details to your administrator" link now opens an e-mail message that 
can be sent to an email address defined by the administrator. 

• The Administrator can configure certain pick lists to support multiple languages. When 
configuration is complete, users can select a language on the Contact Detail view Details tab that 
will change the list items in the Prefix, Suffix, and Title pick lists for a particular contact. 

• When adding a new account, it is now possible to look for potential matching records. 
• When moving a contact, there is a new option to assign all items to the same contact. 
• Showing groups has been replaced by group Favorites. Favorites determine which groups display 

as tabs on list and detail views. 
• Export to File and Export to Excel have been combined and renamed “Export” in the Common 

Tasks pane and from the right-click menu. 
• Export performance has been improved by including a limit to the number of records to be 

exported and adding the ability to turn off exporting pivot tables to Microsoft Excel. 
• The new Sales Intelligence feature includes the ability to view the likelihood that a contact or 

account will make a purchase and provides a Recommendations tab that recommends products 
the contact or account is likely to purchase in the next 30 days. 

• Completed meetings now display contact and account information on the Calendar. 
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• Contour integration provides the ability to map contact and account addresses in order to view 
contacts and accounts that are near one another. You can also add places that are not contacts 
or accounts, such as a hotel or airport. 

• The Account detail view Sales Order tab includes additional information. 
• The Local Pricing feature allows you to choose, on a per entity basis, between the ERP Pricing 

Service or local Infor CRM pricing which allows users to modify product pricing and discount 
amounts in Infor CRM. Using local pricing is only recommended for entities that are not 
synchronized to an ERP system. 

• Creating an ad hoc group with a large number of records now uses the Job Manager. 
• Improvements to Reporting performance. 
• New common task on the Group Manager view to determine which groups will be marked as 

Favorites by default for new users. 
• Integration with the LinkedIn Sales Navigator enables Infor CRM users who have a LinkedIn 

membership and have subscribed to the LinkedIn Sales Navigator feature to see a widget of 
Sales Navigator in a tab on the Infor CRM Account, Contact, and Lead Detail views. 

• In the Infor CRM Account Detail view, the Widget locates and displays other recommended leads, 
connections and news for the selected account available through your LinkedIn network. 

• On the Contact and Lead detail views, the LinkedIn Sales Navigator tab displays the Icebreaker, 
Related Leads, and Get Introduced information. 

• The version of Contour provided with Infor CRM v8.4 is compatible with Microsoft Bing. If your 
installation includes a version of Contour provided in Infor CRM v8.3 Update 03 or later, your 
Contour integration with Google will still function, however it is no longer visible in the UI. 

Back Office Integration enhancements 
The following improvements are available for implementations that include Back Office Extension integration with a 
supported ERP system: 

• Infor CRM can now be set to function as the authoritative system of record for Opportunities in an 
integration between Infor CRM and a supported ERP system through Infor ION. 

• Normalize Base Currency provides an option to store data published by an ERP in terms of the 
Infor CRM base currency. This allows customers who opt for this service, to work in Infor CRM 
using the Infor CRM base currency even though the integrated back office ERP system uses a 
different base currency. 

• ION Workflow enables Infor CRM users to initiate a workflow defined in ION from within Infor 
CRM. The trigger can be defined as conditional or manual in Infor CRM and the trigger can be 
extended to other entities. 

• Discrete Address provides the option to use a discrete type of address if it is passed from an 
integrated back office ERP system. 

• New logging and exception handling for Price and Availability in the Infor CRM Web Client. 
• Master Data Consolidation is an optional feature that: 
• Consolidates duplicate accounts with the same CustomerID, which can result from host systems 

such, as ERP-M3, ERP-LX and ERP-Visual, into a single Infor CRM account record. This applies 
to Accounts, Ship Tos, Bill Tos, Pay Froms, Contacts, Persons, and Products. 

• Adds a filter icon and logic for each of the integrated transactional master data tabs; Account 
Quotes tab, Account Sales Orders tab, Account Shipments tab, Account Invoices tab, Account 
Receivables tab, Account Returns tab, Ship To Sales Orders tab, Ship To Shipments tab, Ship To 
Invoices tab, Ship To Receivables tab, Ship To Returns tab, Bill To Sales Orders, Bill To Invoices, 
Bill To Receivables and Bill To Returns. The new tab filter control supports filtering the tab 
content by Accounting Entity and/or by ERP Status. If the ERP integration is later disabled, the 
Quote and Sales Order filters revert to showing the Infor CRM status. 
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• The Local Pricing feature allows you to choose, on a per entity basis, between the ERP Pricing 
Service or local Infor CRM pricing which allows users to modify product pricing and discount 
amounts in Infor CRM. Using local pricing is only recommended for entities that are not 
synchronized to an ERP system. 

• Improvements for customizing and upgrading customized BOD mappings and BOD field 
mappings which previously could not be upgraded. 

• A new Language Code option for supporting integrated content in a localized environment. 
• The Account Invoice Aging tab provides summarized past due invoice aging content. All host 

ERP invoices with past due payment due dates and an ERP status of Open or PartialPaid are 
included in the summary values presented in the new Account Invoice Aging tab. 

• The Account Invoices tab contains a new Days Late column, enabling users to see past due 
invoices for a given account. 

• Users can now refresh pricing for sales orders and quotes when using a price service. 
• New Test Link button on the Price Service detail view enables testing the price and availability 

end points. 
• The Account Detail View ERP Details tab now contains a notes field which displays notes 

published by the host ERP system. Notes display in descending date sequence. This field is 
read-only. 

Ming.le Integration enhancements 
For implementations that include integration with Infor Ming.le: 

• The following new Ming.le Widgets are available: 
• Infor Ming.le Funnel Chart widget. 
• Infor Ming.le Top Prospects widget is a list of my prospective accounts. 
• Infor Ming.le Infor CRM Opportunities widget of associated quotes for each opportunity. 
• Infor Ming.le Infor CRM Contracts widget which provides a detailed view of the contract and 

associated contacts. 
• A new Dashboard widget for Group Lists (Infor.CRM.GroupList -v1.0.6.3.zip) 
• A new Dashboard widget for Opportunity Status (CRM.opportunity.Status.zip) is available. You 

must execute the *Master Data Consolidation* conversion option in the Conversion Utility if your 
• implementation contains pre-existing ERP data content. Content is dependent upon the Infor 

CRM instance being integrated to a back office host ERP system publishing invoice content. 
Access to this feature must be granted to users. For more information, see the Web Client online 
help topic "Enabling Refresh Pricing". 

• A new tool simplifies the Infor Ming.le provisioning process. 
• An updated WebProvisioningUI.exe adds provisioning information to the Virtual File System 

(VFS). 
• Users and roles are now synchronized between Infor CRM and Infor Ming.le. 
• It is possible to share records and notes and history items 
• It is possible to create and manage bookmarks 
• Links in Infor Ming.le link to Infor CRM. 

Web Client Administrator enhancements 
Administrators and users with appropriate roles can access the following new features and functionality: 

• The following roles are now default permissions in the Admin User Role. In prior releases, they 
were not assigned to a Role and had to be manually added: Pick Lists, Users, Roles, A/C/I, 
Departments, Exchange Rate, Lead Source, Literature, Resource, Standard Problem, Standard 
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Resolution, Security Manager, Ticket Activity, Ticket Area Owner, Qualification, Package, Office 
Profile, Country Code Mappings, Competitor, Campaign, Entity Manager. 

• Create multi-regional pick lists with different list items for each language. The contents of a multi-
regional pick list will depend upon the user's language setting. 

• Set a default language for multi-regional pick lists. 
• Set the desired language on the Name Prefix and Name Suffix so that users can select a 

language on the Contact Detail view Details tab in order to change the list items in the Prefix and 
Suffix, pick lists. 

• A new Office Profile Error Notifications tab allows enabling the Error message e-mail link feature 
and specifying one or more e-mail addresses that will automatically populate the email To: field. 
When the Error message e-mail link feature is enabled, users who encounter an error message 
can send an e-mail to the specified address that contains a link that will display Event Viewer 
information. The Event Viewer information is only available to administrators or users granted 
access to the ErrorLookupService/View secured action. 

• New secured action for Account Hierarchy - Entities/Account/Hierarchy. 
• New secured actions for the Job Manager job schedules and triggers. 
• Steps for configuring Sales Intelligence, including the displaying the purchase likelihood score 

options. 
• New Custom Settings list view and Custom Settings detail view to manage group export settings, 

CreatePivot and MaxExportRecords. 
• New Office Profile Groups tab that allows you to set a limit for the number of groups that can 

display as tabs on list and detail views. All standard groups will be marked as Favorites by 
default. 

• New Adminutil.exe enables the Administrator to see which users are logged in to Infor CRM and 
how many times each user is logged into the various Infor CRM applications. Administrators can 
filter based on type of user and status. It does not track SData logins. 

Mobile enhancements 
The following enhancements have been added to the Infor CRM Mobile Client since version 3.4. 

• Two new files: configuration/development.default.js and configuration/production.default.js enable 
preserving modifications to default settings (such as Enable Multi-currency) in future upgrades. 

• Field level security settings made for the Infor CRM Web Client using the Infor CRM Web 
Administrator now cascade into the Mobile Client. 

• Infor CRM Mobile can now use the 24-hour clock. Settings enable the user to manually change 
between the 12 and 24 hour clocks. The default setting is specified by regional settings. 

• Settings contains two new Offline options: users can clear their Briefcase and clear Recently 
Viewed records as well as clearing all records and showing record usage. 

• Integrations with ERP LX support ‘Availability to Promise” in Mobile. “Click to check warehouse 
availability” enables users to verify if the warehouse selected has the requested volume of 
inventory on hand. 

• Users can look up Contacts based on the Accounts to which they were associated. 
• The Infor CRM Mobile Client supports single sign-on when Infor CRM is integrated with Infor 

Ming.le.  
• Contour enables searching the Infor CRM database for other accounts that are in a specific 

geographical proximity. 
• The Infor CRM Back Office Extension (ICBOE) feature contains the following improvements in the 

Infor CRM Mobile Client: 
• ICBOE is now part of the Infor CRM Mobile Client. It is no longer necessary to install a separate 

bundle. ICBOE for the Infor CRM Mobile Client enables Mobile Client users to drill through 
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account-related information available in back office integration. When ICBOE is configured in the 
Infor CRM Web Client, users can see the following entities in Infor CRM for Mobile: 
o Invoices 
o Quotes 
o Sales Orders 
o Shipments 
o Receivables 

• The Working Offline “Recently viewed” and “My Briefcase” features are now available for ICBOE 
records. 

• The ICBOE feature in Infor CRM Mobile no longer needs to be activated in the Application 
Architect. 
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Lesson 2: User setup 
Estimated time 
2 hours 

Learning objectives 
In this lesson, you will: 

• Describe a New User Checklist prior to creating user. 
• Explain the differences between user types. 
• Create new users. 

Topics 
• About users 
• New user checklist 
• About creating new users 
• Create users in the Web Client 
• Create users in the Windows Client 
• Customize settings in the Windows Client 
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About users 
Infor CRM users represent individuals who work for your company. Each user requires a user profile. 
Settings in a user’s profile determine the user’s log on credentials (such as username and password), 
user type, and ability to access different Infor CRM components. 

Administrators can add any of the following user types: 

• Network 
• Concurrent 
• Remote 
• Template 
• Web only 
• Add-on user 
• WebViewer 

In addition, Infor CRM supports several special user types: 

• System administrator 
• Administrative 
• Retired 
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New user checklist 
Prior to installing the Infor CRM Server components, review the installation options, prepare service 
user(s), and identify what’s included with Required Administrative Tools and Servers. 

After installing Infor CRM Server components and configure required settings in the Administrator 
workstation, you can setup users. The overall process of getting a new Infor CRM user up-and-running 
looks like the following checklist: 

• Review the Windows’ folder sharing permissions for the Sync Logs, Library, and Documents 
folders to ensure the new user has access to these. 

• Determine which type of user will be added (i.e. Network, Remote, Web Only, WebViewer, 
Concurrent, or other). 

• Ensure there is a license available for this type of user. 
• Decide how this user will be created: 

 

Creation Method Description 

Add new users based 
on an existing user 
template 

Add new users based on an existing user template or a custom user 
template you create. 

Create Infor CRM 
users based on 
existing Windows’ 
users 

If you want existing Windows’ users to also be Infor CRM users, you can 
import your Windows’ user information to Infor CRM. During this process, 
you can select an existing user template to configure user profile settings. 

Import users from a 
comma-delimited text 
file 

If your company maintains user information in another application, you can 
export the information and import it to Infor CRM to add users. During this 
process, a user template can be applied to configure user settings not 
found in the import file. 

Create users 
individually 

If you have a small number of users, or each user requires a distinct profile 
with settings that differ substantially, you can add users individually and 
configure each profile as appropriate. 

Copy an existing user If an existing user's profile contains the settings you want to apply to the 
new user, note the existing user's name so that you can select the correct 
profile to copy from when adding the new user. If some settings should not 
be copied, note which tabs to exclude when you copy the profile. 

 

• If necessary, modify the user’s profile. When finished, verify the Login Active check box is 
selected on the General tab. 

• If your organization uses teams for account ownership (recommended) then add the user to the 
appropriate team(s). Since the teams a user belongs to determine which accounts he or she can 
access, ensure you understand how teams work in Infor CRM.  

• Press F5 to ensure all changes have been made. 
• Install and configure the necessary programs on the user’s computer, such as the Infor CRM 

Client. For more information, refer to the Infor CRM Implementation Guide. 
• If your company uses Advanced Outlook Integration or Outlook Sync, do one of the following: 

o Configure the Contact Sync group if your company uses Outlook Integration to synchronize 
contact and calendar information between the Infor CRM Client and Outlook.  
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o Configure and activate Outlook Sync if your company uses Outlook Sync to share activities 
and contacts with Microsoft® Outlook®.  

You may also need to complete the steps in the following checklist to prepare user data to be imported in 
to an Infor CRM database using a CSV import. 

• Export the user information from an existing database as a comma-delimited file. This is the 
source file.  

• Open the Users view in the Infor CRM Administrator and then select Insert > Import Users. 
Click Open to edit the default SaleslogixUserImport.CSV file in Excel. This is the target file 
containing all the columns necessary to import user data into Infor CRM. 

• Open the source file (created in the first step) in Excel. 
• Copy the data from each column in the source file to the appropriate column in the target file. Do 

not copy over the column headings in the target file or remove any of the columns. Except for 
USERNAME, columns and cells may be blank. 

When exporting data from Windows, use the following table as a guideline to paste additional information 
in the correct columns of the target file.  
 

Windows exports with column title Paste data into this column in target file 

Office DIVISION 

Business Phone WORKPHONE 

Email address EMAIL 

City HOMECITY 

State HOMESTATE 

Zip Code HOMEPOSTALCODE 

Country HOMECOUNTRY 

Job Title TITLE 

Department DEPARTMENT 

Company COMPANYNAME 
 

 

 This information is based on Windows 2000 Server and may vary for different versions of 
Windows. 

 

• Type an additional data in the SaleslogixUserImport.CSV file. 
• Save the updated file as .CSV, with a name that you choose. You can then use this file to update 

or import users. 

Once the previous steps are completed, you are ready to import users from a CSV file. 



 

  Infor CRM: v8.4 Administering Training Workbook 39 
   

  © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

About creating new users  
Every person who uses Infor CRM must have a user profile. A user profile determines the user’s log on 
credentials, type of license consumed, sync settings, user interface preferences, security permissions, 
and more. 

What user types are available? 
User types are determined by the available licenses your company has purchased. Different user types 
allow you to purchase only the licenses that best match your user needs. 

 

 

The ability to manage licenses for your Infor CRM implementation is only available in the 
comprehensive Windows Administrator product. 

 

As mentioned previously, Infor CRM offers the following user types. Here is a more detailed description of 
each: 

• Add-on: The Add-on user enables you to create a user with access to the Infor CRM OLE DB 
Provider for third-party client interfaces.  

• Administrative: A user who can perform tasks normally reserved for the system administrator. 
Users with access to administrative functions are defined using administrative roles in the 
Administrator or roles in the Web Client. Administrative users log on using their username.  

Note: The system administrator remains the only user with full access to all features and 
functions in the system.  

• Concurrent: Can access all Infor CRM applications (Windows, Web, and Mobile) but cannot sign 
in to a Remote database. Concurrent users share licenses so access to all applications is 
restricted if the number of concurrent users currently logged on exceeds the maximum allotment. 

• Network: Can access all Infor CRM client applications (Windows, Web, Mobile) but cannot sign 
in to a Remote database. This type of user who primarily accesses Infor CRM via a direct network 
connection to the database. 

• Remote: Can access all Infor CRM applications (Windows, Web, Mobile). Remote Clients keep a 
subset of the main office database on their local computer (a laptop, for example) and use 
synchronization to transfer changes between their system and the main office. Note that remote 
users never connect with the remote office and instead always connect with the main office.  

• Retired: A user type used to maintain the activity history of users who leave your organization. 
Retired users are treated like inactive users in that their contact activities are preserved in the 
database even though they are no longer able to access the system. However, inactive users use 
licenses while retired users do not. 

• Template: User templates can be created to define settings you want to use when creating new 
users. For example, you can create a user template that holds all options for concurrent users. 
Then, when you create a new user, you can use the concurrent user template and the profile 
settings are predefined.  

Note: 

o User templates do not affect the license count or appear in the user's list.  
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o A user template is not an active user and cannot log on to Infor CRM. 
• System Administrator: A user with access to all features and functions in Infor CRM.  

The system administrator logs on as “admin." 

• Web Only: Users who only have access to the Infor CRM Web Client and can view, add, delete, 
or modify information based on their access rights. This user type cannot log on to the Infor CRM 
Client. 

• WebViewer: WebViewer users have read-only access to accounts, contacts, opportunities, and 
tickets. Depending on account and calendar security, Web Viewer users can add, edit, and delete 
activities, notes, and history but cannot use reporting or processes. This user type cannot log on 
to the Infor CRM Client. 

A WebViewer user cannot: 

o Be the owner of any team. 
o Be a manager or have anyone report to them. 
o List any other users in the User Team section of the User Profile Teams 

Note: This user cannot log on to any Infor CRM applications. 
 

 Windows 
Client 

Remote Client       
(w/o database) 

Remote 
Client 

Web 
Client 

Mobile 
Client 

Named User 
License 

     

Windows User      

Remote User      

Web Only User 
License 

     

Web Only User      

WebViewer 
User License 

     

WebViewer 
User 

     

Concurrent 
User License 

     

Concurrent 
User 

     

 

What method(s) can I use for creating users? 
Infor CRM supports the following creation methods: 

• Create Infor CRM users based on existing Windows users 
• Import users from a comma-delimited text file 
• Create users individually 
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• Copy an existing user 
• Add new users based on a template 

Import users from Windows 
Users are automatically logged on without entering their usernames or passwords if your company uses 
Windows Authentication. Users' Windows IDs are stored in the Infor CRM database paired with their Infor 
CRM usernames and passwords. 

To set up Infor CRM users with Windows IDs, do one of the following: 

• Use the Import Windows Users dialog box to select Windows users and create new Infor CRM 
users.  

• Use the Match Users dialog box to pair existing Infor CRM usernames with Windows usernames.  

Import users from a comma-delimited text (CSV) file 
If your company maintains user information in another application, you can export the information and 
import it to Infor CRM to add or update users. Information in the text file overwrites corresponding 
information in the user profile of an existing user. 

The data in the import file must match the format expected by Infor CRM exactly. This format cannot be 
customized. There are 62 available fields that can be utilized within a CSV file import. To view a list of 
fields available for import, see the Import Users File Format topic in the Administrator Help. To create an 
empty template to be used, select the CSV file option from the Add Users dialog box and then select 
Open under the Import File group. 

Copy an existing user 
Similar to creating a user from a template, you can use the Copy User function to copy the configuration 
information from an existing user to the new one. Everything is copied except the information on the User 
Profile General tab.  

CRM recommends creating a user from a template instead of copying an existing user to help prevent 
any unwanted security or other settings being granted to the new user. 

Create users manually 
When creating users individually, start with a blank user profile. The required fields (Username, name, 
Department, and Manager) contain placeholder values. 
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Create users in the Web Client 
When using the Web Client to create a user, the logged in user must have security access to the 
Administration Nav Bar which is based on the secured actions and roles they are assigned. You can 
also use the administrator account, which is typically the username Admin, to create users via the Web 
Client. 

 

 
Not all the available methods for creating users are available to you in the Web Client. 

Understand administrator and user security differences in the Web Client 
The Infor CRM administrator has access to all accounts, menus, toolbars, and features in Infor CRM. 
However, user access is controlled by the user’s profile. The following table summarizes the differences 
when logging on to the Infor CRM Web Client using the admin username versus a typical Infor CRM user. 
 

Administrator rights Individual user rights 

Full access to all pick lists and pick list attribute 
settings. 

Editing or modifying pick lists is governed by 
the pick list attributes. 

Full access to all System menus and toolbars. View access to menu commands and toolbars 
is governed by the role assigned by smart part 
in the Application Architect. 

Can change ownership of accounts regardless 
of ownership type. 

Can change account ownership if the user 
owns the account and, in the case of a team, if 
the user has a Team Owner security profile. 

Can change any data in any field. Can change data in a field depending on the 
account type and user field level security 
profile. 

Can access all groups created by all users. Can only view groups created by the user or 
shared by another user. 
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Create users manually 
Infor CRM provides the ability to create a user manually. This option is best used when there are only a 
small number of users to create. When creating a user manually, the administrator must select every 
option individually. No option is prefilled with a value. 

 

Exercise 2.1: Create a user manually in the Web Client 
In this exercise, you will add a new user manually so they may sign in to Infor CRM. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

 

Scenario 
Phoenix Computers is creating a new Northeast Sales team. A new hire, Anne Avery, was 
hired as Sales Manager for this new team. How do I add a user profile for her so she can 
sign in to Infor CRM? 

Note: The user must be able to access both the Windows and Web Clients so you’ll want 
to use a Windows User License. 

Exercise steps 

 
Verify you are logged in to the training desktop. If not, log in following instructions provided by 
your course instructor.  

Note: If you are taking this course as self-directed learning, follow the instructions on the 
course Lab On Demand screen. 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Expand the Administration Nav Bar. 

5. Right-click Users and then select New Users. The Add Users screen opens. 

6. Confirm the following: 

• Network User is selected in the Add field. 
• 1 is selected in the Quantity field. 
• The Create from Profile check box is cleared. 

7. Click OK. The User - User000# screen opens. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/CreateAUserManuallyInTheWebClient.mp4
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8. Type anne in the Username field. 

 

A username is required and can only contain letters, numbers, and the special 
character “_” (no spaces). 

9. Type Anne Avery in the Name field. 

10. Select Sales Manager from the Title drop-down list. 

11. Type aavery@phoenixcomputers.demo in the Email field.  

Note: If an email address is not specified for a user, the user doesn’t appear in the Infor CRM 
address book. 

12. Search and select Northeast in the Region field.  

13. Verify Administrator is selected in the Manager field. 

14. Select the User is a Manager check box. 

15. Click Save. 

16. Select More Tabs > Department Membership from the tabs pane located near the bottom of the 
page. 

17. Click Add Department to Team.  

18. Search for Sales. 

19. Click OK. 

20. Verify the Login Enabled check box is selected. 

21. Click Change Password to modify this for the training environment. The Change Password 
dialog box opens. 

22. Click OK. 

23. Close the Infor CRM dialog box. 

 

By clicking OK without entering and confirming a password for the new user, the 
password is set to a blank password unless you have required a password for 
users. A warning dialog reminds you of the blank password. 

24. Click Save.  

The new user appears in the Users list view of the Infor CRM Web Client. Within the Infor CRM 
Administrator, you can also see Anne Avery in the following areas of the Organization Chart: 

• In the list of Departments, Anne appears under Sales. Note: Managers are identified by a 
purple icon to the left of their name while other users include a blue icon. 

• In the list of Managers. Note: Anne currently has no direct reports.  

Add users from a template 
Adding new users based on an existing user template or a custom user template you created makes 
creating new users more efficient. For example, you can create a user template named Manager which 

mailto:aavery@phoenixcomputers.demo
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functions as the generic user profile for all managers in the company. Then, when creating the users and 
applying the template, the profile is already configured with the appropriate settings. 

Creating templates is highly recommended as they reduce administration time significantly. User 
templates don’t consume an Infor CRM user license and cannot sign in to Infor CRM. 

Infor CRM includes several default user templates, such as All Access, Customer Service, Customer 
Service Manager, Customer Support, Customer Support Manager, Marketing, Sales, Sales Manager, and 
Executive Management. Open the Templates group of the Users list view to see all available templates 
or open a specific template. You can customize the default user template or create a new user template. 

Template considerations include: 

• Some fields in the user profile don’t apply to template users and are unavailable. 
• When adding a user based on a template user, you may change any user fields after creating the 

user. 
• Changing template fields doesn’t update a user created by the template. 
• Don’t use spaces in the Username field. Instead, use underscores. 
• Users cannot be converted to template users and template users cannot be converted to other 

user types.  
• Templates require a department. Use <None> or create a new department for template users. 
• Templates added to a team or department nested into a team through the user’s General tab in 

their profile appear in the team’s hierarchy list. You cannot add a template to a team directly from 
the team’s view. 

 

Exercise 2.2: Create a user template and new user in the Web Client 
In this exercise, you will create a new user template and new user. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Create a template 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Expand the Administration Nav Bar. 

5. Right-Click Users and then select New Users. The Add Users screen opens. 

6. Select Template from the Add drop-down list. 

Note: (No License Required) displays below the Quantity field. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/CreateAUserTemplateAndANewUserInTheWebClient.mp4
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7. Click OK. The User - Template000# window opens. 

8. Type Northeast_Sales in the Username field. This is the name of the template. 

9. Type Northeast_Sales in the Name field. 

10. Search and select Northeast in the Region field.  

11. Search and select Anne Avery in the Manager field. 

12. Select More Tabs > Department Membership from the tabs pane located near the bottom of the 
page. 

13. Click Add.  

14. Search for Sales. 

15. Click OK. 

16. Click Save. 

17. Click the List View icon and verify the new Northeast_Sales template appears. 

Part 2: Create a user from a template 

1. Select Administration > Add Users > New Users. The Add Users screen opens. 

2. Select Network User from the Add drop-down list. 

3. Select the Create Profile From check box. 

4. Select the Template radio button. 

5. Select Northeast_Sales from the Template drop-down list. 

 
6. Click OK. The User – User000# screen opens. 

7. Type ella in the Username field. 

8. Type Ella Hall in the Name field. 
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9. Select Sales Rep from the Title drop-down list. 

10. Type ehall@phoenixcomputers.demo in the Email field. 

11. Verify Pacific is selected in the Region field. 

12. Verify the Division field is blank. 

13. Verify Avery, Anne is selected in the Manager field. 

14. Select More Tabs > Department Membership. 

15. Verify membership to the Sales department. 

16. Click Save to create the user. 

Change a user’s profile settings 
A user’s profile determines everything about that user’s identity and ability to access Infor CRM 
components. Each user created in Infor CRM requires a profile. The following table summarizes the tabs 
shown on a user’s profile. 

Complete these tabs for all users: 

• Use the information fields to change the user’s name, e-mail, title, department, manager, and 
password. The username is what the user types to log on to Infor CRM; It should not contain 
spaces or an apostrophe. 

• Use the Employee tab to set company information, work phone and fax numbers, and the user's 
personal information. 

• Use the Team Membership tab to add the user to system teams. 
• Use the User Team Members tab to give other users access to this user's accounts. 
• Use the User Team Membership tab to give this user access to accounts owned by other users. 
• Use the Other Calendars tab to set access to other user’s calendars. 
• Use the User's Calendar tab to give other users access to this user's calendar. 
• Use the Security tab to set a field level security profile. 
• Use the Department Membership tab add the user to departments. 
• Use the Client System tab to set a default account owner and default templates. 

Complete this tab for Customer Service and/or Support users: 

• Use the Service/Support tab to set options related to customer service features, support 
features, and SpeedSearch. 

Complete these tabs if necessary: 

• Use the Notes tab to store any additional user-specific information. (This is optional information 
generally found in the user’s personnel file.) 

Change a user’s type 
Use the User’s detail view to convert a user from one type to another. For example, an administrator can 
change a Web Only user to a Concurrent user. They can also retire a user or re-activate a retired user. 

A license must be available for the new user type, except when a user is changed to retired. Retiring a 
user releases one instance of the license type previously assigned to that user. 

mailto:ehall@phoenixcomputers.demo
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_Employee_Tab.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_Team_Membership_Tab.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_User_Team_Members_Tab.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_User_Team_Membership_Tab.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_Other_Calendars_Tab.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_Users_Calendar_Tab.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_Security_Tab.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_Department_Members_Tab.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_Client_System_Tab.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_Service_Support_Tab.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_Notes_Tab.htm
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Rules 
Prior to changing a user’s type to retired, do the following: 

• If the user owns any records, do a territory realignment (in the Administrator). 
• If the user is an account manager for any accounts, do a territory realignment (in the 

Administrator) to assign a new account manager. 
• If the user is a manager, reassign any users who report to him or her to their new manager or to 

the Administrator. 

Prior to changing a user’s type to Web Only, do the following: 

• If the user is a manager, clear this setting in the User’s detail view. 
• If other users are listed as part of this user's User Team, remove them. 

 

Exercise 2.3: Edit a user’s profile settings in the Web Client 
In this exercise, you will change an existing user’s profile. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
One of Phoenix Computer’s Marketing reps, Larry Peters, has finished moving and is now a 
remote employee. Unfortunately, during his move to the new house he forgot his Infor CRM 
password. How can I update Larry’s address, user type, and password within the Infor CRM 
Web Client? 

Exercise steps 

Part 1: Change a user’s password 

1. Open Larry Peter’s User detail view. 

2. Click Change Password. 

Note: You aren’t asked to verify a current password because you are currently logged into an 
administrator’s account. 

3. Type Larry1 in the New Password and Confirm Password fields. 

4. Click OK. 

5. Close the dialog box. 

6. Click Save. 

  Click here to view a demo and/or practice this task 

https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Admin_useradmin/User_Detail_View_User_Team_Members_Tab.htm
https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/EditAUsersProfileSettingsInTheWebClient.mp4
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Part 2: Change a user’s type 

1. Select Remote from the User Type drop-down list. 

2. Click Save. 

Part 3: Update a user’s address 

1. Click Employee in the tab pane. 

2. Click Edit in the Personal > Address field and then enter the following new information. 

• Description: Home 
• Address 1: 40216 Oak St. 
• City: Phoenix, AZ 
• State: AZ 
• Postal Code: 85001 

3. Click Save within the tab. 

 

When editing information in the tabs, click Save on each tab or your option 
selections will not save. 

Edit user options 
Infor CRM provides tools allowing you to modify some parts of the interface so you can work in a way that 
suits you best. User options allow users to set specific preferences for features, such as the view that 
appears after logging on to the Infor CRM Web Client and Alerts. Settings entered by you are recorded 
for you and are not visible to other Infor CRM users. Some options are shared between the Infor CRM 
Windows Client and Infor CRM Web Client. 

• The General tab edits the initial startup view, the default owner or team, the Mail Merge base 
templates, the number of templates in the most recently used list, and e-mail options. 

• The Group tab selects the group of records to use as your default group for each record type. 
• The Calendar tab sets options for the calendar view. You can determine the information that 

displays on your calendar, the default view, or the day start and end times. 
• The Change Password tab changes your password. 
• The Opportunities tab sets defaults for new opportunities. 
• The Alerts tab sets defaults to determine how you will be alerted. 
• The Activities tab sets options for the Activity Main view, follow-up activities, or activity alarms. 
• The Authorize Services tab sets options for third party integrations. 

 

https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Getting%20Started/prefsgen.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Groups/prefsgroup.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Calendar/Setting_Calendar_Options.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Client/prefspass.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Opportunities/prefsopp.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Client/Alerts_Options.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Activities/Setting_Activities_Options.htm
https://inforcrm.crmcloud.infor.com/SLXClient/help/Content/Integrations/Authorize_Services.htm
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Exercise 2.4: Edit a user’s options in the Web Client 
In this exercise, you will set basic user options for Dave Nero.. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
After a few months on the job, Anne Avery wants to set some more tailored user options to 
her Infor CRM account and needs to change her password. Anne has come to you for some 
assistance with this as she is still new to the Infor CRM Web Client. 

Exercise steps 

Part 1: Change your password 

1. Open the Infor CRM Web Client. 

2. Type anne in the Username field. No password is required.  

Note: If you’re still logged in as admin, sign off via the status bar. 

3. Click Sign In. 

Note: You can verify you are logged in as Anne Avery by looking at the status bar. 

4. Select Tools > Options > Change Password. 

5. Type your current password into the Current Password field. 

Note: Anne Avery currently has no password, so leave this blank. 

6. Type Anne1 into the New Password and Confirm Password fields. 

7. Click Save.  

Part 2: Change your startup screen 

1. Click the General tab. 

2. Select Account from the Show on Startup screen drop-down list. 

3. Click Save. 

Part 3: Change your default group for contacts 

1. Click the Group tab. 

2. Select Contact from the Main View drop-down list. 

3. Select My Contacts from the Default Group drop-down list. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/EditAUsersOptionsInTheWebClient.mp4
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4. Select My Contacts from the Default Lookup Layout drop-down list. 

5. Click Save. 
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Create users in the Windows Client  
Within Infor CRM, you can create new users via both the Infor CRM Windows or Web Clients, however, 
there are more options available within the Windows Client for creating users. This client is typically used 
upon an initial installation. 

The Administrator program is used to create new users for the Windows Client. To create new users, you 
must have the appropriate administrative rights. There are four main ways to create a new user in the 
Infor CRM Windows Client: manually, from template, from CSV file, or from windows. 

Creating users in the Windows Client is similar to the Web Client. In the following exercise, you will walk 
through creating new users by various methods using the Windows Client. You’ll also use the user 
template created in a previous exercise. 

 

Exercise 2.5: Creating users in the Windows Client 
In this exercise, you will learn different methods for adding new user(s) to Infor CRM so they 
may log on to Infor CRM. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Manually add users 

1. Select Start > All Programs > Saleslogix > Infor CRM Administrator.  

2. Type admin in the Username field. No password is required.  

3. Click the Users Nav Bar. 

4. Click Add in the toolbar. The Add Users dialog box opens. 

5. Select the Network user type from the Add drop-down list. 

Note: If you select Template here, you would be creating a new user template and not a specific 
user. 

6. Select or type 1 into the Quantity field.  

Note: The number of users available for this license type displays next to the Quantity field. 

7. Click OK. 

8. Fill in the following information: 

• Username: dave 
• Name: Dave Nero 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/CreateUsersInTheWindowsClient.mp4
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• Title: Sales Manager 
• Region: Northeast 
• User is a Manager: Selected 

9. Click the Teams tab. 

10. Click Manager. This opens the Teams dialog box. 

11. Select Northeast. 

12. Click OK twice. The user is created.  

Part 2: Create a user from a template or using the profile of an existing user 

1. Click the Users Nav Bar. 

2. Click Add in the toolbar. The Add User window opens. 

3. Select the Create Profile from check box. 

4. Select the Template radio button. 

• Template adds a user based on an existing template user. Select the name of the template 
user in the Template field. 

• Existing User adds a new user based on an existing user’s profile. Select the name of the 
existing user in the User field. 

5. Select Northeast_Sales from the Template drop-down list. 

6. Select the tabs to copy from the template or user profile. 

7. Click OK. The user <Copy of Northeast_Sales> is created. 

Once the new user is created, the User Profile dialog box opens which you can use to modify the 
user’s profile. 

8. Fill in the following information: 

• Username: adam 
• Name: Adam Garfield 

9. Confirm Northeast is selected in the Region field. 

10. Confirm Anne Avery is selected in the Manager field.  

11. Click Cancel. 

Part 3: Delete a user 

1. Right-click User0001 from the list of available users and then select Delete User. 

2. Click Yes when the confirmation dialog box opens. 

Part 4: Create a copy of a user 

1. Click the Users Nav Bar. 

2. Select Ella Hall to copy information from in the user’s grid. 

3. Select Edit > Copy User. The new user appears in the user list as <Copy of username>. 

4. Update the User Profile General tab with information specific to the new user, such as name and 
email address. 
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A retired user cannot be copied; However, the retired user’s profile can be used as 
the basis for a new user. The retired user’s profile may also be copied to an existing 
user. 

5. Click OK to create the new users in Infor CRM.  

6. Right-click User0001 from the list of available users and then select Delete User. 

7. Click Yes when the confirmation dialog box opens. 

Part 5: Import users from a CSV file 

1. Select Insert > Import Users > From CSV File. Note: The import functionality is also available 
from the Add Users dialog box. 

2. Select Network from the Default User Type drop-down list.  

Note: This type is used only if the user type is not defined in the import file. 

3. Select the Default Template if necessary.  

Note: A template user can be used to configure user settings not found in the import file. For 
example, menu access or security. This template is only used if the user template is not defined 
in the import file. 

4. Confirm the path and file name for your import file are correct in the Import File fields. If 
necessary, browse to the file. Leave this as the default. 

Note: The default is \\ProgramData\SalesLogix\SalesLogixUserImport.CSV . If the file name is 
changed, the new name should use 0-9, A-Z, a-z, and "_" only. The extensions must be 
".csv".\\ProgramData\SalesLogix\SalesLogixUserImport.CSV . If the file name is changed, the 
new name should use 0-9, A-Z, a-z, and "_" only. The extensions must be ".csv". 

5. Select the Update existing users check box if necessary. 

If a username already exists in the database, this option updates the user's information with the 
data in the import file. 

6. Click Open to edit the import file if necessary. 

Note: On your training environment, the default file has been updated to include 1 new user, 
Justin R. Cabana. On a live Infor CRM installation, this file will be blank unless it has been 
overwritten. 

7. Click Import. 

8. Click No. 

 

file://ProgramData/SalesLogix/SalesLogixUserImport.CSV
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Customize settings in the Windows Client 

Changing a user’s profile 
Like the Web Client, a user’s profile determines everything about a user’s identity and ability to access 
Infor CRM components in the Windows Client. Each user you create in Infor CRM requires a profile. The 
following table summarizes the tabs shown on a user profile. 

Complete these tabs for all users: 
• Use the General tab to add the user’s name, e-mail, title, department, and manager. The 

username is what the user types to log on to Infor CRM and it should not contain spaces or an 
apostrophe. Also, the e-mail information may appear in templates and reports.  

• Use the Employee tab to set company information, work phone and fax numbers, and the user's 
personal information.  

• Use the Security tab to set feature security, set a default field security profile, and assign 
administrative roles. Feature security and administrative roles apply to Infor CRM Client users. 
Field security profiles apply to Infor CRM Windows Client and Web Client users.  

• Use the Teams tab to add the user to system teams and give other users access to this user's 
accounts.  

• Use the Calendar tab to set access to other user’s calendars and give another users access to 
this user's calendar.  

Complete these tabs for all Infor CRM Client users: 
• Use the Function Security tab to control the functions available to the user in the Infor CRM 

Client.  
• Use the Client Settings tab to set the default groups and lookups that appear for the user in the 

Infor CRM Client.  
• Use the Client System tab to set a default account owner, default templates, and the user's e-

mail system.  

Complete this tab for remote users: 
Use the Sync tab to assign a sync server to a remote user, determine how the user receives 
synchronization files, configure subscription, configure what activities the remote user receives, what 
records they see in What’s New, and what history and account summary records are kept on the remote 
database.  

Complete this tab for Customer Service and/or Support users: 
Use the Service/Support tab to set options related to customer service features, support features, and 
SpeedSearch.  

Complete these tabs if necessary: 
• Use the Custom tab to store any additional user-specific information. (This is optional information 

generally found in the user’s personnel file.)  
• If Infor CRM is integrated with your organization’s accounting system, use the Employee tab to 

specify the necessary information.  

http://user_profile_general_tab.htm/
http://user_profile_employee_tab.htm/
http://user_profile_security_tab.htm/
http://user_profile_teams_tab.htm/
http://user_profile_calendar_tab.htm/
http://user_profile_function_security_tab.htm/
http://user_profile_client_settings_tab.htm/
http://user_profile_client_system_tab.htm/
http://user_profile_sync_tab.htm/
http://user_profile_support_tab.htm/
http://user_profile_custom_tab.htm/
http://user_profile_employee_tab.htm/
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Manage a user’s password 
Like the Web Client, new users in the Windows Client are created with a default password of “password.” 
The system administrator, Administrative user, or Infor CRM user can change this password at any time.  

You can globally assign, remove, and restrict passwords using password options. 

 

 

Passwords must begin and end with a numeric character (0-9) or an alphabetical 
character (A-Z or a-z). 

 

The Passwords tab allows the system administrator or administrative user to set restrictions on user 
passwords. For example, you can require all users to have a password (not blank) or that passwords 
contain a minimum number of characters. 

Additionally, a user may be "locked-out" from logging in to Infor CRM if the number of user's failed login 
attempts exceeds the number of allowed attempts. The Login Attempt Threshold is set in the 
Administrator on the Password tab. Resetting a locked-out user changes the number of attempts to zero 
and allows the user to attempt to log in again. 

 

 

• If blank passwords are permitted, ensure the minimum length of password is 0. 

• Infor CRM passwords are case-sensitive and may have up to 30 characters. 

 

If Windows Authentication is enabled, the password options do not apply to users with associated 
Windows usernames. 

 

Exercise 2.6: Edit a user’s profile settings in the Windows Client 
In this exercise, you will change a user’s start-up view when in the Windows Client. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Edit a user’s profile 

1. Click the Users Nav Bar. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/EditAUsersProfileSettingsInTheWindowsClient.mp4
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2. Double-click Dave Nero’s name. This is the user you will edit. The User Profile dialog box 
opens. 

3. Click the Client Settings tab. 

4. Select Account Details from the Show On Startup drop-down list. 

5. Select Account Details from the Main View drop-down list. 

6. Select My Accounts from the Default Group drop-down list. 

Note: Each user can have a different default group for each entity. When you select a main view 
from the Main View drop-down list, the Default Group drop-down list changes to show only the 
groups available from the specific main view selected. Default group selections are retained for 
each main view. 

Part 2: Change a user’s password 

1. Click the General tab. 

2. Click Change Password. This opens the Change Password dialog box. 

Note: There aren’t any options here to verify the user’s password because you are currently 
logged in as the administrator account. 

3. Click No Password to set Dave Nero’s password to blank. 

4. Click OK twice. 

Part 3: Reset locked out users 

1. Right-click the username of the user who is currently locked out and then select Reset User 
Logins. 

Part 4: Set password options 

1. Select Tools > Options. The Options dialog box opens. 

2. Click the Passwords tab.  

3. Clear the Use Windows Authentication (Saleslogix Password not required to log on) check 
box.  

If you’re not using Windows Authentication or are only using it for certain users, set the following 
options as needed for all users who are required to log on to Infor CRM manually. 

After setting an option, click Show users with invalid passwords to display a list of users who 
do not meet the password criteria.  

• Type a password in the Default password field to change the default password for new 
users. The Infor CRM default user password is SLXMa$t3r. The default password cannot be 
blank.  

• Type a number in the Minimum password length field to force the user's password to 
contain a minimum number of characters.  

• Type a number in the Days until password expires field to set a password expiration date. 
This option does not apply if you select the Force user to change default password check 
box. 

Some Infor CRM Web components require Infor CRM usernames to function. If the 
passwords expire for these usernames, the Web components will not work.  
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• Select Password must contain numbers and letters to require that the user password 
contains at least one number and at least one letter.  

This check box is only available if Do not allow blank passwords is selected.  

• Select Force user to change default password to require users to change their default 
password when they log on.  

• Select Do not allow blank passwords to require all users to have a password. 

When this option is selected, the No Password button is unavailable in the Change 
Password dialog box in the client programs and Administrator.  

• Select Do not allow username as password to prohibit a user from using their Infor CRM 
username as a password. 

4. Select 5 as the Login Attempt Threshold. (Applies to Web only) 

This limits the number of times a user can attempt and fail to log in to the Infor CRM Web Client 
before the user is locked-out. This option does not apply to the Sales Client.  

a. Select the number of failed attempts to allow.  
b. Enter the number of minutes that must pass before the lock is reset automatically. 

5. Click OK. 
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Check your understanding 
 

 
What are the available Infor CRM user types and their supporting licenses? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What methods are available for creating a new user? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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What are the benefits of using a User Template? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What categories of User Options are within Infor CRM? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Lesson 3: Team and department setup 
Estimated time 
2 hours 

Learning objectives 
In this lesson, you will: 

• Discuss creating and using teams. 
• Discuss creating and using departments. 
• Describe what a user’s manager can see. 
• Discuss security regarding teams. 

Topics 
• About teams and departments 
• Manage teams and departments in the Windows Client 
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About teams and departments 
A team is a group of users who need access to the same accounts—you might create teams based on 
region, territory, type of account, or department. For example, Lee Hogan belongs to the Midwest team 
and has access to all accounts owned by that team. However, Lee is not a member of the Northeast team 
and cannot access the Northeast team accounts. 

A department is a specialized team created from a group of users. By default, users are not assigned to 
any departments. Departments may be created to specify what role users have within a company, such 
as Inside Sales or Field Sales. 

Using teams 

Team considerations 
When creating teams, consider what the team members have in common and the information they need 
to share. 

• Teams can consist of users, departments, and other teams. 
• When creating a team, a Team Owner is required. 
• Users can belong to more than one team and their security profiles can be different for each 

team. 
• When a user is added to a team, the user’s default field security profile is used. You can assign a 

new security profile to the user as it applies to the team only. 
• Changing a user’s field security profile on one team does not affect the user’s default security 

profile. 
• Each team must have at least one Team Owner. The Team Owner profile allows the designated 

user Read/Write access to the team, which also allows the user to reassign team ownership. 

Team restrictions 
When determining a user’s ability to create and maintain teams, consider the following rules. A user can 
never: 

• Add himself or herself to an existing team. 
• Remove himself or herself from a team. 
• Remove the system administrator from a team. 
• Delete a team. 

Team hierarchy rules 
When adding a user to a team, the user's immediate manager can also be included. However, there is no 
further inheritance (for example, the manager's manager). If you don’t want the user's manager added to 
the team, you can clear this option on the Team Members tab. 

• In the Team detail view, if the Automatically add user's manager to team is selected, then each 
time a new user is added to a team, that users’ manager is also added to the team if they are not 
already a member of that team. 

• If a team member changes managers and the new manager is not already on the team, the new 
manager is added to the team. 

• If a team member changes managers, the previous manager will not be removed from the team. 
If the previous manager should not have access to the team, then they need to be manually 
removed from the team. 
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What is a Team Owner? 
The Team Owner is a team security profile. When you create a team, you are required to specify which 
user should serve as the Team Owner. 

This permission allows the user to change account ownership within the Infor CRM client for an existing 
account. All other team members have read-only access to the Owner field on an existing account. 
Limiting access of the Owner field helps prevent other users from inadvertently changing an account 
owner and causing all members of the team to lose access to the record.  

It’s possible to apply a different security profile to the Team Owner after the team is created so only the 
administrator has rights to change account ownership of existing accounts. Use the Tools menu from the 
Teams view to change a user’s security profile for a selected team. 

Using departments 

Department considerations 
Infor CRM automatically creates a department called None. This department is applied to all new users 
by default. 

• Departments contain users, not teams.  
• A user can belong to more than one department. 
• Departments cannot own accounts. 
• Departments cannot have security assigned to them. 
• Teams can own accounts, and departments can access those accounts, but departments cannot 

directly own accounts. 
• When a user is a member of both a team and a department on that team, rights for the team 

prevail over department rights. 
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Manage teams and departments in the Web Client 
In the Infor CRM Windows Client, managing teams and departments is done within the Administrator 
application. Teams are managed from within the Teams view. Departments are managed from within the 
Users view. Appropriate permissions are required on the user account trying to access the Administrator 
application. 

 

Exercise 3.1: Managing teams and departments in the Web client 
In this exercise, you will manage teams and departments from the Administrator application 
in a Windows Client. You’ll create, edit, and delete a team and department, learn how to set 
the field security profile on a team, and view the account access for a team. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Creating a new team 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Expand the Administration Nav Bar. 

5. Click the Teams link in the Administration Nav Bar. This Teams list view opens. 

6. Select Administration > New Team from the menu bar. This New Team page opens. 

7. Type Pacific in the Name field. 

8. Search and select Anne Avery from the Owner field. 

9. Select the Automatically add user’s manager to team check box so it is enabled. 

10. Click Save in the toolbar. 

This creates the team and opens the detail view for the new team you just created. 

Part 2: Adding a user to a team 

1. Click the Add a team member icon within the Members tab toolbar. The Lookup Member dialog 
box opens. 

2. Search and select Ella Hall. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ManagingTeamsAndDepartmentsInTheWebClient.mp4
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Note: If searching by the Member field by starting with, you must search for Hall as the last name 
comes first in this field. 

3. Click OK. 

4. Click Add a team member again. The Lookup Member dialog box opens. 

5. Search and select Justin Cabana. 

6. Click OK. 

Part 3: Removing a user from a team 

1. Select Cabana, Justin from the Members tab’s list. You can see the user is selected by the blue 
highlight. 

2. Click the Delete icon. A confirmation dialog box opens. 

3. Click OK. 

Part 4: Checking account access within a team 

1. Click the Account Access tab within the team detail view. 

This tab shows a list of all accounts the current team has access to within Infor CRM. Since the 
Pacific team was just created, it doesn’t have access to any accounts yet. 

Part 5: Deleting a team 

1. Click Delete. This confirmation dialog box opens. 

2. Click Cancel as the team should not be deleted right now. 

Clicking OK on this confirmation dialog removes the team from Infor CRM. 

Part 6: Creating a department 

1. Select Administration > New Department from the menu bar. The Insert Department page 
opens. 

2. Type Sales_Support in the Name field. 

3. Click Save. This opens the department’s detail view. 

Part 7: Adding members to a department 

1. Click Add a team member. The Lookup Member dialog box opens. 

2. Search and select Justin Cabana. 

3. Click OK. 

4. Click Save. 

Part 8: Deleting a department 

1. Click Delete. This opens a confirmation dialog box. 

2. Click OK. 

Clicking OK on this confirmation dialog generally removes the department from Infor CRM, 
however, Infor CRM does not allow deletion of departments containing members, so an error 
message appears instead. 
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3. Close the Deletion Not Allowed dialog box. 

Part 9: Adding a department to a team 

1. Click the Teams tab. 

2. Click Add department to team. The Lookup Member dialog box opens. 

3. Search and select the Pacific team. 

4. Click Save. 

This adds the Sales_Support department to the Pacific team as a member.  

Note: Departments can be a member of a team, but a team cannot be a member of a 
Department. 
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Manage teams and departments in the Windows 
Client 
In the Infor CRM Windows Client, managing teams and departments is done within the Administrator 
application. Teams are managed from within the Teams view. Departments are managed from within the 
Users view. Appropriate permissions are required on the user account trying to access the Administrator 
application. 

 

Exercise 3.2: Managing teams and departments in the Windows client 
In this exercise, you will manage teams and departments from the Administrator application 
in a Windows Client. You’ll create, edit, and delete a team and department, set the field 
security profile on a team, and view the account access for a team. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Create a new team 

1. Open the Infor CRM Administrator. 

2. Type admin in the Username field. No password is required.  

3. Click OK. 

4. Click the Teams Nav Bar. The Teams view opens in the main window. 

5. Click New Team. The New Team dialog box opens. 

6. Type Atlantic in the Team Name field. 

7. Search and select Dave Nero from the Team Owner field. 

8. Search and select Adam Garfield from the Select Team Members field. 

Note: It’s possible to select multiple members in this field. 

9. Click OK. 

10. Press F5. This refreshes the Administrator application. 

Part 2: Remove members from a team 

1. Select and expand the Atlantic team from the Teams view, if not already selected. 

2. Clear the Automatically add user’s Manager to a Team check box. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ManagingTeamsAndDepartmentsInTheWindowsClient.mp4
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3. Select Anne Avery from the list of members for the Atlantic team. 

4. Click Remove. A confirmation dialog box opens. 

5. Click Yes. 

Part 3: Set field security for a user on a team 

1. Select Adam Garfield from the list of team members in the Atlantic team. 

2. Click Edit next to the Field security of user on this team field. The Security Profile Manager 
dialog box opens. 

3. Select the Read-Only Default radio button. 

4. Click OK. 

5. Click Save.  
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Check your understanding 
 

 
What are some considerations to consider before creating a new team or department? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What are the differences between departments and teams?  

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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What is the role of a Team Owner? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 

Can individual users on a team or department have different security than the 
team/department itself? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Lesson 4: Introduction to Infor CRM 
security 
Estimated time 
1 hour 

Learning objectives 
In this lesson, you will: 

• Describe how Infor CRM handles security. 
• Discuss web security – secured actions and roles. 
• Discover network security – feature and function security. 
• Demonstrate field security. 
• Explain Account Ownership. 

Topics 
• How Infor CRM handles security 
• Manage field security 
• Account ownership 
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How Infor CRM handles security 
Infor CRM handles security differently based on whether users are accessing it through the Web Client or 
within the Windows Client. In the Web Client, roles and secured actions determine what actions can be 
taken. In the Windows Client, feature and function security are the determining factors, while 
administrator roles determine user access to administrative features.  

Additionally, both the Windows and Web Clients use field level security to determine the individual fields 
within an entity that a user can access. Accounts within both clients are further protected by their account 
ownership 

Windows security 
Windows Client security is handled primarily by feature and function security. Feature security determines 
whether a user can add or delete records. Function security determines which interface items in the client 
a user can take. For example, accessing an item from the File menu. Administrative roles can also be 
used to restrict user access to administrative features. 

Windows Client security is explained in more detail in a later lesson. 

Web security 
Web client security is handled primarily by roles and secured actions. Roles determine what functionality 
a user can access in the Web Client. Roles then use secured actions that have been assigned to them to 
determine access to user interface elements, such as pages and menu items. 

Web Client security is discussed in more detail in a later lesson. 

Field level security precedence 
Field level security prevents users from viewing and changing specific data when viewing an Infor CRM 
entity. When using field level security, greater access takes precedence over lesser access. 

If a user has more than one security profile (for example, the user is added to a team as a nested team or 
department and is also a direct member of the parent team), the security profiles share the same seccode 
(owner). When determining security access for a field, multiple profiles may be returned.  

In the Infor CRM Windows Client, access is determined based on how the user accessed the view. In the 
Web Client, access is determined by combining the maximum access of all profiles assigned to that user 
and owner. 

SECCODEID 
SECCODEID (Security Code ID) is the primary key in the SECCODE (Security Code) table of the Infor 
CRM database. Each team, department, and user created is assigned a SECCODEID in the database. 
When users create a new account record and select an owner, the owner’s SECCODEID is stored in the 
SECCODEID field of the ACCOUNT table. Infor CRM queries this SECCODEID field when determining 
which access is used for the account. It’s important to understand this as SECCODEID is used in many 
aspects of Infor CRM security. 
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User security 
The standard system provides a basic set of data security features. You can use account ownership to 
determine which users receive access to accounts and account related data. The system administrator 
has access to everything and the system administrator’s security access cannot be changed. Each user 
has a default security profile you can modify.  

The default security profile includes the following: 

• Users have read/write access to all tables  
• Users cannot create new teams  
• Administrative users can be granted rights to perform tasks normally reserved for the system 

administrator  
• The system administrator or administrative user can set field level security for each user 

(read/write and view access)  
• Security profile templates can be applied to all users (except WebViewer users)  

Security features 
Infor CRM provides tools to manage users’ access to, and sharing of, data, features, and plugins, such as 
processes and reports. Use the following table to determine which product feature supports your needs. 
 

To manage Use If you are a.. 

Ownership of a single 
account 

Owner Assignment dialog 
box in the Windows Client 

User or system administrator 

Changing a user’s data 
access to tables and fields 
as a member of a team 

Teams in Administrator System administrator or 
administrative user 

A user’s data access to 
tables and fields (default 
profile) 

User Profile Security tab in 
Administrator 

System administrator or 
administrative user 

A user’s access to menu 
items 

User Profile Function 
Security tab in Administrator 

System administrator or 
administrative user 

A user’s access to another 
user’s calendar 

User Profile Calendar tab in 
Administrator 

System administrator or 
administrative user 

A user’s access to plugins 
(processes, views, reports, 
templates, Basic scripts, and 
SQL scripts), and groups 

Plugins in Architect User with access to 
Architect or system 
administrator 

A user’s subscription to 
accounts 

Subscription List in Infor 
CRM Client and 
Administrator 

User, system administrator, r 
administrative user 

Ownership changes of all 
accounts and contacts 

See Realignment Scenarios 
to determine whether to use 
Teams or Territory 

System administrator or 
administrative user 
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Realignment in 
Administrator 
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Manage field security 
Field security prevents users from viewing or changing data. To prevent users from viewing or changing 
data, use the Security tab of a user’s profile. Field security refers to a user’s ability to view and/or change 
data for an Infor CRM entity. Field security is managed by using profiles which serve as a template for 
field security rules. After a template is created, these rules can be applied to more than one user or 
department. Field security profiles apply to both Windows and Web Client users. 

While creating custom field security profiles, there are three available system field security profiles in a 
new Infor CRM database: 

• Read Only: View access to all tables and fields. 
• Read/Write: Edit access to all tables and fields except Account Owner (seccodeid) which is 

read only. 
• Team Owner: Edit access to all tables and fields. 

From a Windows Client, Field Security profiles can be created from the Administrator application, In the 
Web Client, you can modify these from the Security Manager view. 

 

Exercise 4.1: Managing field security 
In this exercise, you will manage field security profiles. Profiles are created in both the 
Windows and Web Clients, as well as edited. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
Phoenix Computers wants to restrict new sales personnel from working with opportunities. 
Instead, they want them to focus on existing clients. A new field security profile is created, 
Sales_Training for the first 30-days a new employee in a sales department is with the 
company. 

Exercise steps 

Part 1: Manage field security profiles in the Web Client 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Click the Administration Nav Bar. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ManagingFieldSecurity.mp4
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5. Click Security Manager. This opens the Security Manager screen. 

Part 2: Create a field security profiles in the Web Client 

1. Click Add Profile. A Security Profile dialog box opens. 

2. Type Sales Training in the Description field. 

3. Select User from the Profile Type drop-down list. 

4. Click OK. This creates the new profile and opens it in the Security Manager screen. 

5. Select the Read-Only radio button in the AccountName property row. 

6. Click Sign Off. 

Note: Finding the information to set security within this view can be time consuming and 
cumbersome. Switching to the Administrator application allows for a much quicker and easier way 
to work with security profiles. Let’s switch to this view. 

Part 3: Create and apply a field security profile in the Windows Client 

1. Open the Infor CRM Administrator. 

2. Type admin in the Username field. No password is required.  

3. Click OK. 

4. Select Manage > Field Security Profiles. The Security Profile Manager dialog box opens. 

5. Double-click the Sales_Training security profile. The Edit Security Profile window opens. 

6. Select the Account item. 

7. Click Read/Write. This changes all the account fields back to Read/Write privileges. 

8. Select and expand the Opportunity item. 

9. Click No Access.  

Notice that by doing so, all sub fields change to No Access as well. They now show with a red X. 

10. Click OK. The edited profile is saved for later use. 

11. Click OK again. The Security Profile Manager dialog box closes. 

 

Exercise 4.2: Applying field security 
In this exercise, you will apply the Sales_Training field security profile to specific users and 
teams. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ApplyFieldSecurity.mp4
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Scenario 
Now that Phoenix Computers has the new field security profile, Sales_Training it needs to be 
applied to the appropriate Users and Teams. 

Exercise steps 

Part 1: Apply field security profiles to a user in the Web Client 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Click the Administration Nav Bar > Users. 

5. Open Derek Murphy’s detail view. 

6. Select More Tabs > Security. This opens the Security tab in the tabs pane. 

7. Select Sales_Training from the Template drop-down list. 

8. Click Save. 

Part 2: Apply field security profiles to user for a specific team in the Web Client 

1. Select More Tabs > Team Membership. This opens the Team Membership tab in the tabs 
pane. 

2. Click the FieldSales link in the EMEA row. The Murray, Derek dialog box opens. 

3. Select Sales_Training from the Security Profile drop-down list. 

4. Click Save 

This ensures Derek Murray only has Sales_Training rights even from accounts owned by the 
EMEA team. 

Part 3: Apply a default field security profiles to team in the Web Client 

1. Select the Administration Nav Bar > Teams. This opens the Teams screen. 

2. Click the Pacific team to open its detail view. 

3. Select Read/Write Default from the Security Profile drop-down list.  

This changes the default security for all members of the team to that security profile, unless 
otherwise specified in the user profile. Note: You can follow an identical path for departments. 

4. Click Sign Off. 

Part 4: Apply field security profiles to a user in the Windows Client 

1. Open the Infor CRM Administrator. 

2. Type admin in the Username field. No password is required.  

3. Click OK. 

4. Click the Users Nav Bar. 

5. Open Adam Garfield’s user profile. 
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6. Click the Security tab. 

7. Click Edit next to the Default field security profile field. 

8. Select the Read/Write Default profile. 

9. Click OK twice. 

This sets Adam Garfield’s default user field level security to the Read/Write Default profile. 

Part 5: Apply field security profiles to a team in the Windows Client 

1. Click the Teams Nav Bar. 

2. Select Pacific from the list of teams. 

3. Click Edit next to the Field security of user on this team field. 

4. Select Read/Write Default. 

5. Click OK. 

Part 6: Apply field security profiles to specific user within a team in the Windows Client 

1. Double-click Anne Avery from the expanded Pacific team. 

2. Click the Teams tab. 

3. Select the Pacific team. The Security Profile Manager dialog box opens. 

4. Select Team Owner Profile. 

5. Click OK twice. 

Account security can be restricted at the individual, team, and department level through field level 
access. You have already seen how to set security for a user. Now you can see how security 
applies to members of a team as a user, department, or nested team. 

 

Infor CRM supports a variety of security levels; however, most businesses find it 
easiest and most like their business model to limit account ownership to teams 
(instead of individual users). 

You can create custom security profiles to apply individual users or team members. 
 

Entity How Team Security Applies 

Individual 
Users 

When adding a user to a team, the user’s default security profile is automatically 
applied. Changing the field security of a user on a team only affects the user’s security 
as it applies to the accounts owned by that team. For all other accounts, the user’s 
default security profile is used if nothing else is specified. 
A user may have one or many security profiles, including a separate security profile for 
each team or department to which they belong. 

Departments Users who are part of a department share one security profile. You cannot modify a 
user’s team security profile if the user is part of a department. If you want a user to have 
a different security profile than the rest of the department, you must add the user directly 
to the top-level team (outside the department). 
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Nested 
Teams 

When adding one team to another team, it is referred to as a nested team. Users on a 
nested team share one security profile, similar to departments. The difference is that a 
nested team can own accounts, whereas a department cannot. 
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Account ownership 

Overview of account ownership 
Account ownership controls which accounts different users can access from the entire Infor CRM 
database. For example, when Lee Hogan logs on to Infor CRM, he has access to a total of 288 accounts 
whereas Lee's manager, Lou Pizzutti, has access to a total of 903 accounts.  

Note: The number of accounts may differ depending on what has been added to the Infor CRM database. 

 
Lee Hogan and Lou Pizzutti’s All Accounts List Views in Web and Window Client 

Why are the number of accounts different, when both are looking at the All Accounts group? The answer 
lies with account ownership rules. Every account has an Owner field. This field stores information which 
determines who owns the account. Based on the type of ownership, one or many users can use the 
account. There are four possible options for account ownership. 
 

Owner Description 

An individual 
user 

The account is owned by an individual user—typically the user who created the 
account. The user, members of the user's team, and the administrator can access these 
accounts. 

A team The account is owned by a team entity—not a specific user. Only members of the team 
can view and update these accounts. (Most companies implement team ownership 
instead of individual user ownership.) 

Everyone The account is owned globally. All Infor CRM users have access to these accounts. 
Everyone can see and update these accounts. 
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Everyone 
(View Only) 

The account is owned globally. All Infor CRM users have access to these accounts. 
Everyone can see these accounts but not update these accounts. 

 

 
Web Client view of an Account owned by Midwest team 

 
Windows Client view of an Account owned by the Midwest team 

Because these accounts use different options for their Account Ownership, the users who can view and 
edit these may be different. For example, Benefits Cable has the account ownership of Everyone. This 
allows the account to be viewed and edited by any Infor CRM user. Abbott Ltd. has the account 
ownership of Midwest, a team. Because of this, Abbott Ltd. can only be viewed by members of the 
Midwest team. 
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Exercise 4.3: Managing account ownership 
In this exercise, you will set the default account ownership setting on a user in the Web and 
Windows Clients. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Exploring account ownership 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Select the Sales Nav Bar > Account. This opens the Account main view. 

5. Look at the Total Records field at the top of the list view. Within the Phoenix Computer 
database, it should show around 1,000. 

6. Click Sign Off. 

7. Click Return to Sign In Page. 

8. Type Lee in the Username field. No password is required.  

9. Click Sign In. 

10. Select the Sales Nav Bar > Account. 

11. Look at the Total Records field at the top of the list view. Within the Phoenix Computer 
database, it should show around 300. 

The difference between these two numbers is determined by the Account Ownership property. 

12. Click the Abbott Ltd. Link to open its detail view. 

Notice that within Abbott Ltd., the listed Owner is Midwest and the listed Account Manager is 
Lee Hogan. 

13. Click Sign Off. 

14. Click Return to Sign In Page. 

Part 2: Modifying account ownership and account manager within the Web Client 

1. Type admin in the Username field. No password is required.  

2. Click Sign In. 

3. Select the Sales Nav Bar > Account. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ManageAccountOwnership.mp4
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4. Click the Abbott Worldwide link to open its detail view. 

5. Click Find within the Owner field. The Lookup Owner dialog box opens. 

6. Select Atlantic. 

7. Click OK. 

8. Click Save. 

9. Click List View. 

10. Open the Abbott Ltd. detail view. 

11. Click Find within the Owner field. The Lookup Owner dialog box opens. 

12. Select Atlantic. 

13. Click OK. 

14. Click Find within the Acc Manager field. The Lookup User dialog box opens. 

15. Select Anne Avery. 

16. Click OK. 

17. Click OK again when the Update Contact Options dialog box opens. 

18. Click Save 

Part 3: Changing a user’s default owner 

1. Select the Administration Nav Bar > Users. 

2. Click Lee Hogan. This opens the User – Lee Hogan screen. 

3. Click the Client System tab. 

4. Click Find within the Accounts field in the Default Owner area. 

5. Select Midwest. 

6. Click OK. 

7. Click Save.  

8. Click Sign Off. 

Note: You cannot set a default owner from a team or a department, as the default owner is pulled 
from the user creating the account. 

Part 4: Applying field security profiles to a user in the Windows Client 

1. Open Infor CRM Administrator. 

2. Type admin in the Username field. No password is required.  

3. Click OK. 

4. Click the Users Nav Bar. 

5. Double-click Lee Hogan to open his user profile. 

6. Click the Client System tab. 

7. Click the Find icon from the Account field within the Default Owner group. The Owner 
Assignment dialog box opens. 
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8. Select Midwest. 

9. Click OK. 

 

Exercise 4.4: Exploring account ownership 
In this exercise, you will learn how account ownership works. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Applying field security profiles to a user in the Windows Client 

1. Open the Infor CRM Windows Client. 

2. Type derek in the Username field. 

3. Click OK. 

4. Select the Sales Nav Bar > Opportunities. 

Notice how Derek has 22 opportunities available. However, you cannot see them due to the 
restricted settings of the Field Security profile you assigned to him. 

5. Click Accounts. 

6. Click Abi Specialty Group. 

Note: Derek has access to this account. 

7. Close the Infor CRM Web Client. 

8. Open the Infor CRM Windows Client. 

9. Type Lee in the Username field. No password is required. 

10. Click OK. 

11. Select the Sales Nav Bar > Accounts. 

12. Switch to the list view if not already viewing it. 

13. Select the All Accounts group. 

Note: Lee does not have access to this Abi Specialty group because of account ownership 
rules. 

Part 2: Exploring account ownership in the Web Client 

1. Open the Infor CRM Web Client. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ExploreAccountOwnership.mp4
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2. Type derek in the Username field. No password is required.  

3. Click Sign In. 

4. Select the Sales Nav Bar > Accounts. 

Note: Abi Specialty Group is available again as Derek has ownership access. 

5. Click Opportunities. 

Note: Derek can see 88 records, however, most of the information is hidden and he cannot 
access the detail view. 

6. Click Sign Off. 

7. Click Return to Sign In Page. 

8. Type admin in the Username field. No password is required.  

9. Click Sign In. 

10. Open the Opportunities list view. 

Note: The administrator can see all items and detailed information, as well as opportunities for 
Abi Specialty Group. Derek was unable to see the Abi Specialty Group opportunities even though 
Derek was an owner of that account.  
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Check your understanding 
 

 
What are the main components of Infor CRM’s Web Client security? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What are the main components of Infor CRM’s Windows Client Security? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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What is the importance of the Security Code ID (SECCODEID) field? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What is the importance of Account Ownership? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Lesson 5: Sync Server setup 
Estimated time 
2 hours 

Learning objectives 
In this lesson, you will: 

• Identify the prerequisites to setting up a Synchronization Server Profile. 
• Understand what happens on the sync server during the synchronization process. 
• Summarize the benefits of using a synchronization schedule. 
• Describe a scenario in which a synchronization conflict might occur. 
• Explain the purpose of a sync transfer profile. 

Topics 
• About synchronization 
• Synchronization folders on the Server 
• Sync Server schedules 
• Conflict resolution 
• Sync transfer profiles 
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About synchronization 
If your installation supports remote/offline users or remote offices, changes to all Infor CRM databases 
must be reconciled. Infor CRM achieves this using synchronization. 

In Infor CRM, synchronization is like an exchange of files (containing database changes) between remote 
offices, remote/offline users, and the main office. This file exchange is possible because all changes 
made to the remote and main database are logged in Transaction Exchange Files (TEFs). Infor CRM 
synchronizes at the field level meaning when a specific value is changed only the field change is sent. 
The entire record doesn’t have to be sent to the main database or to the remote offices and users. 

No actual connection exists between the Sync Server and the remote database. Instead, Infor CRM uses 
an off-line synchronization process where all communication is accomplished by both the Sync Server 
and the Sync Client placing files in and retrieving files from the location(s) specified by the sync transfer 
profile. 

Where should I install the Sync Server? 
In this training workstation, all servers and administrative tools, including the Sync Server, are already 
installed. However, you haven’t yet installed the Synchronization Client because you’ll do this as part of 
the Remote Client installation. 

In a production environment, it’s best practice to install the Sync Server on a dedicated server with a large 
hard drive where everyone has access to the SyncLogs folder. This means you need to run the Infor 
CRM Server Installation on the dedicated server, choose Required Administrative Tools and Servers, and 
choose a Custom Setup with only the Sync Server. 

 

 

This installation requires 16 MB. Additional space is required on the hard drive where the 
SyncLogs folder resides. The amount of space required depends on the volume of TEFs, 
the number of users, and the use of attachments and library items. 

Does synchronization require a license? 
Yes. Before you can configure the Sync Server you must add the Sync Server license. When this license 
is installed, the following features are enabled in the Infor CRM Administrator: 

• All fields in the Edit Office Information window (Sync Options tab) become enabled.  
• The SyncServers tab becomes editable in the System Information view. 
• You can access and launch the Sync Server under Program Files. 

Contact your sales/account representative to purchase a Sync Server license. Your implementation may 
require multiple Sync Server licenses depending on the activity and volume of TEFs on the servers. The 
recommended maximum number of users per Sync Server is 150. 
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Exercise 5.1: Adding a Sync Server license 
In this exercise, you will add the Sync Server license. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
My company has a field sales team which frequently travels. When our field sales 
representatives are disconnected from the network, how can they access key accounts to 
update data? 

• Add the Sync Server license from the Class Files folder. 
• Setup the Sync Server profile. 

Exercise steps 
1. Copy the Sync Server license key to your Windows clipboard from the class documentation. 

2. Open Infor CRM Administrator. 

3. Type admin in the Username field. No password is required. 

4. Select the Systems Nav Bar. The System Inform. 

5. ation screen opens. 

6. Click the Licenses tab. 

7. Right-click and then select Add License. The License Wizard window opens. 

8. Paste the license into the window. 

9. Click Next. 

Since Infor CRM detected this as a Sync Server license, you’re prompted for additional 
information required to create a Sync Server profile. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/AddTheSyncServerLicense.mp4


 

  Infor CRM: v8.4 Administering Training Workbook 91 
   

  © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

 
10. Type Main Sync Server in the Description field. 

11. Type \\SRV10\SyncLogs in the Shared path for Logging field. 

Note: This location may be different on your training environment.  

This path is generally on a separate server from the Administrator workstation, however, because 
you’re using one machine to install everything, you can enter a local path. 

12. Type 100 in the field next to Send no more than.  

This value determines the number of accounts sent to a remote/offline user during a single 
synchronization cycle. This value varies by company. In the SALESLOGIX_EVAL database, you 
have 12 users and less than 1000 total accounts so raising this number will not impact 
performance. 

13. Verify the Sequence files before apply check box is selected.  

This setting ensures duplicate, missing, or incorrect TEFs are resolved during the synchronization 
process. Although this process can take more time, with few remote/offline users, you can afford 
to take this precaution. 

file://SRV10/SyncLogs
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The Site Code in the window header (in this example, “PAZY”) is automatically 
assigned to each new Sync Server, remote user, remote office, and database. A 
Site Code is tagged on each TEF which tells the Sync Server which TEF is going or 
coming to/from which place. The Site Code your environment is assigned may be 
different than “PAZY.” 

14. Click Next. 

15. Click Finish in the License Wizard. 
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Synchronization folders on the server 
Synchronization requires a specific set of folders to exist on the Sync Server and each remote. Let’s 
review the server folders here. 

What happens the first time you run the Sync Server? 
The first time you run the Sync Server, Infor CRM: 

• Creates the required logging subfolders under the SyncLogs directory. 
• Creates new subfolders under the Sync directory. This Sync directory is set at the installation of 

the Sync Server under C:\ProgramData\SalesLogix. 

What is the purpose of the SyncLogs subfolders? 
The SyncLogs folder on the server contains synchronization metadata related to Network Users. The 
following table describes the subfolders created under the SyncLogs directory: 
 

Directory Purpose 

Archives Stores copies of the TEFs placed in the Outfiles for remote/offline clients to 
retrieve during synchronization. 

Documents Stores attached files for the Main Office Database Server. The folder must be 
shared and the path must be set in the Edit Office Information window. 

FailedTrans Temporary holding place for failing transactions. When a sync error occurs 
during the sync cycle, a transaction containing the error and information from 
the TEF is written to the FailedTrans folder. Errors are also written to the 
SyncError.txt file. You can view failed transaction files using TrnViewer. 

Infiles Stores TEFs received from remotes. 

Library This is the root folder for the library system. The folder must be shared and 
the path must be set in Edit Office Information. 

Outfiles Stores TEFs for remotes to retrieve during synchronization. 

PortalDeployments Contains any new Web portal from the Application Architect to be delivered to 
offline (web) users and remote offices. Each portal within the folder has its 
own folder named <GUID>_PortalName>. 

SharedLogs Saves copies of all applied changes in systems using more than one Sync 
Server. 

Tasks When a remote/offline user or office uses the Retrieve option under Remote 
Tasks to transfer a file, a TEF is created by the Sync Client and is deposited 
here. 

WGLogs Stores TEFs created by Client users for changes made to the Main Office. By 
default, WGLogs is closed every 30 minutes. 
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What is the purpose of the other Sync Server folders? 
In addition to the SyncLogs subfolders, when running the Sync Server, the following new subfolders are 
created under the Sync folder: 
 

Directory Purpose Path 

EventLogs Stores synchronization logs 
in text format that you can 
open with Notepad. In 
Synchronization Server, 
under Options, Logs tab, 
use the Save to Local 
Folder or Save to Server 
Path setting. When 
synchronization is run, the 
folder is created. 

\\Documents and Settings\All Users\Application 
Data\Saleslogix\Sync\EventLogs(XP/2000/2003) or 
\\ProgramData\Saleslogix\Sync\EventLogs 
(Vista/7/2008) or \(server shared path) EventLogs. 

SRVXX This folder holds the 
WriteCache folder and the 
ConfTran.stm file used for 
conflict resolution. 

\\Documents and Settings\All Users\Application 
Data\Saleslogix\Sync(XP/2000/2003) or 
\\ProgramData\Saleslogix\Sync (Vista/7/2008). 
The folder’s name is server_name-alias_name. 

 

Folder considerations for virus-checking software 
If you have virus-checking software scanning synchronization folders as the Sync Server tries to use a file 
within the folders, you may receive an “Error deleting file or folder” error. This occurs when the virus 
checking software checks the file at the exact moment the Sync Server tries to use the file. 

To avoid errors, set your virus-checking software to modify scans to skip the following folders during real-
time scans and/or scans scheduled to run when the Sync Server is scheduled to run. If anti-virus 
programs are scanning the following folders in real time during a synchronization cycle it may cause 
problems with synchronization to remotes. 

• WriteCache 
• Infiles 
• Outfiles 
• FailedTrans 
• WGLogs 
• SharedLogs 
• Archives 

What happens when the Sync Server process is run? 
During a synchronization cycle on the server, several transactions occur. The following table describes 
this process: 
 

Step Description 

1 A network user (Infor CRM Client, Architect, Administrator) makes changes to 
the main office database. For each change, the main office database is updated 

file://Documents
file://ProgramData/Saleslogix/Sync/EventLogs
file://Documents
file://ProgramData/Saleslogix/Sync
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Step Description 
and a record is written to a transaction exchange file (TEF) located in the main 
office WGLogs folder. The record represents only the specific values changed, 
not the entire table record (field level synchronization). If the database is 
changed because of an agent, then the change is recorded and synchronized. 

2 Sync Server checks the WriteCache folder for any transaction files not 
processed and does one of the following with found files: Deletes if a 0 kb, 
moves to Outfiles folder for processing, or leaves as is. 

3 Sync Server processes all TEFs in the main office WGLogs folder. Because 
these files reflect changes already made to the host database, the information is 
written to the ConfTran.stm file for later use in conflict resolution. Only closed 
WG Logs are processed. The interval to close WG Logs is set on the Sync 
Options tab of the Edit Office Information dialog box. 

4 Sync Server searches the SharedLogs folder for any files generated by 
secondary Sync servers and updates the database with changes. The contents 
of the SharedLogs folder are duplicate Workgroup Logs and Infiles processed by 
other Sync servers and detail changes made to the main database by the 
secondary Sync servers. 

5 Sync Server receives all Remote Client files from the server Infiles directory. 
Files containing documents or other attachments are placed in the shared 
Documents folder after decompression. Requests from remote/offline users for 
Library documents are applied. 

6 If the Sequence Files Before Apply option is set on the main Synchronization 
Server and in each remote user’s profile, then (a) files confirming successful 
application of a file and requesting missing files are processed, (b) missing files 
are copied from the Archives folder to the Outfiles folder to be resent to the 
remote, and (c) TEFs containing database changes are sorted, checked for 
duplicates, missing index numbers, or an incorrect starting index number and 
apply changes to the database. 
If a missing file is not available in the Archives folder, a log file in the missing 
TEFs name is sent instead. See Resolving Synchronization Apply Problems to 
understand how problems with TEFs are handled. 

7 Sync Server uses the ConfTran.stm file to compare all records for conflicts and 
applies the information to the main office database. If the file cannot be applied 
because of an error, it is written to the SyncErrors.txt. 

8 After all Infor CRM Remote Client TEFs are applied they are deleted from the 
server Infiles folder. WGLogs files and SharedLogs files are also deleted. 

9 If the Sequence Files Before Apply option is set, an acknowledgment transaction 
is sent to the Remote Client, and the Outfiles stored in the remote’s Archives 
folder are deleted. If Sequence Files Before Apply is not set, Outfiles remain in 
the Archives folder until they are deleted manually. 

10 Sync Server creates one TEF for each Remote Client and selects all records for 
a specific Remote Client to which the user has subscribed. The TEF is written to 
the Server Outfiles path, is compressed and encrypted. 
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Step Description 
If a portal has been created for an Offline Web Client or Web Remote Office, the 
portal is saved in the PortalDeployments folder within its own folder named 
<GUID>_<PortalName>. This folder also contains the list of users the matching 
portals will be deployed to. 

11 To send the files to the Infor CRM Remote Clients, Infor CRM Client opens the 
log files in the WGLogs folder and writes them to the WriteCache folder as it 
compresses them into TEFs. Once the log files are converted to TEFs, the logs 
are deleted. 

12 Any missing TEFs requested by the remotes are copied from the Archives folder 
into the Outfiles folder. All confirmed TEFs are deleted. Any Documents or 
Library items are compressed into TEFs. 

13 Once all these TEFs are processed, they are placed in the Archives folder for 
confirmation and into the Outfiles folder for transmission to remote/ client users 
the next time they synchronize. 

14 Sync Server copies all records from the ConfTran.stm to the server log. Records 
needed to support conflict resolution are saved for the length of time specified 
when setting up conflict resolution rules in the Administrator. 

15 If Agents are scheduled, they run after the synchronization cycle is complete. 
Any synchronization files resulting from the agents are copied to the Outfiles 
folder so they are ready for remotes. 

 

 

Exercise 5.2: Starting the Synchronization Server 
In this exercise, you will register the machine and run the Sync Server. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
I installed the Sync Server, added the required license, and setup a Sync Server profile. How 
do I start the Sync Server for the first time? 

• Register the current machine as the Sync Server. 
• Run the Sync Server to create additional logging folders. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/StartTheSynchronizationServer.mp4
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Exercise steps 
1. Select Start > Programs > Saleslogix > Synchronization Server. 

2. Type admin in the Username field. No password is required. 

3. Click OK. 

Since this is your first time running the Sync Server, a Confirm window opens prompting you 
register the machine as the Sync Server with the database. 

 
4. Click Yes. The Verify Administrator Password window opens. 

5. Confirm the field is blank; There is no password. 

6. Click OK. The Synchronization Server window opens. 

7. Click Sync Now. 

 
During synchronization, messages displaying in the Sync Server dialog box are written to the 
event log in the EventLogs folder (C:\ProgramData\Saleslogix\Sync). A new file is created each 
time you sync, unless you specifically save them as one large file on the Logs tab of the File > 
Options window of the Sync Server. 

8. Browse to C:\SyncLogs when the cycle is complete. Notice the new subfolders created by the 
Sync Server. 
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Sync Server schedules 
You can run synchronization in three ways: 

• Manually using the Sync Server or the Command Prompt 
• As a service 
• Third party scheduler 

Why run synchronization as a service? 
Running the Sync Server from a Windows service allows synchronization to process without an 
administrator signed in to the server. You can monitor the status of the scheduled jobs using the Infor 
CRM Monitor Console. The Monitor Console monitors remotely so it can run from any computer with 
access to the computer(s) where the synchronization service is installed. The Monitor Console is installed 
with the Administrative Tools. 

 

 

You can configure one sync automation service profile per server but each profile can 
have any number of jobs using various databases. 

How often should the synchronization service run? 
A synchronization cycle is the time required by the Sync Server to process changes and generate files for 
remotes. The time it takes to complete a sync cycle and the frequency with which you should schedule 
them depends on the number of TEFs sent, your synchronization method, and the amount of traffic on 
your network. For best results, run synchronization during off-peak times or after normal business hours. 

 

Exercise 5.3: Scheduling the Synchronization Server 
In this exercise, you will create a service configuration schedule and monitor the schedule. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
How do I schedule the Sync Server so I don’t have to start it manually every few hours? 

• Create a sync automation service profile. 
• Setup the Monitor Console to monitor the schedule. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ScheduleTheSynchronizationServer.mp4
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Exercise steps 

Part 1: Create a service configuration schedule 

1. Open Infor CRM Administrator. 

2. Type admin in the Username field. No password is required. 

3. Click the Systems Nav Bar. The System Information view opens. 

4. Click the Sync Automation Services tab. The Sync Services File Path window opens. 

5. Type \\SRV10\SyncService in the shared file path field. You created this field in an earlier lesson 
and shared it with everyone (full control). 

6. Click OK. 

7. Right-click within the empty space on the Sync Automation Services tab and then click Add 
Service. The Service Configuration window opens. 

8. Enter the following details: 

• Service Name: Daily Sync 
• Service Machine: SRV10 
• Service Port: 8950 
• NT Log Level: Select Errors, Warnings, and Information 
• Job Name: Daily Sync Job 
• Sync Server: Select your server from the drop-down list 
• Enabled check box: selected 
• Run on: Verify every day of the week is selected 
• Daily Schedule: Every 60 minutes between 6:00AM and 7:00PM 

9. Click Apply Job. 

10. Click OK. 

11. Restart the Infor CRM synchronization service after the sync automation service has been 
created. 

12. Select Start > Administrative Tools > Services. The Services window opens. 

13. Right-click Saleslogix Synchronization Service in the list of services and then click Restart. 

14. Close the Services window. 

Part 2: Monitor the schedule 

1. Browse to C:\Program Files (x86)\Saleslogix and open SLXMonitorConsole.exe. The Monitor 
Console opens. 

2. Select File > Register Service. The Service Registration window opens. 

3. Type Daily Sync in the Service Name field. 

4. Type SRV10 in the Machine Name field. 

5. Type 8950 in the Port field. 

6. Click OK. 

The Daily Sync service adds to the list and the green arrow is indicating it’s currently being 
monitored. 
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7. Expand the Daily Sync service and then click Pending Jobs. 

Notice the Daily Sync job is pending to run within the hour (every 60 minutes). 

8. Close the Monitor Console window. 

With the Monitor Console configured, you can remotely monitor the status of processes and jobs 
running on the Sync Server. 
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Conflict resolution 
After installing and configuring the sync server you can set additional synchronization options to support 
conflict resolution preferences. 

What is conflict resolution? 
Conflict resolution is the process used during synchronization to determine which database changes 
remain when more than one user changes the same data. Using conflict resolution, you can identify up to 
three criteria determining which user wins when a conflict occurs. After analyzing the conflicting 
transactions, a win, loss, or tie occurs. In the event of a tie, the next criterion is used to settle the conflict. 
Generally, if all options are exhausted and the transactions are still in conflict, the system allows the most 
recent change to win. 

The default conflict resolution rules are: 

• The user wins if he or she is a remote/offline client. 
• If after step one both users are equal, the user wins if he or she is the owner of the record. 
• If after step two both users are equal, the user wins if he or she makes the most recent change. 

What happens to a rejected transaction? 
Rejected conflicts and accepted transactions are stored in the ConfTran.stm file for a specified number 
of days and can be used later for reference and resynchronization. After a set time period, old 
transactions are deleted and a notification is sent to the user whose transaction is rejected. This user can 
view a list of conflicts as well as normal database changes in the What’s New view in the Infor CRM 
Remote and Offline Clients. 

 

 

It’s best to limit the time for the ConfTran.stm file to something relatively small to optimize 
Sync Server performance. 

 

Exercise 5.4: Setting conflict resolution rules 
In this exercise, you will set conflict resolution rules. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/SetConflictResolutionRules.mp4
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Scenario 
Before our remote/offline users use synchronization, how can I set conflict resolution rules so 
Infor CRM knows which change to apply to the database in the event a remote/offline and 
Windows user change the same data? 

• Change the default rule priority so the user who makes the most recent change 
always wins regardless of other criteria. 

• Phoenix Computers has a small number of remote employees to keep sync 
performance in check so extend the default value to retain updates for 14 days. 

Exercise steps 
1. Open Infor CRM Administrator. 

2. Type admin in the Username field. No password is required. 

3. Select Tools > Options from the menu bar. The Options window opens. 

4. Click the Conflicts tab. 

5. Select made the most recent change from the rule priority 1. The user wins if (s)he drop-down 
list. The other rule priorities become disabled as they’re no longer applicable. 

6. Type 14 in the field next to Retain updates to support Conflict Resolution for. 

7. Click OK. 
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Sync transfer profiles 
When developing synchronization strategy, administrators must determine how remote office and 
remote/offline users send and retrieve transactions. Generally, remote office and remote/offline users do 
not have persistent connections to the network and intermittently connect to the sync server via the 
Internet after working offline for some time. Infor CRM supports three synchronization methods: Network 
Synchronization, FTP, and HTTP. 

Why use a network sync transfer profile? 
If remote/offline users connect to your company’s network through a VPN (Virtual Private Network), Infor 
recommends creating a network sync transfer profile. Using VPN, remote users connect to the Infor CRM 
network via the Internet to send and receive transactions from the main office database. This is the 
default method of synchronization for most companies using the Windows (network/remote) Clients. 

Why use an FTP sync transfer profile? 
If you have an FTP site on an FTP server, Infor recommends creating an FTP sync transfer profile. 
Remote offices and remote/offline users upload and download files through the Internet or a TCP/IP 
network connection using FTP. 

When creating an FTP site for Infor CRM, you must: 

• Create three folders on the FTP server. For example, /Infiles, /Outfiles, and /FailedTrans. These 
folders must be shared and all remote/offline users and the Sync Server must have read, write, 
and delete access. 

• Create three virtual directories pointing to the /Infiles, /Outfiles, and /FailedTrans folders. All 
remote/offline users as well as the Sync Server must have read, write, and delete access to these 
directories. 

Tip: If your organization uses FTP to synchronize data, you can create additional directories to improve 
data transfer. Refer to the Infor CRM Administrator Help for more details. 

Signing on to an FTP site can be accomplished in one of two ways: 

• Global logon: Using a global logon, the Sync Server and all remote/offline users share the same 
logon and password. 

• Personal logons: Using personal logons, the Sync Server and each remote/offline user is 
assigned a different logon to the FTP on the Sync tab of each remote user profile. 

Why use an HTTP sync transfer profile? 
If you have an HTTP/web site hosted on a Microsoft ® Internet Information Services (IIS) server already 
deployed on your network, then you can leverage your existing network infrastructure and services 
required for transferring sync data via HTTP. HTTP Synchronization provides a secure method of 
transferring data using a website on an HTTP Server and requires Internet Information Services (IIS) with 
World Wide Web Service installed. 

When the Sync Server cycles, it connects to the HTTP Server and searches the Infiles folder for any 
transaction exchange files (TEFs) uploaded by remote/offline users. Likewise, when the Sync Client 
cycles it connects to the HTTP Server and searches the Outfiles folder for any transaction exchange 
files placed there by the main office. All transaction exchange files, library files, and documents are 
uploaded to and downloaded from the HTTP Server. 
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When creating an HTTP site for Infor CRM, you must: 

• Create three folders on the FTP server. For example, /Infiles, /Outfiles, and /FailedTrans. These 
folders must be shared and all remote/offline users and the Sync Server must have read, write, 
and delete access. 

• Create three virtual directories pointing to the /Infiles, /Outfiles, and /FailedTrans folders. All 
remote/offline users as well as the Sync Server must have read, write, and delete access to these 
directories. 

Signing in to an HTTP site can be accomplished in one of two ways: 

• Global logon: Using a global logon, the Sync Server and remote/offline users share the same 
logon and password. 

• Personal logons: Using personal logons, the Sync Server and each remote/offline user is 
assigned a different logon to the HTTP on the Sync tab of each remote/offline user profile. 

 

Exercise 5.5: Creating an HTTP sync transfer profile 
In this exercise, you will create an HTTP sync transfer profile. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
My organization has an HTTP server available to use for synchronization. How do I create an 
HTTP sync transfer profile to configure remote/offline users who aren’t able to connect 
through VPN? 

• Create the HTTP site directory and subfolders. 
• Enable permissions to the directory. 
• Create an HTTP site with the required folders. 
• Create the sync transfer profile within the Infor CRM Administrator referencing the 

HTTP site you created. 

Exercise steps 

Part 1: Create the HTTP site directory and enable permissions 

1. Create a folder named “HTTPSync” in the following location: C:\Inetpub\wwwroot\. This is for 
the Infor CRM HTTP Sync web application on the HTTP (web) server.  

2. Create the following subfolders within the HTTPSync folder: 

• Infiles 
• Outfiles 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/CreateAnHTTPSyncTransferProfile.mp4
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• FailedTrans 

You must allow domain users access to the site. Let’s use Everyone in the training environment. 

3. Right-click the new HTTPSync folder and then click Properties. The HTTPSync Properties 
window opens. 

4. Click the Security tab and then click Edit. The Permissions for HTTPSync window opens. 

5. Click Add. The Select Users or Groups window opens. 

6. Type Everyone in the Enter the object names to select field. 

7. Click Check Names. 

8. Click OK. 

9. Select the Everyone group and then select the Full control check box. 

10. Click Apply. 

11. Click OK. 

  
12. Click OK again to close the HTTPSync Properties window. 

Part 2: Create and configure an HTTP site for sync 

1. Select Start > Administrative Tools > Internet Information Services (IIS) Manager. The 
Internet Information Services window opens. 

2. Expand SRV10 in the Internet Information Services tree view. 

3. Right-click the Sites folder and then click Add Website. The Add Website window opens. 

4. Type HTTPSync in the Site name field. 

5. Type C:\Inetpub\wwwroot\HTTPSync in the Physical path field. 

6. Type 8080 in the Port field. Note: You can use any unused port higher than 1024. 
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7. Click Connect as. The Connect As window opens. 

8. Select the Specific user radio button and then click Set. The Set Credentials window opens. 

9. Type WebDLL in the User name field. 

10. Type crmweb in the Password and Confirm password fields. 

Note: Your production installation may have a different username and password. 

11. Click OK. 

12. Click OK again to close the Connect As window. 

13. Click Test Settings to verify it’s working correctly. 

14. Click Close. 

15. Click OK to close the Add Website window. 

16. With the HTTPSync website still selected, double-click Authentication in the features view. The 
Authentication list opens. 

17. Select Anonymous Authentication and then click Disable under Actions in the Actions pane. 

 
18. Select Windows Authentication and then click Enable. 

19. Click the Providers link. The Providers window opens. 

 
20. Select NTLM and then click Move Up to move it to the top of the list. 

21. Click OK. 

22. Select the HTTPSync website in the tree list view again and double-click MIME Types within the 
features view. 

23. Right-click in the workspace and then click Add. The Add MIME Type window opens. 

24. Type SLXT in the File name extension field. 

25. Type text/plain in the MIME type field. 
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26. Click OK. 

27. Return to the HTTPSync features view and double-click WebDAV Authoring Rules. 

28. Click Enable WebDav in the Actions pane. 

29. Click Add Authoring Rule in the Actions pane. The Add Authoring Rule window opens. 

30. Select the All users radio button within the Allow access to this content to pane. 

31. Select the Read, Source, and Write check boxes within the Permissions pane. 

 
32. Click OK. 

33. Return to the HTTPSync features view and double-click Directory Browsing. 

34. Click Enable in the Actions pane. 

35. Verify the Time, Size, Extension, and Date check boxes are selected and then click Apply if 
necessary.  

36. Exit the IIS Manager by selecting File > Exit. 

37. Reset IIS by selecting Start > Run, typing iisreset, and then pressing Enter. 

38. Close the command prompt. 

Part 3: Create a sync profile 

1. Open Infor CRM Administrator. 

2. Type admin in the Username field. No password is required. 

3. Select Manage > Sync Transfer Profiles from the menu bar. The Sync Transfer Profile 
window opens. 
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4. Click Add. The Edit Sync Transfer Profile window opens.  

5. Select HTTP Sync Transport v1.2 (SShttp.dll) from the DLL drop-down list. 

6. Type HTTP Sync in the Description field. 

7. Click Setup.  

 
8. The HTTP Sync Transport Options window opens. Type SRV10 in the Web Site field.  

9. Type 8080 in the Port field. 

10. Type /Infiles in the Infiles field. 

11. Type /Outfiles in the Outfiles field. 

12. Type /FailedTrans in the FailedTrans field. 

13. Select the Login and password below radio button. 

14. Type webdll in the Login field.  

This is the global login shared by all remote/offline users and the Sync Server. 

15. Type crmweb in the Password field. 

 
Personal logins for remote/offline users are set in the individual's user profile. 

16. Click OK. 
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17. Click OK again to close the Edit Sync Transfer Profile window. 

18. Click OK again to close the Sync Transfer Profiles window. 
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Check your understanding 
 

 
What are the prerequisites to setting up a Synchronization Server profile? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What happens on the sync server during the synchronization process? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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What are the benefits of using a synchronization schedule? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What is the purpose of a sync transfer profile? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Lesson 6: Remote/Offline database 
setup 
Estimated time 
1 hour 

Learning objectives 
In this lesson, you will: 

• Summarize user profile sync options. 
• Attach a Remote Database. 
• Create a Remote Database link. 

Topics 
• Remote/Offline user configuration 
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Remote/Offline user configuration 
When opening the User Profile window for a user configured with a Remote User license, all fields on the 
Sync tab are editable. These settings determine what data is included in the remote database, such as 
which sync transfer method the user can use, which accounts the user sees, whether the user can see 
file attachments and file size limit, and which activities the user can see. 

Configure user Sync settings before creating the remote database. Any changes you make to these 
settings after creating the remote database require you to re-create it. 

 

 

The computer used for creating remote databases must have SQL 2005 Native client 
installed. 

Subscription Rules: What account records are included in a remote database? 
By default, a remote database includes certain accounts. These records are called forced accounts and 
include the following: 

• All accounts owned by the user individually, not a team. 
• All accounts owned by the user’s team where (s)he is the team owner. 
• All accounts for which the user is assigned an activity. 

To sync only certain accounts, limit the number of records in a user’s database. This has several benefits 
including minimizing the amount of space required on the user’s computer for data storage and reducing 
the time required to transmit synchronized data. 

To limit accounts, you can: 

• Select them individually: Only accounts to which the user has access are available for 
inclusion. You can also individually unsubscribe from selected accounts except for forced 
accounts. 

• Set up a subscription rule: New accounts automatically get sent to the user if they meet a 
specific set of criteria. For example, you may choose to subscribe a user to accounts owned by 
Everyone only if an open opportunity with a close probability of 75% or more exists in the data 
set. 

You can also allow or prevent users from creating their own subscription rules or unsubscribing from 
accounts. Users can never unsubscribe from forced accounts. 

Attachment Filters: What documents are sent to remotes? 
Like accounts, library items are also handled by request. Attachments on the other hand are automatically 
included in synchronization with the appropriate record if they don’t exceed the file size or the number of 
days old criteria specified in the Attachment Filters. 

What’s New Options: What changes were made since the last sync? 
Whenever the Sync Server cycles, changes made by Windows Client users are queued to be picked up 
by a remote user’s database the next time the user runs sync on the Synchronization Client. The remote 



 

116  Lesson 6: Remote/Offline database setup 
  

 © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

user affected by the change, meaning the user or the user’s team owns a record that has been 
added/updated/deleted, can view the change by selecting the What's New view from the Sales Nav Bar. 

By default, remote users can view new activity for accounts, contacts, opportunities, and activities. To 
limit the data a user sees or to allow users to see notification of changed history records, lost conflicts, or 
delivered documents, configure the What’s New Options (User Profile > Sync settings in the Infor CRM 
Administrator). 

History Options: Do history records expire? 
By default, all history records included with a record remain in the remote user’s database indefinitely. To 
change these options to free up space, modify the History Filters. When choosing to purge history 
records, all selected records are deleted from the user’s database after a specified number of days unless 
created by the remote user in which case they stay. The default number of days is 180. 

Create remote databases 
After setting options for each user, create a unique remote database file for each user, and then distribute 
the remote database file to each user’s computer. If the Remote user’s computer is connected to the 
network, create a folder on the Administrative Workstation and copy the database to the folder. Share this 
folder so that the Remote user’s computer has access to it. 

If the Remote user is not connected to the network, copy the database to the user’s computer using some 
form of removable media. Another option is to zip the database, e-mail it to the Remote user, and instruct 
the user to copy it to his or her computer and unzip it. 

 

 

If remote clients use Infor Xbar to integrate Infor CRM and Microsoft® Outlook®, the 
SData portal must be deployed to remote clients. See the Infor CRM Implementation 
Guide for more information. 

 

Exercise 6.1: Configuring user sync options 
In this exercise, you will configure user sync options. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
Although Lee is a member of both the Global and Midwest teams, he primarily accesses 
accounts for Midwest and those on the Global team where he is the Account Manager. 

• Configure the Sync settings for Lee Hogan’s user profile. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ConfigureUserSyncOptions.mp4
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• Select a subscription rule so Lee only syncs records owned by the Midwest team. 

Exercise steps 
1. Open Infor CRM Administrator. 

2. Type admin in the Username field. No password is required. 

3. Double-click Lee Hogan in the Users view. The User Profile for Hogan, Lee window opens. 

4. Click the Sync tab. 

5. Select HTTP Sync from the Sync Transfer Profile drop-down list. 

6. Select the Synchronize Changes check box. 

7. Click Subscription Rules. The Subscription Rules window opens. 

 
8. Select Midwest and then click Copy. 

9. Click Add. The New Subscription Rule/Template window opens. 

10. Select the Create a New Rule radio button. 

11. Click OK. The Query Builder window opens. 

12. Type Global Lee in the Name and Display Name fields. 

13. Click the Conditions tab. 
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14. Double-click Accountmanagerid from the list of fields in the top right pane. The Assign 
Condition: Account.Accountmanagerid window opens. 

15. Click Browse. The Select Values for Account.Accountmanagerid window opens. 

 
16. Double-click Lee Hogan. 

 
17. Click OK to return to the Query Builder – New Query window. 

Notice the field is added to the Conditions tab. 

18. Double-click Seccodeid from the list of fields in the top right pane. The Assign Condition: 
Account.Seccodeid window opens. 

19. Click Browse. The Select Values for Account.Seccodeid window opens. 

20. Double-click Global. 

21. Click OK to return to the Query Builder window. 

Notice the field is added to the Conditions tab. The default operator is set to AND for 
Account.Accountmanagerid and END for Account.Seccodeid. Both conditions must be true 
for a record to be included in this group. 

22. Click OK again. 
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23. Click OK again to close the Subscription Rules window. 

24. Click Yes after reading the information in the Confirm dialog box. 

25. Click OK to close the User Profile for Hogan, Lee window. 

 

Exercise 6.2: Creating a remote user database 
In this exercise, you will create a server folder and a remote user database. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
How do I create Lee’s remote database now that I’ve configured user sync options? 

• Create a folder on the server in which to save remote databases. 
• Create the remote database for Lee. 

Exercise steps 
1. Create a new folder called RemoteDB on the C:\ drive of the training workstation. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/CreateARemoteUserDatabase.mp4
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When using the Create on SQL Host option, the folder must be on the Database 
Server and shared. The CREATOR OWNER must also be set to Modify 
Permissions at a minimum. In the training workstation, you’re using the Create on 
SQL Express Instance from SQL Host option so you need a valid folder location on 
the computer where SQL Express is installed. 

2. Open Infor CRM Administrator. 

3. Type admin in the Username field. No password is required. 

4. Select Tools > Create Remote User Databases from the menu bar. The Create Databases 
window opens. 

Only users created with the Remote User type are included in this list. 

5. Select Hogan, Lee from the list of Available Users and then click the right arrow to move Lee to 
the Select Users list. 

6. Click Options. The Create Database Options window opens. 

 
7. Select the Create on SQL Host radio button. 

8. Type Ma$t3rk3y in the SQL Express sysdba password field. 

Since you configured Database Options in a previous exercise the usernames and passwords for 
Host and Target Database are already populated. To review, they are: 

• Host Database Owner Login ID: sysdba 
• Host Database Owner Login Password: Ma$t3rk3y 
• Target Database Administrator Login ID: sa 
• Target Database Administrator Login Password: password 

9. Type C:\RemoteDB in the field within the Remote Path pane. 

Use the format drive letter:\shared_folder_path. Do not include the computer name. 

10. Select the Create DTS package and run it immediately (do not save it) option. 

11. Click OK. The Create Databases window opens. 

12. Click Now. 
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The status of the database creation indicates the progress. If there are any errors, double-check 
the Remote Path entered matches an existing folder and the passwords for the Host and Target 
Database are correct. 

13. Click OK after the database creation is complete.  

 
14. Click Cancel in the Create Databases window. 

15. Minimize the Infor CRM Administrator. 

• Open the C:\RemoteDB folder to view the files created: 
• SLX_lee_dat.dat (database) 
• SLX_lee_log.ldf (log file) 

You’re now ready to attach the database to the SQL Express instance on Lee’s workstation. 

How do remote users receive their remote database files? 
If a user’s computer is connected to the network, you can save the database file to a shared network 
folder and they can copy the file(s) to their local systems. If a user’s computer isn’t connected to the 
network, you can copy the database file(s) to the user’s computer using some form of removable media 
or send through email or another file hosting service. 

How do remote users attach their database files? 
The Attach Remote utility is used to attach and detach databases. If a database already exists on a 
remote/offline user’s computer, Attach Remote automatically detaches the existing database and 
attaches the new database when executing the *.sxd file. 

You may also use the Attach Remote utility on the Administrator workstation when resynchronizing or 
testing with a copy of a remote user or remote office database. 

Some notes to consider when using this utility:  

• It’s only possible to attach a remote database locally. However, you can detach a remote 
database across a network. 

• To attach a database, the remote database, Attach Remote, and the SQL Express instance must 
all be present on the local machine. 

• Attach Remote doesn’t accept a mapped drive or UNC path for the remote database. 
• The connection contains the following values: 

o The Database Name is set to SLXRemote. 
o The Server Name is set to the name of the Remote user’s computer. 
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o The User name is set to sa. 
o The sysdba password is set to Ma$t3rk3y. 

 When attaching the remote database, if the sysdba user does not exist, the user is 
created with a password set to Ma$t3rk3y. If the sysdba user already exists in the remote 
Microsoft SQL instance, then the sysdba user’s password remains unchanged. However, 
the database installation sets the sysdba password in the Connection Manager to 
Ma$t3rk3y. Therefore, if the sysdba password on the remote database is set to a value 
other than Ma$t3rk3y, the Remote user must open the Connection Manager and change 
the sysdba password to the value in their database. 

After creating the remote database, there is no sa password. You may need to adjust this setting in the 
Attach Remote utility. 

 

 

In addition to the password, if you must change other settings in the Attach Remote utility, 
run command “C:\Program Files\Saleslogix\AttachRemote.exe” 

How do users sign in to Infor CRM when remote? 
After installation, the user who installed Infor CRM must log on to the Client computer(s) for the first time 
and launch various applications. This process creates the necessary registry entries for each application 
and creates a connection to the Remote database. 

A user can sign in to the Infor CRM Windows Client using the new remote database data link (e.g. 
REMOTEDB). The user can still use the main database/main office data link (e.g. MAINDB) whenever 
(s)he is back in the office and sync as soon as a network connection is obtained and before disconnecting 
again. 

 

Exercise 6.3: Attaching a remote database 
In this exercise, you will attach a remote database and setup a remote data link. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
I’ve installed the Remote Client on Lee Hogan’s computer. How do I attach the remote 
database now so he can sign in and test synchronization? 

• Use the Attach Remote utility to attach the remote database. 
• Setup the remote data link and sign in to the Remote Client. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/AttachARemoteDatabase.mp4
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Exercise steps 

Part 1: Attach a remote database 

1. Open the C:\RemoteDB folder housing the remote database files for Lee Hogan. 

2. Double-click the SLX_lee_dat file. The Remote Database Setup window opens. 

3. The setup automatically detaches an existing remote database (if any) and attaches the new 
database. After this process completes, a pop-up message informs you that the database 
installed successfully. 

4. Click OK on the popup message. 

5. Click OK again (if required) on the Remote Database Setup window. 

 

Part 2: Setup a remote data link 

1. Select Start > All Programs > Saleslogix > Infor CRM Client. The Please log on window 
opens. 

2. Click the ellipsis in the Log on to field. The Data Link Manager window opens. 

3. Click Add.  

4. Select Saleslogix OLE DB Provider and then click Next. 

5. Select SRV10 from the Select or enter the Saleslogix Server drop-down list. 

6. Select SLXREMOTE from the Select Saleslogix database name drop-down list. 

7. Type admin in the Saleslogix User Name field. 

8. Click Test Connection. The Test connect window opens. 

9. Click OK. 

10. Click OK again. 

11. Click OK again to close the Connection Name window. 

12. Double-click SLXREMOTE from the Data Link Manager window. 

13. Type lee in the Username field. No password is required. 

14. Click OK. 
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The Infor CRM Remote Client (Windows) opens. Notice the What’s New option under the 
Sales Nav Bar, Synchronize in the toolbar, as well as the File > Subscribe and File > 
Synchronize menu items. We’ll explore the Remote Windows Client in a later lesson.  
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Check your understanding 
 

 
What are the options for user profile sync? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
Does a remote user need to connect to the host database before use? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Do History Records expire? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
How do users attach their database? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Lesson 7: System maintenance 
Estimated time 
2 hours 

Learning objectives 
After completing this lesson, you will be able to: 

• Discuss scenarios that might require a manual backup or restore of a database. 
• Summarize the available data maintenance tools and their purposes. 
• Identify where to find system upgrade documentation and installation files. 
• Explain how to create Windows and Web development environments. 

Topics 
• Data backup and recovery 
• Data maintenance tools 
• System upgrades 
• Customizations 
• User maintenance 
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Data backup and recovery 
Creating and executing a backup schedule is crucial for disaster recovery and preparedness. You or your 
Database Administrator (DBA) should automate a backup job for the Infor CRM database that runs on a 
regular schedule (Infor recommends daily). In addition to scheduled jobs, you should always create a 
database backup before applying an update, creating a development environment, installing a 
customization, or performing data maintenance so you can restore its previous state if anything goes 
wrong. 

Can I restore the Infor CRM database on another server? 
When restoring an Infor CRM SQL database backup from one server to another, you must synchronize 
the database’s sysdba user to the new SQL server’s sysdba user. This can be done using a SQL stored 
procedure. You can find this procedure in the \Database folder on the Infor CRM Installation DVD: 
sysdbafix_script.sql. It contains the following command to run against the Infor CRM database: 

sp_change_users_login 'Update_One', 'sysdba', 'sysdba' 

How can I tell when users are signed on? 
The physical connection to your Infor CRM database uses OLE DB Connection Pooling. Each client 
query uses one connection from a pool of connections available for use on the Infor CRM Server and 
then releases the connection when the query is complete. If a user is signed in to Infor CRM but (s)he is 
not retrieving information from the database, a connection to the database is not being consumed. 

Nevertheless, if you are planning system maintenance, it’s best to wait until all users are signed off before 
making changes. In the Users view of the Infor CRM Administrator, any users currently signed in to Infor 
CRM Windows or Web (not Mobile) are denoted with a green arrow next to their user record. 

 

Exercise 7.1: Backup and restore a database 
In this exercise, you will backup and restore a database under the same name. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
Before performing data maintenance on the Infor CRM database, how do I create a backup 
in case I need to restore? 

• Backup the saleslogix_eval database as an example. Use the defaults provided by 
Microsoft SQL Server 2012. 

• Restore the database under the same name. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/BackupAndRestoreADatabase.mp4
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Exercise steps 

Part 1: Backup a database 

1. Select Start > All Programs > Microsoft SQL Server 2012 > SQL Server Management 
Studio. The Connect to Server window opens. 

2. Select SRV10\SQLEXPRESS from the Server name drop-down list. 

3. Select Windows Authentication from the Authentication drop-down list. 

4. Click Connect. 

 
5. Expand SRV10\SQLEXPRESS > Databases from the Object Explorer. 

6. Right-click saleslogix_eval, point to Tasks, and then click Back Up. The Back Up Database – 
saleslogix_eval window opens. 

7. Click OK. A confirmation window opens. 

8. Click OK again. 

The saleslogix_eval.bak file is saved in the following default folder on the same server: 
C:\ProgramFiles\Microsoft SQL Server\MSSQL11.SALESLOGIX\MSSQL\Backup. 

Part 2: Restore a database under the same name 

Imagine you made some errant changes in the database and now want to restore it to its previous state. 
Restoring the database under the same name allows you to keep existing connections in the Infor CRM 
Connection Manager. Before restoring a database, you must ensure the target database (if it already 
exists) isn’t currently in use. 

1. Expand SRV10\SQLEXPRESS > Databases from the Object Explorer. 

2. Right-click saleslogix_eval and then click Delete. The Delete Object window opens. 

3. Clear the Delete backup and restore history information for databases check box. 

4. Select the Close existing connections check box. 

5. Click OK. 
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6. Right-click Databases from the Object Explorer and then click Restore Database. 

 
7. Select saleslogix_eval from the Database drop-down list. Note: This name must be the same as 

the one you deleted. 

8. Click Script on the General tab. 

9. Click Verify Backup Media. 

10. Close the Restore Database – saleslogix_eval window. Notice the restore script is written in the 
background. 

11. Click Execute to run the SQLQuery. 

 
12. Click Refresh within the Object Explorer to refresh the database. 

Part 3: Alternative method for restoring a database 

1. Right-click saleslogix_eval and then click Delete. The Delete Object window opens. 

2. Clear the Delete backup and restore history information for databases check box. 

3. Select the Close existing connections check box. 

4. Click OK. 

5. Right-click Databases from the Object Explorer and then click Restore Database. The Restore 
Database window opens. 
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6. Select the Device radio button and then click the ellipses. The Select backup devices window 
opens. 

7. Verify File is selected in the Backup media type drop-down list. 

8. Click Add. The Locate Database Files – SRV10\SQLEXPRESS window opens.  

9. Navigate to the C:\Program Files\Microsoft SQL Server\MSSQL 
11.SALESLOGIX\MSSQL\Backup directory (if you don’t begin here by default) and then select 
saleslogix_eval.bak. 

10. Click OK.  

 
11. Click OK again to close the Select backup devices window.  

12. Select the most recent backup set to restore and then click Verify Backup Media. 

 
13. Click Script once the media has been verified. 

14. Close the Restore Database – saleslogix_eval window. 

15. Click Execute. 
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16. Click Refresh in the Object Explorer once the query successfully executes. 

17. Close Microsoft SQL Server Management Studio. 
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Data maintenance tools 
Infor CRM includes several utilities to inspect your Infor CRM data and make bulk changes. Although you 
can write your own queries inside SQL Server Management Studio (or other Relational Database 
Management System) to act with data, the Infor CRM tools allow you to perform specific, commonly-used 
data maintenance tasks without having to sign in directly to your database server. 

What tool should I use to search and replace data? 
The Replace Data Wizard in the Infor CRM Windows Client (Tools > Maintenance > Replace Data) is an 
easy way to replace one or more values with another value in the ACCOUNT, CONTACT, or 
OPPORTUNITY tables. Locate the Replace Data Wizard by clicking Tools, clicking Maintenance, and 
then clicking Replace Data. Consider running this wizard if mass changes need to be made to data. For 
example, a new telephone area code is introduced and must be applied to all affected records. 

The Replace Data Wizard works within the context of the current account, contact, or opportunity group. 
Before running the wizard, it is best practice to select the group you want to work with from the group 
tabs, or create an ad hoc group using the Query Builder. If you want to find/replace data for records other 
than account, contact, or opportunity, use the Execute SQL tool in the Saleslogix Administrator (Tools > 
Execute SQL). 

What tool should I use to delete a group of records? 
The Purge Records Wizard in the Infor CRM Windows Client found by clicking Tools, clicking 
Maintenance, and then clicking Purge Data is an easy way to delete a group of records in the 
ACCOUNT, CONTACT, or OPPORTUNITY tables. Deleting one of these records also purges data in 
related tables for that record such as HISTORY. 

To purge data for records other than account, contact, or opportunity, use the Execute SQL tool in the 
Infor CRM Administrator by clicking Tools and then clicking Execute SQL. 

What tool should I use to find and resolve missing or invalid references? 
The Integrity Checker in the Infor CRM Administrator found by clicking Tools and then clicking Integrity 
Checker allows you to locate errors and correct records in your database. Integrity Checker uses libraries 
of tests looking for missing or invalid references in a variety of tables such as attachments with a bad file 
name/path or a ticket activity not tied to a parent ticket ID. 

What tool should I use to find and resolve duplicate records? 
A Check for Duplicates wizard is available from both the Windows and Web Clients. Although both tools 
allow you to check for and resolve duplicate records in the Infor CRM database, they have a few 
differences. 

Windows Client duplicate checker 
The Check for Duplicates Wizard in the Infor CRM Windows Client is an easy way to check for duplicate 
records in the ACCOUNT or CONTACT tables. Locate the Check for Duplicates Wizard by clicking Tools, 
clicking Maintenance, and then clicking Check for Duplicates. The Windows version of the duplicate 
checker offers the following benefits: 
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• Choose any field on the entity to use for comparison whereas the Web version allows you to 
choose from a limited number of fields. 

• Broaden or narrow matching criteria by including case sensitivity or comparing the first few letters 
of a field value—a number you can choose. 

Web Client duplicate checker 
If you have the Web Client running with SpeedSearch configured, you can alternatively use the duplicate 
checker by clicking Tools and then clicking Check for Duplicates to check for duplicate records in the 
ACCOUNT, CONTACT, and LEAD tables. 

• You can save the results of a duplicate checking job for processing later whereas the Windows 
version requires you to act on the results at the same time as the duplicate checking process. 

• You can use a custom rating system to label matching records. This rating may be useful if you 
have different people running the check and processing the jobs. 

• You can broaden or narrow matching criteria by including Stemming, Phonics, Synonyms, and a 
custom Fuzzy Matching level. 

• You can choose individual fields to keep from either the source or target record when performing 
a merge whereas the Windows version doesn’t allow you to choose at the field level. 

 

Exercise 7.2: Checking for duplicate records 
In this exercise, you will check for duplicate contacts and leads. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
It’s been a few weeks since my customers have entered Infor CRM data. How do I check for 
duplicate records to ensure data is kept clean? 

• Use the Windows Client to check for duplicate account records. 
• Restore the database under the same name. 

Exercise steps 

Part 1: Check for duplicate contacts 

1. Open the Infor CRM Windows Client. 

2. Type admin in the Username field. No password is required. 

3. Click OK. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/CheckForDuplicateRecords.mp4
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4. Select Tools > Maintenance > Check for Duplicates. The Check for Duplicates Wizard 
opens. 

5. Select the Accounts radio button and then click Next. The Select Search Options screen 
opens. 

6. Select the All records radio button and then click Next. The Select Group Options screen 
opens. 

7. Select the Entire Database radio button and then click Next. The Select Fields to Compare 
screen opens. 

8. Select the following fields: 

• Account.Type 
• Account.Account 

9. Click Next. The Field Comparison options dialog box opens. 

 

The Duplicate Checker looks for all selected fields using AND. The more fields you 
select, the more filtered the search. 

10. Double-click inside the ALL cell in the Characters column of the Account.Account row. Another 
Field Comparison Options window opens. 

11. Select the Compare the first radio button and set the value to 3. 

12. Click OK. The Field Comparison Options screen opens. 

13. Click Next. The Assign Default Behavior screen opens. 

14. Select Merge records into the FIRST record CREATED from the drop-down list and then click 
Finish. 

 

You can change the behavior per set of duplicate records later. Setting a default 
now prevents you from having to do a lot of manual intervention later. 

If no matching records are found, the Duplicate Checker closes. If one or more records match the 
criteria, they appear as a set in the Duplicate Record Confirmation window. The window shows 
one matching set at a time. Notice the two records found match the criteria specified: 

 
Duplicate Record Confirmation window 

• Account Type is equal (Customer) 
• The first three letter of the Account Name are equal to “Fir.” 

Evidently, the search criteria is a bit loose. These are two separate records so let’s skip this set.  

15. Click Skip. 

The next set of matching records appears in the window. This time you have three records which 
meet the criteria.  
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Duplicate Record Confirmation window 

For training purposes, let’s assume you know First Printing and First Processing are the same 
company. They’ve recently had a name change. Since both accounts were created on the same 
date, you should next check to see which record has the most history. Neither of these rules 
apply here because it’s evaluation data so leave the First Processing record as PRIMARY and 
the First Printing record set to MERGE. 

16. Right-click the Status cell of the First Radio record and then click Change Status. The Status 
window opens. 

17. Select IGNORE. 

18. Click OK. 

Infor CRM merges the selected record with the primary record. All notes, history and activities 
appear in the Primary record, however, other information such as address, phone numbers, type 
are deleted. Within the Duplicate Checker, the next set of matching records appears in the 
window. Because you used broad criteria for training purposes, you have various potential 
matches. 

19. Click Cancel to close the remaining sets. 

Part 2: Check for duplicate leads 

1. Open the Infor CRM Windows Client. 

2. Type admin in the Username field. No password is required. 

3. Click OK. 

4. Select Tools > Check for Duplicates. The Select a Source screen opens. 

5. Select Lead from the Select type of job drop-down list. 

6. Select All Leads from the Group drop-down list. 

7. Click Next. The Search Options screen opens. 

8. Click Advanced Match Options. The Match Options window opens. 

9. Set the value of the Fuzziness Level number to 1 to narrow the search criteria. 

10. Click OK to return to the Search Options screen.  

11. Clear the Email check box. 

12. Select the Industry check box. 

13. Click Next. The Review screen opens. 

14. Click Submit. The Process Request screen opens. 

15. Click the Job Number link. The Check for Duplicates History 0 –1-00-025862 screen opens.  



 

  Infor CRM: v8.4 Administering Training Workbook 137 
   

  © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

 
Wait for the job status to finish. When complete, there are two duplicates with a score of 100:  

 
16. Click Resolve next to Richard Bowersock. The Resolve Duplicate Record window opens.  

17. Scroll down to the Unresolved Duplicates pane and click Merge next to Bridget Bowersock. The 
Merge Records window opens. 

 
18. Choose the values you want to keep during the merge either from the Source or Target record. 

Since these records are different, there aren’t many shared values. Let’s keep all values from the 
Target. Click Merge. 

The selected records merge and the ALL LEADS view opens. 
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System upgrades 
Periodically, updates (previously known as hot fixes) and service packs are released to correct known 
issues or feature enhancements. 

Where do I find updates and service packs? 
Infor CRM partners can find updates and service pack downloads/documentation in the Infor CRM 
Partner Portal: https://www.inforxtreme.com. Customers can also find downloads appropriate to their 
product from the Infor CRM Customer Portal https://www.inforxtreme.com. If you have signed up for alerts 
from within the portal, you receive notifications of new updates via email. 

What steps are involved in an upgrade? 
Always follow the steps in the upgrade documentation before performing a system update. Each upgrade 
may have specific steps included in the Upgrade Workplan. Generally, most upgrades use the following 
process: 

• Confirm all Infor CRM users are signed off. 
• Confirm the Sync server won’t run while installing. 
• Backup your Infor CRM database. 
• Backup any customizations made. 
• Upgrade administrative tools and servers. 
• Upgrade client applications. 
• Install the service pack bundles (.sxb) in the Administrator. 
• Upgrade the Web Host 
• Restore the project backup (.zip) in the Application Architect. 
• Rebuild the web platform. 
• Deploy Core Portals. 
• Test the upgrade. 
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Customizations 
The Infor CRM Clients (Windows, Web, and Mobile) are fully customizable. Although training for 
customizations is outside the scope of this course, you’ll review which tools are available and how to 
create a development or test environment. Visit http://www.infor.com/services/education/ to learn about 
more training opportunities for Infor CRM Developer courses. 

Windows customizations 
Your resident developer or Infor CRM Business Partner can use the Infor CRM Architect to customize the 
Infor CRM Windows Client. All the pieces making up the Infor CRM Windows Client interface such as 
forms, main views, toolbars, menus, scripts, and more are referred to as plugins. The Architect allows you 
to modify existing plugins or create your own. You can also create custom tables, fields, joins, lookups, 
and pick lists. 

The Architect includes a code editor that supports VBScript. For advanced customizations, you can use 
the Infor CRM .NET Extensions Manager to import custom DLLs or EXEs created outside the Architect 
tool such as those created in Visual Studio. 

Any of these customized and tested items in a development environment must be packaged inside of a 
bundle (sxb) file. After backing up the production database again, you can then install the bundle in the 
production environment using the Infor CRM Administrator. During the bundle installation process, you 
can also choose the users and teams to release plugins to should you want to limit the customizations to 
a specific group of users. 

Web customizations 
Your resident developer or Infor CRM Business Partner can use the Infor CRM Application Architect to 
make customizations to the Infor CRM Web Client. All pages (aspx) making up the Infor CRM Web Client 
interface such as Account Detail or Insert Opportunity are grouped within the Infor CRM portal. The portal 
determines the look and feel (template) and the navigation (menus and nav bars) for the website. Pages 
serve as containers for smart parts (ascx) including the controls (text boxes, lookups, buttons, and more) 
with which users interact. Each control has a set of properties defining which property it’s linked to in the 
database as well as any actions or behaviors it has through business rules, events, and more. The 
Application Architect allows you to modify existing interface elements or create your own. You can also 
create custom entities, properties, relationships, and action items. 

The Application Architect includes a code editor supporting C#.NET. For advanced customizations, you 
can import external assemblies or VB.NET code snippets created outside the Application Architect tool 
such as those created in Visual Studio. 

Any of these customized and tested items in a development environment must be packaged inside of a 
web bundle (zip) file. After backing up the production database again, you can then install the web bundle 
in the production environment and redeploy the website using the Application Architect. To release the 
customizations to a specific group of users, you must assign the items to a secured action, assign the 
secured action to a role, and assign specific users to that role. 

Mobile customizations 
Your resident developer or Infor CRM Business Partner can use Notepad++ or other 
JavaScript/CSS/HTML Editor such as WebStorm to make customizations to the Infor CRM Mobile Client. 
In addition to an editor and a working Infor CRM Web environment with SData configured, a mobile 
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development environment also requires a copy of the Infor CRM mobile deployment files and the argos-
sdk and argos-saleslogix frameworks. 

After backing up the production database again you can add the customized files in the production 
environment as support files in the SlxMobile portal using the Application Architect. 
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User maintenance 
Over time, personnel and user needs may change. Infor CRM supports a variety of scenarios when user 
circumstances change. 

What happens when a user leaves and no longer requires Infor CRM? 
When a user leaves your company, it’s recommended to convert his or her user profile to a retired user 
rather than delete it. Retired users don’t use a license and cannot sign in but their name is preserved in 
the database. This prevents history records from displaying “Unknown User.” Instead, choose to 
inactivate a user by clearing the Login Active check box which also preserves history and prevents the 
user from signing in to Infor CRM but still consumes a license. 
 

Variable Deleted Inactivated Retired 

Can sign in to the database    

Consumes a license  X  

History records removed reference to the user X   

 

If you are retiring a user who owns accounts, it’s recommended to reassign territories and activities. 
Additionally, ensure the user doesn’t have a Team Owner security profile, reports only to the 
Administrator, and isn’t a manager with direct reports. 

 

Exercise 7.3: Realigning activities and changing a user’s type 
In this exercise, you will realign activities and change a user’s type. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
Ed Martinez is taking a short leave of absence. While he is gone, Dan Barret is managing 
Ed’s activities. How do I adjust these settings? 

• Change the user’s user type to Retired during the leave. 
• Change the user’s user type back to Network when he returns. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/RealignActivitiesAndChangeAUsersType.mp4
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Exercise steps 

Part 1: Realign activities 

1. Open Infor CRM Administrator. 

2. Type admin in the Username field. No password is required.  

3. Click OK. 

4. Select Tools > Realign Activities in the menu bar. The Activity Realignment window opens. 

5. Search and select Ed Martinez in the Source User field. 

6. Search and select Dan Barret in the Target User field. 

7. Click Realign. A confirmation message appears. 

 
8. Click Yes. 

Infor CRM sets Dan as the owner of Ed’s scheduled activities. When Dan signs in to Infor CRM, 
he sees the new activities on his calendar. 

Part 2: Change a user’s type 

1. Select the Administration Nav Bar > Users. 

2. Click the All Users tab and locate Ed Martinez. 

3. Right-click and then select Change User Type. The Change User Type window opens. 

4. Select Retired User from the drop-down list. 

5. Click OK. 
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Notice how a license isn’t required for a retired user type. When Ed Martinez returns, you can 
change his user type back to Network User. Any new activities scheduled by Ed after the activity 
realignment are no longer assigned to Dan. 
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Check your understanding 
 

 
When would you want to realign a user’s activities? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
Can you restore a backed-up database to a different server? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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What is the difference between Retiring and Deleting a User? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
Why should you regularly check for duplicate records? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Lesson 8: Integrations and 
enhancements 
Estimated time 
1 hour 

Learning objectives 
In this lesson, you will: 

• Discuss the different integration options Infor CRM has: Ming.LE, ION, BOE. 
• Discuss the enhancements available for outlook 
• Discuss Web Integrations Nav Bar. 
• Discuss Administrator integrations. 

Topics 
• About integrations and enhancements 
• Different integrations for Infor CRM 
• Web Client integrations Nav Bar 
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About integrations and enhancements 
Within Infor CRM there are many integrations and enhancements that can be added to a standard 
installation. These include business intelligence software, enhancements to emails programs, and 
integrations to certain ERP systems. 

To learn more about these products, including how to administer, install, please contact your business 
partner or sales representative. 
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Different integrations for Infor CRM 

Intelligent Open Network (ION) 
Infor’s Intelligent Open Network, or ION, allows for the easy integration of both Infor and third-party 
software applications. ION is Infor’s advanced middleware platform. Providing the flexibility needed to 
make a complex set of enterprise systems work together for long-term sustainability and optimize ROI. 

Advanced Analytics 
Advanced Analytics is a powerful yet easy to learn and use interactive business intelligence solution that 
allows you to increase organizational and customer intelligence. This enhancement provides the tools so 
that users at every level can monitor productivity, analyze trends, and identify issues that enable them to 
focus attention and resources on the most profitable business activities. 

Back Office Extension (BOE) 
Back Office Extension is a product that allows your Infor CRM application to integrate with your ERP 
system. By integrating Infor CRM to your ERP solution; including detailed customer information, invoices, 
orders, and more, you can streamline your systems. Using this can allow you to be more responsive to 
your customer needs, to help your sales people close more deals, and service more customers.  

When enabled the Back Office Extension feature users the Infor ION framework to manage the flow of 
real-time data between Infor CRM and ERP software. 

Ming.LE 
Infor Ming.le is a comprehensive platform for social collaboration, business process improvement, and 
contextual analytics. Infor Ming.le is fully embedded with organizational systems such as ERP, financials, 
and Infor CRM. 

Desktop enhancements 

Xbar  
Infor CRM’s Xbar for Microsoft® Outlook® is an add-in to Infor CRM that seamlessly embeds the 
functionality of Infor CRM into Microsoft® Outlook® 2010 and newer versions. Xbar docks a window 
seamlessly into Outlook that allows for a context-aware, intuitive addition to the Outlook interface. 

With Xbar you can easily access Infor CRM information from within Microsoft® Outlook®, or have data 
seamlessly load based on contacts within Outlook. Create Infor CRM Contacts from Outlook Contacts, as 
well as new accounts and opportunities. You can sync Outlook with Infor CRM to add new calendar 
events and activities to Infor CRM as well. 
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Web Client integrations Nav Bar 
This navigation bar gives you access to different integrations you have installed on your Infor CRM 
system. 

SData Sync Configuration 
Sdata provides a simple protocol for reading data from and writing to Business Applications. The Sdata 
integration is used for everything from the Infor CRM Mobile Client, Desktop Integration, and Xbar. Sdata 
is deployed on your Infor CRM Webserver. 

The Sdata Sync Configuration toolbar is used to feed synchronization information to Infor CRM. This can 
be used to create integrations with different extensions such as Infor CPQ, Sync with Google, Outlook 
Sync, and Back Office Extensions. 

Integrations 
The Integrations List view displays all the integrations that you have access to. This list includes all the 
integrations released by Infor CRM as well as any custom integrations. You can use groups and lookups 
to narrow the list of records that display. 

ERP Persons 
This will be available if you have Back Office Extensions installed on your Infor CRM installation. This 
view allows access to a user within the back office integration and can be used to assign data ownership. 

Outbound Trans 
Outbound transaction is another component of Infor CRM’s Back Office Extensions. The list view will 
detail all the outbound transactions that the logged-on user has access to. This view can also show newly 
promoted or updated Infor CRM records that are waiting to be processed by the outbound JobService. 
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Lesson 9: Web security 
Estimated time 
1 hour 

Learning objectives 
In this lesson, you will: 

• Describe how Infor CRM handles security. 
• Discuss creating and using Roles. 
• Discuss creating and using Secured Actions. 
• Describe the Security Manager. 

Topics 
• Web security 
• About roles 
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Web security 

About secured actions 
A role determines what functionality a user can access in the Web Client. Roles use secured actions to 
control access to user interface elements such as pages, menus, menu items, toolbars, and buttons. 
When you control access to individual user interface elements, you can control access to actions such as 
editing, deleting, or printing. Current secured elements are all user interface elements giving access to 
accounts, contacts, and opportunities. 

You secure a user interface element by assigning a secured action to its Applied Secured property in the 
Application Architect. Once a secured action is applied to a user interface element, only users who are 
assigned a role that includes the secured action can see and use the element. For example, 
Entities/Account/Save is the secured action assigned to the Applied Security property for the Save button 
action on the Account Detail view. When the button loads at runtime, the display value changes 
depending on whether the user has permission to perform the action. 

A user interface element in the Web Client that is secured restricts access from all users until a role is 
assigned which gives access to the user. To secure elements in the Web Client using roles you must add 
secured actions to elements, add the secured action to a role, and assign users to the role. 

Elements are secured in the Application Architect by assigning a secured action to them, or applying 
security. The value of the Applied Security property is the secured action name. To secure an element in 
the UI and allow users access to that element you must: 

 Determine which secured action you want to use to secure the element. If necessary, you can 
create a new secured action in the Web Client. 

 Add a secured action to the Applied Security property for the element in the Application Architect. 
See the "Understanding Secured Actions" topic in the Application Architect Help for more 
information. 

 Add the secured action for that element to a role in the Web Client. 

 Assign users to the role. 

 

Exercise 9.1: Creating secured actions and assigning them to a user 
interface item 
In this exercise, you will create new Secured Actions from the Web Client, and the 
Application Architect application. A Sales_Script secured action will be created to secure a 
button on the Account Details form. Also, a Navigation/Marketing action will be created to 
secure the Marketing Nav Bar. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/CreateSecuredActionsAndAssignThemToAUserInterfaceItem.mp4
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Exercise steps 

Part 1: Create a new secured action in the Web Client 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Expand the Administration Nav Bar. 

5. Right-click the Secured Actions link. 

6. Click New Secured Action. 

7. Type Sales Script in the Name field.  

8. Type Run a Sales Script Button in the Description field. 

9. Click Save. 

10. Minimize the Sage SalesLogix Web Client browser window. 

 

The following steps are examples to show how you could modify a user interface 
item to use a secured action in the evaluation database. You should always consult 
your Infor CRM Web Developer before modifying anything in a production 
environment. 

Part 2: Assign a secured action to an interface item 

1. Open Application Architect by selecting Start > All Programs >Saleslogix > Application 
Architect. 

2. Open Project Explorer by selecting View > Project Explorer. 

3. Expand VFS on INFORCRM EVAL > Entity Model > Packages > SalesLogix Application 
Entities > Account > Forms. 

4. Double-click the AccountDetails form to open it in the workspace.  

5. Right-click on the form and then select Rows > Add Row. 

6. Right-click the left cell in the new row. 

7. Select Insert > Button > Button. 

8. Select View > Properties. The Properties window opens. 

9. Click the new button to show its properties in the Properties window.  

10. Type Sales Script in the Caption property. 

11. Expand the On Click Action property. 

12. Select Sales Script from the drop-down list in the Applied Security property. 

13. Click the ellipses within the Action Name property. The Action Item Designer dialog box opens. 

14. Select the Show Message action. 

15. Type Phoenix Computers was founded in 1987 in the Text field. 
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16. Type Company History into the Title field. 

17. Click OK in the Action Item Designer window. 

18. Click Save. 

Part 3: Create a Secured Action from Application Architect 

1. Expand VFS on INFORCRM EVAL > Portal Manager > SlxClient > Navigation. 

2. Double-click Marketing to open it. 

3. Select <Add New Action> from the Applied Security field. The Add Secured Action dialog box 
opens. 

4. Type Navigation/Marketing in the Secured Action Name field. 

5. Type Access Marketing Nav Bar in the Description field. 

6. Click OK. 

7. Click Save All. 

Part 4: Rebuild the Web Client 

1. Click Run on the Application Architect toolbar. 

2. Close Application Architect when the deployment is complete. 

At this point, you haven’t used the secured action yet because this feature is currently available to 
all Infor CRM Web Client users. Now you need to assign the action to a role, and then assign new 
sales representatives to that role. 
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About roles 
Permissions to features and functionality in the Web Client are determined by roles. You can create any 
number of roles and assign them to any number of users. A user can have one or more roles assigned to 
them. You cannot assign a role to a department or team. 

Default roles 
By default, new users created in the Administrator application are not assigned any role. Users created in 
the Web Client are given the Standard User role by default. This allows access to most non-administrative 
functions in the Web Client, such as access to Leads, Accounts, Contacts, and Opportunities. 

If you remove a user from this role, the user will not have access to any items that have been secured 
unless you assign them a new role.  

The default roles include: 

• Administrator: Allows add, edit, and delete permissions to administration functions such as 
users, teams, departments, pick lists, products, and packages. 

• Standard User: Allows add, edit, and delete permissions to all Web Client non- administrative 
entities such as accounts, contacts, opportunities, tickets, defects, and so on. 

• Account Management: Allows add, edit, and delete permissions to accounts. 
• Contact Management: Allows add, edit, and delete permissions to contacts. 
• Opportunity Management: Allows add, edit, and delete permissions to opportunities. 

 

 

Roles work differently in the Web Client than they do in the Windows Client. Security in 
the Windows Client is defined using feature security, function security, and administrative 
roles, whereas Web security combines all Network elements into one security model - a 
role. You cannot use the Network security model for Web users or the Web security model 
for Network users. 

 

Exercise 9.2: Managing roles 
In this exercise, you will add a new role for service/support users and assign a user to the 
Administrator role. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ManageRoles.mp4
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Exercise steps 

Part 1: Add a user to a role 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Select the Administration Nav Bar > Roles. 

5. Click Administrator. This opens the detail view for the Administrator role. 

6. Click the Users tab. 

7. Click Add Users. 

8. Type Lee in the Search field. 

9. Click Search. 

10. Select Lee Hogan. 

11. Click Add Selected. 

12. Click Close. 

Part 2: Add a new role 

1. Right-click Roles from the Administrative Nav Bar to open the context menu. 

2. Click New Role. The Insert Role screen opens. 

3. Type Sales Script in the Name field. 

4. Type Allow access to Sales Script button and Marketing Nav Bar in the Description text box. 

5. Click Save. 

6. Click the Users tab. 

7. Click Add Users. 

8. Select Anne Avery, Adam Garfield, and Ella Hall by holding down Ctrl while clicking on each. 

9. Click Add Selected. 

10. Click Close. 

11. Click the Actions tab. 

12. Click Add Action. The Lookup Action dialog box opens. 

13. Select Navigation/Marketing and Sales Script by holding down Ctrl while clicking on each. 

14. Click Add Selected. 

15. Click Close. 

16. Click Save. 

Part 3: Remove a user 

1. Click List View from the toolbar. 

2. Click the All Roles tab. 
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3. Click Standard User from the Roles list view to open its detail view. 

Note: Anne Avery and Ella Hall are already in this role as they were created within the Infor CRM 
Web Client. 

4. Select Ella Hall. 

5. Click Remove from the toolbar. An Infor CRM dialog box opens confirming the deletion request. 

6. Click Yes. 

 

Exercise 9.3: Exploring roles and secured actions 
In this exercise, you will you will log on as Ella Hall, Anne Avery, and Lee Hogan to explore 
the different features available to them based on the Secured Actions and Roles they have 
access to. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Explore a user with no Standard User access 

1. Open the Infor CRM Web Client. 

2. Type Ella in the Username field. No password is required.  

3. Click Sign In. 

4. Expand the Sales Nav Bar. 

You will see that the Leads, Contacts, Accounts, and Opportunities are not available because Ella 
Hall’s user does not have access to the Standard User Role. 

5. Expand the Marketing Nav Bar. 

Notice Ella Hall has access to the Marketing Nav Bar as she now has access to the new Sales 
Script Role. 

6. Expand the Administration Nav Bar. 

Because the Administration Nav Bar does not have any secured action to secure it, Ella can 
access the navigation bar. However, because Ella does not have access to any of the items 
because no Role Ella is a part of has Secured Actions for these pages associated with her. 

7. Click Sign Off.  

8. Click Return to Sign In Page. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ExploreRolesAndSecuredActions.mp4
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Part 2: Explore a user with the Standard User role 

1. Type Anne in the Username field.  

2. Type Anne1 in the Password field. 

3. Click Sign In. 

4. Expand the Sales Nav Bar. 

Notice Leads, Contacts, Accounts, and Opportunities are now available because Anne Avery’s 
user does have access to the Standard User role. 

5. Click Charter Software to open the account detail view. 

6. Click Sales Script. A message opens. 

Because Anne has access to the Sales Script role, she can access and use the Sales Script 
button in the account detail view. 

7. Expand the Marketing Nav Bar. 

You can see Anne has access to the Marketing Nav Bar as Ella does have access to the new 
Sales Script role. 

8. Expand the Administration Nav Bar. 

Because the Administration Nav Bar does not have any secured action that secures it, Anne can 
access the navigation bar. Anne also has access to a few administrative items that come with the 
Standard User role. 

9. Click Sign Off from the status bar. 

10. Click Return to Sign In Page. 

Part 3: Explore a user with the Administrator Role 

1. Type Lee in the Username field. No password is required.  

2. Click Sign In. 

3. Expand the Sales Nav Bar. 

Notice Leads, Contacts, Accounts, and Opportunities are now available because Lee Hogan’s 
user does have access to the Standard User role. 

4. Click on Charter Software to open the account detail view. 

5. Look for the Sales Script button. 

Because Lee was not granted access to the Sales Script role, which is the only role with the 
Sales Script Secured Action. This means Lee is not permitted to see or use the new Sales Script 
button you created. 

6. Look for the Marketing Nav Bar. 

The Marketing Nav Bar is not on the Navigation Pane for Lee Hogan. This is because we did not 
grant Lee access to the Sales Script role we created. This is the only role with the 
Navigation\Marketing secured action that controls access to the Marketing Nav Bar. 

7. Expand the Administration Nav Bar. 
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Lee Hogan has access to the Administrator role; he has many options available to him. However, 
because he does not have access to all the Administrative functions and he is not the admin user, 
Lee is restricted from using some of the features found here. 

8. Click Sign Off from the status bar.  
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Check your understanding 
 

 
What is the difference between a role and secured actions? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What is the importance of the Standard Role? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Can roles be assigned to users, teams, or departments? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Lesson 10: Personalize the Infor CRM 
Web Client 
Estimated time 
2 hours 

Learning objectives 
In this lesson, you will: 

• Use the Admin Nav Bar features for “Personalization” of the Infor CRM Web Client. 

Topics 
• About personalization 
• Personalize resources 
• Personalize selections 
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About personalization 
The Infor CRM Web Client can be personalized for your company making specific resources available, 
such as literature or resources, and by customizing available selections in items such as pick lists and 
lead sources. 

Specifying personalization’s doesn’t require a redeployment of the Infor CRM Web Client or a rebuild of 
the files which make up the web client. These personalization’s can be used to help transition a new 
employee to using the Infor CRM Web Client, to ensure your company’s terminology is consistent 
throughout the product, or various other reasons. 
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Personalize resources 

Literature items 
Literature items refer to company brochures, product information sheets, or other marketing collateral 
made available to customers. Users select from the list of literature items when they submit a Literature 
Request (a type of activity). 

You can track the following information about literature items 

• Item number 
• Name 
• Author 
• On hand (quantity in inventory) 
• Reorder quantity (minimum quantity that indicates it’s time to restock) 
• File (type a file path to the document) 
• Expires (date to expire the item) 

Resources 
You can add a resource, such as a conference room to the list of available resources that appears when 
other Infor CRM users schedule an activity. This allows users to know what items they have available to 
them when scheduling meetings with other employees, leads, or contacts. 

 

Exercise 10.1: Creating literature items and resources 
In this exercise, you will create new literature items and resources for use with accounts, 
contacts, and activities. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Add new literature items 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Expand the Administration Nav Bar. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/LiteratureItemsandResources.mp4


 

164  Lesson 10: Personalize the Infor CRM Web Client 
  

 © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

5. Right-click Literature Items and then click New Literature Item. The Insert Literature Item 
window opens. 

6. Enter the following information: 

• Item Number: WP-Web83 
• Name: White Paper - Infor CRM Web Client 8.4 
• Author: James Dobbey 
• Family: Services 
• Cost: $5.00 
• On Hand: 100 
• Reorder Qty: 25 

7. Click Save. 

Part 2: Delete literature items 

1. Click the List View icon. 

2. Click the All Literature Items group. 

3. Click the Lenovo ThinkPad Brochure link. 

4. Click Delete. 

5. Click OK. 

Part 3: Edit literature items 

1. Click the All Literature Items group if not already there. 

2. Click the PHCPC Mouse Pads link. 

3. Enter 100 in the On Hand field. 

4. Click Save. 

Part 4: Create new resource 

1. Select Administration > New Resource from the menu bar. 

2. Enter the following information: 

• Name: Sales-WebExNE 
• Type: WebEx Account 
• Coordinator: Anne Avery 
• Location/Description: User: PhxComWebEx-NE Pass: PhxComputers1 

3. Click Save. 

Part 5: Edit an existing resource 

1. Click the List View icon. 

2. Click the All Resources group. 

3. Click the Conference Room 100 link. 

4. Select the Is Location field so it’s enabled. 

5. Click Save. 
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Part 6: Delete an existing resource 

1. Click the Next Record icon on the toolbar to open the Conference Room 200 resource detail 
view. 

2. Click Delete. 

3. Click OK.  

 

Infor CRM users who do not have access to the Administration menu are not able to 
see the coordinator’s information when they schedule the resource. 

Products 
Products refer to the goods and/or services your company sells. Users select from the list of products 
from the Insert Opportunity view, the Insert Sales Order view, or from the Insert New Asset view 
located within the account detail view. 

You can track the following information about products: 

• Name 
• Description 
• SKU 
• Family 
• Status 
• Cost 
• Price level 
• Package 
• Attachment 

 

 

To help organize products, you should consider first modifying the Product Family pick list. 
For example, a technology company may have the following product families: Hardware, 
Software, Warranty, Service, and so on. 

Packages 
Packages represent a method for grouping a set of products for ease of bulk pricing and order entry. For 
example, you may want to bundle three products into one package and sell the package as a set. If a 
customer purchases a package, all products within the package are listed individually as assets under the 
customer’s account detail view. Users select from the list of products from the Insert Opportunity view or 
the Insert Sales Order view. 

You can track the following information about packages: 

• Name 
• Description 
• SKU 
• Products 

 



 

166  Lesson 10: Personalize the Infor CRM Web Client 
  

 © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

Exercise 10.2: Products and packages 
In this exercise, you will personalize the Infor CRM Web Client by inserting, and 
discontinuing products, as well as creating new packages that can be used within sales 
orders, opportunities and other areas within Infor CRM. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Insert a product 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Expand the Administration Nav Bar. 

5. Select Administration > New Product from the menu bar. 

6. Enter the following information: 

• Name: Windows 10 Upgrade Services 
• Description: Consulting Services for Windows 10 
• SKU: Win10-Upg 
• Status: Available 
• Family: Service 
• Type: Download 
• Cost: $250 

7. Click Save. 

8. Click the Price Levels tab from the tab pane. 

9. Click Add Price. This opens the Add Product Price dialog box. 

10. Enter the following information: 

• Description: Presidential 
• Price: 125 

11. Click OK. 

Part 2: Discontinue a product 

1. Click List View. 

2. Click the All Products group. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ProductsAndPackages.mp4
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3. Click the Fujitsu Lifebook TabletPC link. 

4. Select Discontinued from the Status drop-down list. 

5. Click Save.  

Part 3: Insert a new package 

1. Right-click Package and then select New Package. The Insert Package window opens. 

2. Enter the following information:  

• Name: Windows 10 Upgrade 
• Description: Windows 10 Upgrade 
• Status: Available 

3. Click Save. 

4. Click Associate Product from the Products tab toolbar. 

5. Select Consulting Services, Windows 10 Upgrade Service, and Wireless Optical Mouse. 

6. Click Add Selected. 

7. Click Close. 

8. Click Save from the Products tab toolbar. 
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Personalize selections 

Competitors 
Competitors refer to another business that may sell similar products or services that competes with your 
company for a sale. Users select from the list of competitors from the Opportunity detail view. 

You can track the following information about competitors: 

• Name 
• Account 
• Contact 
• Phone 
• Web address 
• Rating 
• Weaknesses 
• Strengths 
• Strategy 
• Notes 

 

Exercise 10.3: Adding a competitor 
In this exercise, you will add and edit competitor information for use in opportunities. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Insert a competitor 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Expand the Administration Nav Bar. 

5. Select Administration > New Competitor from the menu bar. 

6. Enter the following information: 

• Competitor: Abbott Ltd. 
• Account: Abbott Ltd. 
• Contact: John Abbott 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/AddACompetitor.mp4
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• Rating: 25 

7. Click Save. 

Part 2: Edit a competitor 

1. Click List View. 

2. Click the All Competitors group. 

3. Click Paradigm Systems to open their detail view. 

4. Type 50 in the Ratings field. 

5. Click Save. 

Lead sources 
Lead sources represent a method for keeping track of how your company obtained a business lead. 
Users select from the list of lead sources when adding or importing leads. 

You can track the following information about lead sources: 

• Description 
• Abbreviated description 
• Type 
• Status 
• Cost 
• Date 

About qualifications 
Qualifications are a collection of qualification items used to validate lead information or determine when a 
lead is ready to become a sales opportunity. 

 

Exercise 10.4: Adding lead sources and qualifications 
In this exercise, you will insert and edit Lead Sources and Qualifications. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Create a new lead source 

1. Open the Infor CRM Web Client. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/AddALeadSourceAndQualifications.mp4
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2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Expand the Administration Nav Bar. 

5. Right-click Lead Sources and then select New Lead Source. The Insert Lead Source window 
opens. 

6. Enter the following information: 

• Description: Social Media – Twitter 
• Abbrev. Desc: Twitter 
• Type: Web 
• Status: Active 
• Cost: $0.00 
• Date: <Today> 

7. Click Save. 

8. Right-click Lead Sources and then select New Lead Source. The Insert Lead Source window 
opens. 

9. Enter the following information: 

• Description: Social Media – Facebook 
• Abbrev. Desc: Facebook 
• Type: Web 
• Status: Active 
• Cost: $0.00 
• Date: <Today> 

10. Click Save. 

Part 2: Edit a lead source 

1. Click List View. 

2. Click the All Lead Sources group. 

3. Open the Telemarketing – General lead source. 

4. Change the Status field to Inactive. 

5. Click Save. 

The more information you track about a lead source, the more options you have for querying that 
information. For example, by entering a cost, you can run custom queries on future events to measure the 
success of an event by comparing the number of leads generated against a dollar amount spent. 

Part 3: Insert a qualification 

1. Right-click Qualification and then select New Qualification. The Insert Qualification window 
opens. 

2. Type Social Media Direct Contact in the Qualification For field. 

3. Click Save. 

4. Click Add Qualification Item from the Items tab. 

5. Enter the following information 



 

  Infor CRM: v8.4 Administering Training Workbook 171 
   

  © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

• Visible: Selected 
• Sort Position: 1 
• Description: Facebook 

6. Click OK. 

7. Click Add Qualification Item from the Items tab. 

8. Enter the following information 

• Visible: Selected 
• Sort Position: 2 
• Description: Twitter 

9. Click Save. 

Pick lists 
A pick list is a list of values that you can select from when entering data in an Infor CRM field. For 
example, in a contact Title field, the user can select from a list of titles rather than typing in a value. Pick 
lists are useful because they eliminate keystrokes and encourage correct, consistent data entry—that way 
you don’t have one value for President and another value for Pres. When pick lists are synchronized, they 
provide consistent information across databases. 

Almost any pick list you see in the Infor CRM Web site can be changed. The Pick Lists list view shows 
over 165 default pick lists in the product, you may see more depending on whether your Infor CRM 
implementation has any customizations. 

Pick list options 
For each pick list, you can set different options or rules for how end users can interact with the items. 
 

Option Description 

Required entry Requires users to enter a value before they can continue to the next field. 

Allow multiple 
selections 

Allows users to select more than one item from a pick list. 

Text must match a 
li t it  

Ensures that the value entered matches a pick list item. 

Sorted alphabetically Displays pick list items alphabetically. If this option is selected, the Order values 
are ignored. 

Users can edit items 
(Windows version 

l ) 

Allows users to add or change pick list items. 

Apply options to Web 
pick list 

Select this check box to use the options selected on this view for Web pick lists. 
By default, the options automatically control pick lists in the Sage SalesLogix 
Client. If this option is cleared, the Web pick list is controlled by the attributes set 
on the control in the Application Architect. 
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Exercise 10.5: Modifying and adding pick lists 
In this exercise, you will modify pick list options and items and add a new pick list. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Modify pick list options and items 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Select the Administration Nav Bar > Pick Lists. 

5. Click the Account Type from the Pick Lists list view. 

6. Click Add Item from the Items tab toolbar. 

7. Type Presidential in the Text field. 

8. Type Presidential in the Code field. 

9. Type 9 in the Order field. 

10. Click OK. 

11. Click Save. 

Testing the pick list now shows us that the Other option shows up before the new Presidential 
option. Let’s fix this by changing the order value for Other. 

12. Click Edit in the row for the Other value. 

13. Type 99 in the Order field. 

14. Click OK. 

15. Type Presidential in the Text field. 

16. Click Save. 

Testing the pick list now shows Other properly falling as the final option in the Pick List. 

Part 2: Add a pick list  

1. Click Add Pick List from the Common Tasks pane. 

2. Type Priority in the Pick List Name field. 

3. Click OK. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ModifyAndAddPickLists.mp4
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4. Click Add New Item. 

5. Type Low into the Text field. 

6. Type Low into the Code field. 

7. Click Save and New. 

8. Type Medium into the Text field. 

9. Type Medium into the Code field. 

10. Click Save and New. 

11. Type High into the Text field. 

12. Type High into the Code field. 

13. Click Save and New. 

14. Type Urgent into the Text field. 

15. Type Urgent into the Code field. 

16. Click OK. 

17. Click Save. 

 

New pick lists need to be assigned to controls from the Application Architect 
application. This application is used to create advanced customizations within the 
web client such as new entities and forms. If you need to use this application, it is 
suggested you consult business partners or a certified Infor CRM Developer within 
your company. 

Groups 
The tabs at the top of every main view represent groups. These represent records meeting one or more 
criteria. Groups can be ad hoc, or built with the Query Builder. 

The following two groups are always available: 

Lookup Results: This group always appears as the first tab. It contains a temporary set of records from 
your last lookup and is overwritten each time you perform a new lookup; it keeps your most recent search 
results easily accessible. 

All [Main View entity]: This group generally appears as the second tab because it starts with “A,” 
however, tabs are sorted alphabetically so other tabs may become before it. The All group shows all 
records for the selected view that the current user has permission to access. There are no “where” 
conditions applied to it. 

Groups with conditions 
Groups with conditions show records meeting one or more criteria. Create this type of group when saving 
results from a lookup or when creating a new group using Query Builder. For example, right-click the 
Latest Leads group and click Edit to launch the Query Builder. The Conditions tab says to show records 
where the Modify Date is within the last 30 days. 
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Conditions tab 

Groups with conditions are dynamic. If you edit a record so it no longer fits the group criteria it no longer 
appears in that group. For example, create a lookup to search for active accounts that purchased your 
product during the past year. Save this lookup as a group. As active accounts purchase a product they 
are automatically added to the group and remain there the next 365 days unless they purchase an 
additional product. 

Groups without conditions 
Groups not based on a condition are called ad hoc. These groups contain records that are manually 
added. For example, you can create an ad hoc group of contacts with whom you play golf by adding 
those contacts from memory rather than a field in the database. 

If you create some group other Infor CRM users find useful, you can share the group with specific users, 
departments, or teams. After sharing the group, users whom you shared it with can see the group the 
next time they sign in to Infor CRM or refresh their view. 

You can only share groups you create. For example, if Lee shares a group with Dan, Dan cannot share 
the same group with Lois unless Dan makes a copy and shares this copy. The Infor CRM administrator 
sees all created groups whether they are shared or not. 

The list view becomes crowded if you have many groups. You can only delete groups you’ve created and 
cannot delete groups shared with you. This means unless you’re the Infor CRM administrator you cannot 
edit or delete any of the out-of-the-box groups because they are owned by everyone. 

To clear space, hide groups less frequently used. 

Group Manager 
The group manager feature in the Web Administrator allows you to see every group you current have on 
your Infor CRM Web Client, for all Entities. There is additional information that you can filter on here, such 
as First Used and Last Used date. This additional auditing features can give you insight into which groups 
may no longer be needed or could be modified to better serve their intended purpose. There are three 
tabs available in Group Manager; Groups, Shares, and Usage. You can also Edit groups from here, 
however it may be easier to edit groups from the Entity View. 

Groups 
The Groups tab shows you generic about the groups. This includes the family, name, ad hoc status, 
create/Modify date, and other generic information regarding the group. This tab will show you all groups. 

The Groups tab will also allow you to view, edit, delete, share, and reassign an owner of a group. 

Shares 
The groups tab shows you information regarding the shared status of your groups. This includes the 
shared date, who it was shared to, user types, and more information. This tab will only show you groups 
that have been shared. 

Usage 
The Groups tab shows you statistics regarding your groups. This includes the number of times a group 
has been used, when it was first used, and an owner’s usage stats. This tab also will allow you to reset 
the statistics of a group. 
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Exercise 10.6: Groups and group manager 
In this exercise, you will XXXXXX. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Access Group Manager 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Select the Administration Nav Bar > Group Manager. This opens the Group Manager view. 

Part 2: Create a Group without Conditions (Ad Hoc) 

1. Click Sales to open the Sales Nav Bar. 

2. Click Accounts to open the Accounts main view. 

3. Click Lookup. This opens the Account dialog box for a lookup search. 

4. Select the following conditions: 

• Lookup By: Account 
• Condition: Starting With 
• Criteria: A 

5. Click Search. This opens the Lookup Results group. 

6. Select all the results by selecting first results, scroll down, and shift click the last result. 

7. Right-click the selected items. 

8. Select Save Records as Group. This opens the Add Records to a New Group dialog box. 

9. Type Ad Hoc Starts With A in the Group Name field. 

10. Click OK. 

The new group is now created and available along with the other groups tabs. Because group 
tabs are sorted alphabetically it should appear near the beginning of the list. 

Part 3: Create a group with conditions (Dynamic) 

1. Click Add Group in the Account list view. 

2. Type A Condition in the Name field. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/GroupsandGroupManager.mp4


 

176  Lesson 10: Personalize the Infor CRM Web Client 
  

 © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

3. Type A Condition in the Display Name field. 

Generally, you would want a more descriptive name, however this will allow our query to be near 
the beginning of our groups tabs, to allow for easier comparison with our Ad Hoc Starts With A 
group. 

4. Click the Conditions tab. This opens the conditions view in the bottom pane. 

5. Click Account in the top left window of the Query Builder. This loads all Account columns into 
the field on the right in the Query Builder. 

6. Click and drag Account Name from the Column field into the Conditions tab. This opens the 
Assign Conditions dialog box. 

7. Enter the following information: 

• Operator: Starting With 
• Value is: A 

8. Click OK in the Assign Conditions dialog box. 

9. Click OK in the Query Builder. 

The group is now saved and available for use from the groups tabs. 

Part 4: Explore the difference of Ad Hoc and dynamic queries 

1. Click the Ad Hoc Starts with A group. 

2. Make note of the number of records in this group. 

3. Click the A Condition group. 

4. Make note of the number of records in this group. 

5. Open the All Accounts group. 

6. Open the AWI Limes Account detail view. 

7. Type BWI Limes in the Account Name field. 

8. Click Save. 

9. Click List View to return to the Accounts list view. 

10. Open the Zenith Robotics Corp. account. 

11. Type AZenith Robotics Corp. in the Account Name field. 

12. Click Save. 

13. Click List View to return to the Accounts list view. 

14. Open the Zefer May Industrial Account detail view. 

15. Type Azefer May Industrial in the Account Name field. 

16. Click Save. 

17. Click List View to return to the Accounts list view. 

18. Click the Ad Hoc Starts With A group. 

Note the total records. This should number should not have changed. Because this is an Ad Hoc 
group, the records in it are static and will not change based on the initial criteria the group started 
with. 
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19. Click the A Condition group. 

Note the total records. This number should be one higher than before. This is because a dynamic 
group will update based on the current information stored in the database against the conditions 
used to create the group. In this case, we removed one record AWI Limes, and added two Zenith 
and Zefer, by changing the Account Names of each to either start with A or to no longer start with 
A. 
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Check your understanding 
 

 
List six items that can be personalized within Infor CRM’s Web Client? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 

What are the differences between products and packages? How can each benefit Infor 
CRM’s Web Client? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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How can lead sources and qualifications help convert leads into contacts and accounts? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What is are some benefits of utilizing Groups within an entity? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Lesson 11: Customize the Infor CRM 
Web Client 
Estimated time 
1 hour 

Learning objectives 
In this lesson, you will: 

• Use Form Manager to edit forms. 
• Use Entity Manager to edit entities. 
• Learn about advanced developer customizations. 

Topics 
• About customizations 
• Form Manager customizations 
• Entity Manager customizations 
• Development level customizations 
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About customizations 
The Infor CRM Web Client can be customized in many ways to better help your company attain the goals 
it wishes to accomplish with Infor CRM. In addition to the multiple ways you can personalize the out-of-
the-box entities and form, developers can greatly enhance the capabilities of Infor CRM’s Web Client by 
adding new entities, forms, business rules and events. 

Administrators can use Form Manager to edit already existing forms, to add fields, change captions, and 
other simple customizations. While the Entity Manager is available to make small changes to existing 
entities. 
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Form Manager customizations 

Form Manager Nav Bar 
Form Manager will show you a list of all the forms that are available within your Infor CRM Web Client 
installation. This includes any custom forms developers have created and deployed for you. From this 
view, you can open any of the forms into the Form Designer to make basic changes to the form. 

Form Designer 
Form Designer allows you to actively change the way an existing form appears within Infor CRM’s Web 
Client. The look and feel of the form can be changed including; layout of fields in the grid, which fields are 
visible, adding and removing fields from the form, and changing captions for each field. 

Form Designer can also be reached from most individual forms as well. Many administrators find it easy 
to access Form Designer from the actual form that is going to be modified as within Form Manager the list 
of forms can be long and robust.  

 

Exercise 11.1: Customizing forms with Form Designer 
In this exercise, you will access Form Manager to see a list of all forms, open a form inside 
Form Designer from the Form Manager view, access Form Designer from an active form, 
and use Form Designer to change the look of a form. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Using Form Manager to access Form Designer 

1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Click the Administration Nav Bar > Form Manager. The From Manager screen opens. 

5. Click Account Details to open the Account Details form in Form Designer. 

There are over 300 current forms in our Web Client, so accessing the forms from Form Manager 
can sometimes be cumbersome. If the form name is unknown, but a user process to get to this 
form is known, it may be easier to access Form Designer from the form itself. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/CustomizingFormsWithFormDesigner.mp4
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Part 2: Access Form Designer from an Active Form 

1. Select the Sales Nav Bar > Account. This opens the Account list view. 

2. Click the Abi Specialty Group to open their detail view. 

3. Right-click the Edit Form icon located in the toolbar. 

4. Select Open in New Tab to open the Form Designer in a new tab. 

Note: It’s not required to open Form Designer in a new tab. If your browser does not have this 
capability it is not a requirement. Most Administrators find it easier to open Form Designer in a 
new tab, as this allows them the ability to quickly switch back to the active forms tab to refresh 
and see their changes more quickly. 

5. Switch to the newly opened tab in your web browser. 

Part 3: Edit an active form in Form Designer 

1. Right-click a grey cell on the left of the grid. 

2. Select Insert Row > Above. This adds an empty row above the row with the grey cell. 

3. Click and drag the Status field to the empty cell below Acc Manager. 

Note: A green highlight appears on the field when you can stop the click and drag. 

4. Find the Territory field from the list on the right. 

5. Click and drag Territory into the cell where Status was removed earlier. 

6. Select the Address field from within the grid. 

7. Select the Basic tab. 

8. Type Home Office Address in the Caption field. 

9. Click Save. 

Part 4: Verify the changes 

1. Switch to the active form tab in your web browser. This is our form not open in Form Designer. 

2. Click the refresh button on your web browser. 

After the refresh completes, you should see you changes to the form. This includes the new 
fields, and the updated caption. 

 



 

184  Lesson 11: Customize the Infor CRM Web Client 
  

 © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

Entity Manager customizations 

Entity Manager 
The Entity Manager provides a list of entities and allows you to take certain actions from this view. Within 
the Entity Manage use the filters to narrow the list of entities you want to view, and create new entities 
from the Task Pane. Find details about specific entities from the details pane tabs as well as to manage 
entity related information. 

The items within Entity Manager can greatly affect the Infor CRM system. Incorrectly creating, deleting, or 
modifying an entity can impact several items. Due to this it is recommended that only advanced users or 
developers be given access to this administrative feature. 

List view 
The Entity Manager list view contains 4 tabs within it by default; Fields, Filters, Metrics, and Relationships. 
The information within each tab will change depending on the Entity that is selected within the list above 
them. 

Missing from the List View for Entity Manager is the ability to create groups, or run a lookup search. 
These items are also disabled from the Entity Manager context menu from the navigation bar 

Fields  
The fields tab lists all the fields associated with the currently selected entity. From within this tab you can 
add new fields to the entity, as well as edit existing fields. Deleting a field is not available from within this 
tab. 

When adding a new field, you can use any of the available types, and if required add additional 
information to the field. For example, creating a calculated field will allow you to create the calculation. 

Filters 
The filters tab lists all the filters associated with the currently selected entity. From within this tab you can 
add, edit, and delete filters related to the currently selected entity.  

Metrics 
The metrics tab lists all the metrics associated with the currently selected entity. From within this tab you 
can add, edit, and delete metrics related to the currently selected entity. These metrics can be used in 
places such as dashboards as calculated data. 

Relationships 
The filters tab lists all the relationships associated with the currently selected entity. From within this tab 
you can add, edit, and delete relationships related to the currently selected entity. This will allow you to 
connect to related entities via a shared ID field. By having a relationship, the two entities can then be 
used with lookups on forms within Infor CRM among other items. 

Detail view (dialog window) 
The detail view within Entity Manager is a dialog window which allows you to edit basic information 
related to the Entity. This includes items such as the Entity’s display name and plural display name. What 
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field is used as the title for the entity. If the Entity is an Extension, and some of the advanced options; 
Import, Match, Bulk Update, Audited, Put, Post, and Delete. 

 

Exercise 11.2: Exploring Entity Manager 
In this exercise, you will create a new field in the Account entity, Priority, as a Pick List and 
associate the Priority pick list to it. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 
1. Open the Infor CRM Web Client. 

2. Type admin in the Username field. No password is required.  

3. Click Sign In. 

4. Select the Administration Nav Bar > Entity Manager. The Entity Manager screen opens. 

5. Select the Account entity. 

6. Click Add within the Fields tab. This opens the Add Field to Account Entity dialog box. 

7. Enter the following information 

• Display: Priority 
• Name: Priority 
• Type: Pick List 

Once you select Pick List, some additional options appear. 
• Pick List: Priority 

8. Click OK. 

9. Click Save. 

Now that the new field has been added to the Entity, you could go back into Form Designer for an 
account form and add the new field. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ExploringEntityManager.mp4
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Development level customizations 
In addition to Form Manager and Entity Manager customizations, Infor CRM allows for more advanced 
customizations to be created within Infor CRM’s Web Client. Creating these customizations is better left to 
developers to ensure they work properly. Some of these customization options are listed below. 

These customizations will typically be created within the Application Architect program that comes with 
Infor CRM. However, for some of these customizations you can code in other IDE’s such as Microsoft 
Visual Studio or Eclipse. 

Make your own entities 
Application Architect gives you the ability to create brand new entities from scratch. These entities can 
either extend already existing entities to add new functionality, or they can be brand new entities to help 
maintain and organize new information within your database. 

Make your own forms 
Application Architect also allows for you to create brand new forms and pages to view them on. These 
forms can be created as a detail form, summary view, or a form with a grid. These forms can then be 
used as Main Views, new Tabs, or even pop-up Dialogs. 

Create custom relationships 
Relationships in Infor CRM connect two entities together with shared data. Such as how a Contact can be 
included in an Account view, or how we use lookups in forms. Application Architect will allow you to 
create additional relationships to connect new entities to existing out-of-the-box entities, or connect nay 
existing entity to another. 

Use .NET or other languages for customer business rules 
Application Architect is the main program used for creating new customizations within Infor CRM’s Web 
Client, however it is not the only program you can use. Application Architect can take DLL files that have 
been created in other programs and use the methods stored within them as business rules within forms, 
or entities. 

Customization example 
Perhaps Phoenix Computers wanted to track Projects that they are working with their customers. A new 
Entity could be created, ClientProjects, with a relationship to Accounts. This would allow Phoenix 
Computers to know what account is related to which project. 

This could be further customized if ClientProject also had a relationship with the Contacts entity, if there 
was a specific person within an Account that was the key manager of the Project. 

Perhaps these projects were handled within Phoenix Computers by using the Ticket entity already 
available in Infor CRM, another relationship could be created to connect those. 

Also, Client Projects may have a status field, which could include ‘Closed’ as an option. A developer 
could create a new business rule that will verify before a save occurs if that status field is set to closed, to 
verify all associated Tickets are also closed before allowing the save to occur. 



 

  Infor CRM: v8.4 Administering Training Workbook 187 
   

  © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

Though this is a simple example of a customization that may be utilized, it shows just how robust Infor 
CRM’s Web Client can get when you start creating new customizations for it. 
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Check your understanding 
 

 
What can be changed in a form via Form Designer? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
Can new entities be created to customize Infor CRM? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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What benefit is there to using Entity Manger to view or modify existing entities? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What is Application Architect used for in regards to customizations? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Lesson 12: Windows security 
Estimated time 
2 hours 

Learning objectives 
In this lesson, you will: 

• Explore the different security features. 
• Explain administrative roles. 
• Explore feature security. 
• Define field security. 
• Examine function security. 
• Apply security. 

Topics 
• Windows security 
• Set user security in the Windows Client 
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Windows security 

Managing administrative roles 
The admin user is the only user account with full access rights to all features and operations in the Infor 
CRM Clients and Infor CRM Administrator. If you want to allow another user to assist with administrative 
functions, you must give the user access to the Infor CRM Administrator workstation or install the 
Administrator application on the user’s computer. If you install multiple copies of the Administrator, all 
executable files for the Administrator (Admin.exe) must contain the same release number. 

To perform the functions assigned to an administrative role, a user must have: 

• An administrative role assigned using the Security tab on the User Profile. 
• Access to the Infor CRM Administrator. 

 

 

Infor CRM does not recommend giving the same administrative role to more than one 
user. Administrative roles allow other users to perform limited, specific tasks in the Infor 
CRM Administrator generally reserved for the system administrator. You can assign an 
administrative role to a user on the user’s Security tab within their profile. 

 

Although Infor CRM includes the following administrative roles by default, you can create custom 
administrative roles as well. 

• Sales admin – Users assigned this role can perform all functions except managing 
SpeedSearch, using the Database Manager, and modifying the Library. 

• DB admin – Users assigned this role can perform all functions except realigning territories, 
modifying sync transfer profiles, modifying the Library, and managing currency. 

• Librarian – Users assigned this role can manage SpeedSearch, manage NetForms, and modify 
the Library. 

 

 

When a new administrative role is created, access rights to all functions automatically 
default to No. Double-click a function to change the value to Yes, making it available for 
that administrative role. 

 

The following functions are available for each administrative role: 
 

Function Description 

Attach Remote Allows the user to attach or detach remote databases. 

Calc Field Manager Allows the user to add, edit, and delete calculated fields. 

Change User 
Password 

Allows the user to change another user’s password.  
Note: To give password access, you must also enable the Modify Users 
(restricted) function. 
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Create Remote 
Office DB 

Allows the user to create a Remote Office database. 

Create Remote 
User DB 

Allows the user to create a Remote user database. 

Execute SQL Allows the user to run SQL statements against the database. 

Integrity Checker Allows the user to run the Integrity Checker to locate errors and correct 
records in the database. 

Join Manager Allows the user to add, edit, and delete global joins. 

Lookup Manager Allows the user to add, edit, and delete lookups. 

Manage Currency Allows the user to enable multi-currency; add, edit, or delete currency values; 
and update open opportunities with revised currency values. 

Manage NetForms Allows the user to manage .NET Extensions. 

Manage 
SpeedSearch 

Allows the user to configure SpeedSearch, manage indexes, and manage 
schedules. 

Modify Bundles Allows the user to manage, add, remove, or upgrade bundles. 

Modify Library Allows the user to edit the files and folders in the Library. 

Modify Systems Allows the user to modify agents, offices, sync servers, licenses, and remote 
tasks. 

Modify Teams Allows the user to modify teams. 

Modify Users Allows the person with this role to change everything on users’ profiles.  
Note: The person with this role can also match Infor CRM users to Windows 
users. 

Modify Users 
(restricted) 

Allows the person with this role to modify users’ profiles.  
Note: The person with this role cannot set the Windows ID, password, or the 
information on the User Profile Security tab. 

PickList Manager Allows the user to add, edit, and delete pick lists and pick list items. 

Realign Activities Allows the user to realign activities and processes. 

Realign Territories Allows the user to reassign account ownership. 

Resync Remote 
DB 

Allows the user to resynchronize a remote database. 

Security Profiles Allows the user to manage security profiles. The user can create, edit, and 
delete profiles but cannot assign them to users. 

Sync Transfer 
Profiles 

Allows the user to define the methods and parameters used for 
synchronization. 

Tools Options 
Menu 

Allows the user to access the Options dialog box and set various Infor CRM 
system options. 
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Use DB Manager Allows the user to add, view, and delete tables and fields in the database. 
 

User Profile Function Security tab 
 

Item Function 

Activity Reminder Allows the user to access the Activity Reminder to keep track of his or her 
activities. 

Dial Phone Allows the user to access dialing properties for Dialer. 

Options Allows the user to access the Options dialog box which contains options 
for setting Display settings, Lookups and Groups settings, Outlook 
Synchronization settings, Email settings, Activity settings, Calendar 
settings, and Other settings. 

Add Contact to Outlook Allows the user to add an Infor CRM contact to the Outlook address 
book. 

Literature Fulfillment Allows the user to access the Literature Requests view to fulfill, complete, 
and reject literature requests. 

Mail Log on/off Allows the user to log on or off the email system. 

Customize, Menus Allows the user to customize Infor CRM Client menus. 

Customizing, Toolbars Allows the user to customize Infor CRM Client toolbars. 

Processes, Scan 
Interval 

Allows the user to determine how often to scan processes. 

Processes, Process 
Manager 

Allows the user to access the Process Manager to assign, scan (start), 
and monitory the status of processes assigned to their contacts. 

Processes, Scan All 
Processes 

Allows the user to run al processes that they own, including those on 
contacts they are not currently viewing. 

Processes, Purge 
Processes 

Allows the user to delete processes. 

Processes, Scan this 
record 

Allows the user to scan all processes for the current contact. 

Maintenance, Check 
for Duplicates 

Allows the user to eliminate duplicate accounts or contacts using the 
Check for Duplicates Wizard. 

Maintenance, Replace 
Data 

Allows the user to replace one or more values with another value in the 
Account, Contact, or Opportunity tables using the Replace Data Wizard. 

Maintenance, Purge 
Records 

Allows the user to delete account, contact, or opportunity records and 
related data from the database using the Purge Records Wizard. 

Manage, Customer 
Service Defaults 

Allows the user to access the Manage Customer Service Defaults dialog 
box which contains options for ticket entry and time tracking. 
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Manage, 
AreaCategoryIssue 

Allows the user to manage the Area, Category, and Issue lists used to 
classify tickets and defects for Customer Service. 

Manage, Customer 
Service Options 

Allows the user to access the Manage Customer Service Options dialog 
box which contains options for setting Auto-Assignment, User Defaults, 
and Ticket Rate options. 

Manage, Dashboard 
Options 

Allows the user to access the Manage Dashboard Options dialog box 
which contains access to Fiscal Calendar Periods. 

Manage, Qualifications Allows the user to access the Configure Qualifications dialog box which 
contains fields for providing descriptions for each level in the qualification 
process. 

Manage, Standard 
Resolutions 

Allows the user to access the Mange Standard Resolutions dial box 
where information for standard resolutions is entered into Infor CRM. 

Manage, Standard 
Problems 

Allows the user to access the Manage Standard Problems dialog box 
where information for standard problems is entered into Infor CRM. 

Manage, Opportunity 
Defaults 

Allows the user to access the Opportunity Defaults dialog box which 
contains default settings for new opportunities.  

Manage, Quotas Allows the user to manage quotas for their sales team using the Mange 
Quotas dialog box. 

Manage, Products Allows the user to add to, edit, and delete from the list of products. When 
the user adds an opportunity, they can add one or more products to the 
opportunity. 

Manage, Competitors Allows the user to add to, edit, or delete from the list of competitors using 
the Manage Competitors dialog box. The user can also add, edit, or 
delete information about competitors’ products and customers.  

Manage, Lead Sources Allows the user to add to, edit, or delete from the list of lead sources. 
Lead sources can be items such as trade shows, conferences, dealer 
referrals, or web inquiries. 

Manage, Resources Allows the user to add, edit, delete, and schedules resources. Resources 
can include conference rooms and equipment such as overhead 
projectors and white boards. 

Manage, Pick Lists Allows the user to add, edit, or delete pick lists and pick list data. 

Manage, Sales 
Processes 

Allows the user to access the Manage Sales Processes dialog box where 
the user can create sales processes and edit existing sales processes. 

Manage, Literature Allows the user to select a document from the list of literature when 
scheduling a literature request and to use the Manage Literature dialog 
box to add to, edit, or delete from the list of available literature. 

Macros, Record Macro Allows the user to record a macro. 

Macros, Run Macro Allows the user to run a macro. 

SpeedSearch Options Allows the user to specify the options available through SpeedSearch. 
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Exercise 12.1: Create and assign an administrator roles 
In this exercise, you will create and assign an administrator role. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
Lois Tomlin is the inside sales manager. Due to frequent turnover in the Sales department, 
Lois wants the ability to realign territories and activities when a sales user leaves or joins the 
company. How can Lois adjust these settings? 

• Create an administrative role for Realignment. 
• Assign the Realignment role to Lois Tomlin. 
• Sign in to the Administrator as Lois to verify settings. 

Exercise steps 

Part 1: Create a new role 

1. Open Infor CRM Administrator. 

2. Type admin in the username field. No password is required. 

3. Click OK. 

4. Select Manage > Administrative Roles from the menu bar. The Manage Administrative Roles 
screen opens. 

5. Click New Role. The New Administrative Role window opens. 

6. Type Realignment in the Enter Role Name field. 

7. Click OK. A new column is created for the Realignment role. 

8. Double-click inside the Realign Territories cell under the Realignment role (column) to change 
the value from No to Yes. 

9. Double-click inside the Realign Activities cell under the Realignment role to change the value 
from No to Yes. 

10. Press F5 to refresh the Administrator so the new role is available. 

Part 2: Assign the administrative role to Lois Tomlin 

1. Click Users to open the Users view. 

2. Click the All Users tab to browse all users. 

3. Double-click Tomlin, Lois. The User Profile for Tomlin, Lois window opens. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/CreateAndAssignAnAdministratorRole.mp4
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4. Click the Security tab. 

5. Select Realignment from the Administrative Role drop-down list. 

6. Click OK to close Lois Tomlin’s profile. 

Now Lois has rights to sign in to the Infor CRM Administrator application. You can either install 
the application on her computer or give her access to the Administrator workstation. Let’s test her 
credentials to see what Lois can view when she signs in to the Administrator. 

7. Select File > Exit from the menu bar. 

8. Sign back in to Infor CRM Administrator by selecting Start > All Programs > Infor CRM > 
Administrator.  

9. Type Lois in the Username field. No password is required. 

10. Click OK. 

Notice how all navigation menus, toolbars, and other menus are inaccessible except the Realign 
Territories and Realign Activities under the Tools menu. 

11. Exit the Infor CRM Administrator. 

Part 3: Delete an administrative role 

1. Open Infor CRM Administrator. 

2. Type admin in the Username field. No password is required. 

3. Click OK. 

4. Select Manage > Administrative Roles from the menu bar. The Manage Administrative Roles 
screen opens. 

5. Click New Role. The New Administrative Role window opens. 

6. Type Delete in the Enter Role Name field. 

7. Click OK. A new column is created for the Delete role. 

8. Select the Delete role by clicking on a cell in that column. 

9. Click Delete Role. A confirmation dialog box opens. 

10. Click Yes. This deletes the selected role. 

 



 

  Infor CRM: v8.4 Administering Training Workbook 197 
   

  © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

Set user security in the Windows Client 
User security refers to the ways in which you can restrict or allow access to features, functions, and fields 
within the Infor CRM client. 

• Windows Client users can set user security from the Security and Function Security tabs of a 
user profile in the Administrator. 

• Web Client users can set user security from the Roles and Secured Actions view in the Web 
Administrator. Field security profiles set in the Windows Administrator apply to both Windows and 
Web users. You can also view and edit field security profiles in the Security Manager of the Web 
Administrator.  

Feature Security: Prevent users from adding or deleting records 
To prevent users from adding or deleting records, use the Security tab of a user profile. Feature security 
permissions determine whether a user can add or delete records. Multiple entities can be secured from 
this tab by selecting security preferences for each entity, e.g., ACCOUNT, CONTACT, OPPORTUNITY, 
RETURN, and more. For each entity, you can choose which detail view and lookup view to set as the 
user’s default. 

Function Security: Prevent users from using interface items 
To limit items on the Windows Client interface, use the Function Security tab of a user’s profile. When 
you remove access to a function, the related menu item or toolbar appears grayed out in the Windows 
Client. 

Consider the following for function security: 

1. When you add a new user, the following functions are disabled (no access) by default: 

• File > Subscribe to Account 
• Edit > Account Unsubscribe 
• Tools > Literature Fulfillment 
• Tools > Customize 
• Tools > Maintenance 
• Tools > Manage 
• Tools > Macros 

2. When removing access from a main category, access to all dependent items is also removed 

3. Changes take effect the next time the user signs in to Infor CRM or refreshes the client by clicking 
CTRL + F5. 

4. Create new secured functions in the Architect by clicking Manage and then clicking Secured 
Functions. 
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Exercise 12.2: Set custom feature and function security 
In this exercise, you will set and apply custom features and functions to a user and then 
verify the settings. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

Exercise steps 

Part 1: Remove access from a user’s profile 

1. Open Infor CRM Administrator. 

2. Type admin in the username field. No password is required. 

3. Click OK. 

4. Select the Administration Nav Bar > Users.  

5. Double-click Derek Murray from the All Users list. The User Profile for Murray, Derek window 
opens. 

6. Click the Security tab. 

7. Select OPPORTUNITY from the Entity Name drop-down list. 

8. Clear the Delete Opportunity check box. A dialog box opens indicating the user’s ability to purge 
records is removed. 

9. Clear the Add Opportunity check box. 

 
10. Click OK. 

Part 2: Set function security 

1. Click the Function Security tab in Derek Murray’s user profile. 

2. Select Tools > Manage. 

3. Select Quotas. 

4. Click Remove Access. The menu item is updated with a red X. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/SetCustomFeatureAndFunctionSecurity.mp4
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5. Click Maintenance. 

6. Click Remove Access. Notice this time all functions under maintenance now have the red X 
showing there is no access granted. 

Part 3: Verify security settings 

1. Select Start > All Programs > Saleslogix > Infor CRM Client. The Please log on window 
opens. 

2. Type derek in the Username field. No password is required. 

3. Click OK. 

4. Close the Activity Reminders window if it opens. 

5. Select Insert > Opportunity from the menu bar. 

A dialog box opens stating Derek doesn’t have security for this feature. This is expected because 
you removed Derek’s access to view Opportunities. 

6. Click OK to close the message.  

Part 4: Test function security to ensure Derek cannot adjust sales quotas. 

1. Select Tools > Manage from the menu bar. Notice the Quotas menu item not available to Derek 
in the Manage menu. 
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2. Select Tools > Maintenance. Notice all items are grayed out. 

3. Exit the Infor CRM Client. 
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Check your understanding 
 

 
What are some benefits of using feature security? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What are some benefits of using function security? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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What are administrative roles? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 



 

  Infor CRM: v8.4 Administering Training Workbook 203 
   

  © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

Lesson 13: Prepare the Windows Client 
Estimated time 
1 hour 

Learning objectives 
After completing this lesson, you will be able to <terminal learning objective for lesson X>. In this lesson, 
you will: 

• Setup the Windows Client. 
• Manage the functions within the Manage toolbar. 
• Manage the functions within the Tools toolbar. 

Topics 
• Install the Windows Client 
• Establish a database connection 
• Explore the Manage toolbar 
• Explore the Tools toolbar 
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Install the Windows Client 
Because you haven’t configured user profiles yet, imagine you’re installing the Infor CRM Windows Client 
on the Administrator workstation to test the implementation. The administrator profile is added 
automatically. 

The Windows Client refers to either the Windows Client or the Remote Client. 

What’s included in a typical Windows Client installation? 
In a typical Infor CRM Windows Client installation, the following programs and files are installed: 

• Infor CRM client: The program allowing users to interact with sales data. 
• Import Wizard: A separate utility allowing you to import a large amount of data from another 

database or from a text file. 
• Mail Client: A separate utility interfacing with the user’s email system. 
• Help Files: Infor CRM Client, SpeedSearch Client, and Import Wizard. 
• Documentation: Infor CRM Quick Reference for the Customer Service and Support user, Infor 

CRM Quick Reference for the Sales and Marketing user. 

Import Wizard implications 
You may want to install the Import Wizard utility on the Administrator’s workstation only and import data (if 
any) before non-administrative users sign in to Infor CRM. An import is generally a one-time event which 
you might perform if you have data in an older system prior to installing Infor CRM. Next, it’s 
recommended for non-administrative Infor CRM users to insert additional records manually as they are 
discovered. Removing the Import Wizard from other users’ machines prevents users who aren’t properly 
trained on its use from accidentally tainting the database. 

Can I automate client installations? 
Instead of physically inserting an installation disk into each Infor CRM client user’s computer you can 
create an automated installation (executable file) which you can then host in a shared location or 
distribute to users for self-service. When you build an auto-installation, any custom settings you choose 
are retained for each user who executes the auto-installation file including the data link to your Infor CRM 
Server. Building a client installation is available for both the Network and Remote Clients (Windows). 

What settings should I adjust in the client after installation? 
After installing and signing in to Infor CRM you may want to set additional administrative settings by 
clicking Tools and then clicking Manage. By default, new users don’t have access to this menu as it’s 
generally reserved for the administrative user or for “’power” end users who you’ve chosen to assist you 
with these settings: 

• Pick lists • Quotas 

• Lookups • Sales processes 

• Literature • Customer service defaults 

• Resources • Customer service options 
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• Qualifications • Lead sources 

• Products • Standard problems 

• Opportunity defaults • Standard resolutions 

• Competitors • Dashboard options 

 

Exercise 13.1: Installing an Infor CRM Windows Client 
In this exercise, you will install the Windows Client. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
There are settings I’d like to change within Infor CRM for all users. How do I install the Infor 
CRM Windows Client on the Administrator’s workstation to configure and validate preferred 
settings? 

• Install all features including the Import Wizard on the Administrator’s workstation. 

Exercise steps 

 

The steps below are for a new installation on a clean environment. Because your training 
environment already has an Infor CRM Windows Client installed there will be some minor 
differences including a Modify, Repair, or Remove screen instead of being able to select a 
complete installation. Please follow along with the steps, but do not click Install when 
that option is available. 

1. Open the C:\ClassFiles\Infor CRM folder on your training workstation. 

2. Double-click the Setup.exe file to launch the Infor CRM Installation Wizard. The Infor CRM 
Installation screen opens. 

3. Click Run if prompted with a security message. 

4. Click Client Installations. The Infor CRM Client Installation screen opens. 

5. Click Install Network Client. The Welcome screen opens. 

6. Click Run if prompted with a security message. 

7. Click Next. The Setup Type screen opens. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/InstallTheInforCRMNetworkClient.mp4
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8. Verify the Complete radio button is selected and then click Next. The Ready to Install the 
Program screen opens. 

 

 

Please do not follow the remaining steps in the training environment. Please click 
cancel to end your installation process. 

9. Click Install. 

10. Click Finish. 

11. Click Exit to close the Infor CRM setup wizard. 
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Establish a database connection 
All Infor CRM administrative and client applications connect to the Infor CRM Server using a data link 
while the Infor CRM Server connects to the Database Server using OLE DB. 

 

If you install Infor CRM using the Express Installation or run the Standard Installation and install the Infor 
CRM Server on the Database Server (Microsoft SQL Server only) then Infor CRM automatically creates 
your database connections. 

When you install the Infor CRM Server on a separate machine from the Database Server, you must 
create the connection manually using the Connection Manager. Do this by clicking Start, clicking All 
Programs, clicking Infor CRM, and then clicking Connection Manager. 

Since every component is installed in the training workstation, the connection is already made. 

Within your Infor CRM installation, if you decide to add an additional database for testing or development 
purposes you may also need to create another database connection through Connection Manager. 
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All non-remote Infor CRM client and administrative applications use this connection on the Infor CRM 
Server by way of a data link. The following settings are default settings for the connection: 

• User name: sysdba 
• Password: Ma$t3rk3y 
• Allow saving password: selected 

 

Exercise 13.2: Create a database connection 
In this exercise, you will create the database connection. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 
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Scenario 
Our company needed to create a new database for testing purposes. How can I create a 
connection to this new database within Infor CRM? 

• Use Connection Manager to create a new Infor CRM Database Connection. 
• Add the newly created connection to the options within Infor CRM. 

Exercise steps 

 

The steps below are for a new installation on a clean environment. Because your training 
environment already has a InforCRM_EVAL database installed please follow along with 
the steps, but choose a different name when that option is available. 

Part 1: Create the database connections for the databases 

1. Select Start > All Programs > Connection Manager. The Saleslogix Connection Manager 
window opens. 

2. Click Add. The Connection Name window opens. 

3. Type INFORCRM_EVAL in the Name used to refer to this connection field. 

4. Click OK. The Data Link Properties window opens. 

5. Select SQL Server Native Client 11.0 and then click Next. 

6. Type SRV10\SQLEXPRESS in the Select or enter a server name field. Remember, depending 
on your server’s name, “SRV10” may be different. 

7. Select the Use a specific user name and password radio button. 

8. Type sysdba in the User name field. 

9. Clear the checkmark in the Blank password field. 

10. Type Ma$t3rk3y in the Password field. 

11. Select the Select the database radio button and then select saleslogix_eval from the drop-down 
list. 

12. Click Test Connection. 

13. Click OK. 

14. Click the All tab. 

15. Double-click Integrated Security. The Edit Property Value window opens. 

16. Click Reset Value. 
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17. Click OK. 

18. Double-click Persist Security Info. The Edit Property Value window opens. 

19. Select True from the Property Value drop-down list. 

20. Click OK. 

 
21. Click the Connection tab and then click Test Connection. 

22. Click OK. 

23. Click OK again. This creates your connection and brings you back to the Saleslogix Connection 
Manager window. 
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24. Click Apply, this will save our new connection. 

25. Click Edit. The Data Link Properties window opens again for a final test. 

26. Click Test Connection. 

27. Click OK. 

28. Click OK again. 

Part 2: Add the InforCRM_EVAL database 

1. Open the Infor CRM Windows Client. 

2. Click the ellipsis next to the Log On To field. 

3. Click Add in the Data Link Manager dialog. 

4. Select SalesLogix OLE DB Provider. 

5. Click Next. 

6. Enter SRV10 as the SalesLogix Server.  

Note: This maybe different on your Training Environment. 

7. Select InforCRM_Eval from the SalesLogix Database Name field. 

8. Enter Admin into the Username field. 

9. Click Test Connection, to verify all the settings. 

10. Click OK. 

11. Click OK again. 
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12. Click OK again. 

13. Click OK again. 

14. Click OK again to log on to the Infor CRM and verify the database connection worked. 

 

Exercise 13.3: Installing Infor CRM Administrator 
In this exercise, you will install Infor CRM Administrator. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
Not all Administrators want to log on to the Administrative Server to run admin functions 
within Infor CRM. Installing the administrator application on a local machine can alleviate this 
problem. 

Exercise steps 

 

The steps below are for a new installation on a clean environment. Because your training 
environment already has an Infor CRM Windows Client installed there will be some minor 
differences including a Modify, Repair, or Remove screen instead of being able to select a 
complete installation. Please follow along with the steps, but do not click Install when that 
option is available. 

1. Open the C:\ClassFiles\Infor CRM folder on your training workstation. 

2. Double-click the Setup.exe file to launch the Infor CRM Installation Wizard. The Infor CRM 
Installation screen opens. 

3. Click Run if prompted with a security message. 

4. Click Server Installations. The Infor CRM Server Installation screen opens. 

5. Click Required Administrative Tools and Servers. The Installation Wizard appears. 

6. Click Next. This opens a prompt asking if you want to install Microsoft SQL Express. 

7. Click No. Installing SQL Express, is not expected for a machine that will only have an Infor CRM 
Administrator application. After some setup, the Welcome screen will appear. 

8. Click Next, this will open the setup type screen. 

9. Select Custom. 

10. Click Next. The Custom Setup screen opens. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/InstallingInforCRMAdministrator.mp4
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11. Change Administrator to the This feature, and all sub features, will be installed on the local 
hard drive. 

12. Click Next. 

13. Click Install. 

14. Enable the Launch Administrator option. 

15. Click Finish. 

16. Type Admin into the Username field. 

17. Verify InforCRM_Eval is selected in the Log on to field. 

18. Click OK, to verify access to the Administrator application.  
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Explore the Manage toolbar 
The manage toolbar within Administrator give you multiple options to manage your Infor CRM Database 
and Installation. Below you will read summaries of what each of the tools are used for. 

For more comprehensive information on each of these tools, please see the Infor CRM Administrator help 
files. 

Database 
The Database Manager will show you a list of all associated tables within your Infor CRM database. 
Selecting a table will allow you to see a list of all fields setup within that table. 

From the Database Manager, you can add new fields to an existing Entity, remove fields, check field 
properties, change whether a field is indexed or hidden, among other options. The ability to create a new 
Table (Entity) is also available.  

Ensure that any changes made here are finalized by using the Apply Changes or Cancel Changes 
buttons in the toolbar. 

Global Join Manager  
The Global Join Manager displays all global joins in your Infor CRM database, and permits the system 
administrator or administrative user to add, edit, and delete global joins as necessary. A global join is 
permanent and exists from session to session in the Query Builder data tree structure. 

Extreme care should be taken if you add or edit a global join, as these can cause performance problems 
when not created properly. 

Pick lists 
The Pick List Manager allows a user with sufficient administrative rights the ability to manager all the Pick 
Lists within the Infor CRM system. This includes creating new Pick Lists, editing existing Pick Lists, and 
deleting pick lists. 

Lookups 
Lookups are used to search for, and populate a field with a specific value. To include a list of options with 
the lookup, you can associate it with a pick list. For example, when a user performs a lookup on City, the 
City pick list appears. For more customization, you can add the lookups you create to a menu, toolbar, or 
view using the Architect. See the Architect Help for more information.  

The Lookup Manager displays lookups for the selected main table. The name of a lookup is based on the 
lookup field within a table.  

Currency 
If your company has Infor CRM users in multiple countries using different currencies, you can enable 
multi-currency support. Before you enable multi-currency support, review Understanding Multi-Currency 
Support. Once multi-currency support is enabled and you set a base currency, you can use the Manage 
Currency dialog box to set up currencies to be used with opportunities, sales orders, and products. 
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Calculated fields 
A calculated field is dynamic and consists of two or more fields from the database. The fields used to 
create a calculated field can come from one table or from several joined tables. The values that appear 
for a calculated field are updated after changes are made to the fields comprising it. A calculated field can 
perform mathematical operations or concatenate strings, depending on the type of calculation. 

 

Exercise 13.4: Exploring the Manage menu 
In this exercise, you will explore the Manage features, Database, Global Joins, Lookup, 
Calculated Fields, and Pick Lists. You will also use the Pick List features within the Manage 
toolbar to create a new Customer Priority picklist. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
The manager toolbar contains many different features to help maintain and manage your 
Infor CRM system. In this exercise, you’ll explore the different features of this toolbar and 
work with some of the different functions. 

Exercise steps 

Part 1: Pick Lists 

1. Open Infor CRM Administrator. 

2. Type admin in the username field. No password is required. 

3. Click OK. 

4. Select Manage > PickLists. The Pick List Manager dialog box opens. 

5. Click Add. The Pick List Name dialog box opens. 

6. Type CustPriority in the Name field. 

7. Click OK. This will open the Edit List: CustPriority dialog. 

8. Click Add.  

9. Enter Ruby in the Item field. 

10. Click OK. 

11. Repeat steps 5 – 7 for the values; Presidential and Diamond. 

12. Click OK. Our new custom Pick List is now available for use. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/ExploreTheManageMenu.mp4
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13. Click the ellipsis next to the Test List field to verify the Pick List works. 
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Explore the Tools toolbar 
The Tools menu within Infor CRM Administrator offers options and tools used to help maintain your Infor 
CRM system. These include the ability to create Remote features, such as Databases and Offices, to 
realign activities and territories in the event of a Retirement or other user issue. As well as maintaining 
Database Integrity and verifying your system.  

Most of these tabs have been explained and examined in other lessons within this workbook. A quick 
overview of these tabs follows as a refresher and as information for tabs not explored already in this 
workbook. 

Integrity Checker 
The Integrity Checker is a utility that can be used to locate errors and correct records that are in your 
database. It is also available as a stand-alone utility (SLXDBChecker.exe), but is typically run from within 
the Infor CRM Administrator.  

 

 

The Integrity Checker does not work with Unicode data. If you do have Unicode enabled, 
test results may be inaccurate. 

 

 

Do not use the repair functionality of the Integrity Checker if any user or application is 
currently using the database. This includes having a running synchronization server, 
active users, or other services within Infor CRM. 

Systems Summary report 
The systems summary report displays information about your Infor CRM system. When you are 
contacting Infor CRM customer support they may request a copy of this report. This can only be accessed 
by the Infor CRM System Administrator, there is no Administrative Role that can be assigned to grant 
access to this report. 

This report includes items such as the Company the report is generated for, a Report number, which 
version and port your Infor CRM is installed on and using, which license keys are installed, any bundles 
that are installed, and information about the database. 

The File created is a text file that will open in your default TXT viewer. By default, it is given the name 
SLXSummary-<DATE>.txt. 

Options 
The options selection in the Tools menu contains multiple tabs representing different areas within the 
Infor CRM Windows Client. This can control everything from views you see at startup to rules for 
password complexity. Each tab within it represents a series of different options about a similar topic, such 
as Security, Passwords, or System. 
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Client view 
The client view tab handles items that pertain to the general Infor CRM Windows Client. These options do 
not alter how the Infor CRM Web Client views function.  

Options include warning users before switching to potentially large groups, which could affect the 
performance of Infor CRM. Whether large icons are shown within the client. If public contacts can be used 
in personal activities. As well as the ability to show (or unhide) all groups created in versions earlier than 
version 6.2 of Infor CRM. 

Client events 
The client events tab allows you to manage the event types for all Infor CRM Client users. New event 
types can be created such as trade shows or business trips. These event types can be assigned different 
colors to allow a user to quickly identify events within their calendar. 

Client plugins 
The client plugins tab controls the global basic script and actions that run when a user logs on or logs off 
onto the Infor CRM Windows Client. This tab does not apply to the Infor CRM Web Client. 

From this tab, you can set a Global Basic action that you want to append to any basic script. Also, from 
the DB Open option allows for a basic script to run when a user logs onto the Infor CRM client. The DB 
Close option will allow you to set a script for when a user logs off. 

Within this tab you can also set which views, menus, and toolbars are visible within the Infor CRM 
Windows client. These include options such as; Notes-History, Activities, and Attachments within the 
Contacts Entity, or Details, Marketing and Notes within the Leads entity. 

System 
The systems tab allows the configuring of dates, contact names, and how views and other toolbars 
appear in the Administrator. This tab allows you to select which view is opened on startup of the 
Administrator; Users, Teams, Library, Systems, Bundle Manager, or Database Manager. How far tree 
views are expanded by default, which toolbars are visible. 

The systems tab also allows for customizing how certain dates and names are viewed. Such as how the 
century used within a two-digit year. This allows you to set when the switch from 19XX to 20XX is utilized, 
such as from 1930 – 2029. Also, how a contacts name appears, either in a U.S. or International style  

Database 
The database tab stores and changes information regarding the Infor CRM Database. Options included 
whether a SQL or Oracle database are being used, what the ID and Password are for the Host Owner 
and Host Admin.  

Within this tab you can also see the Server Name associated with your Databases, where Remote DBs 
will be in your server, and the way a Remote DB will be prepared for creation. 

Conflicts 
The Conflicts tab is used with the synchronization clients and handles the conflict rules when a conflicting 
transaction occurs. A conflict is when multiple databases, remote or networked, have changed a record 
between synchronizations. 

There is up to a three-step check to see which transaction will win, or be used, by the database to 
determine what the record should be updated to. 
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Passwords 
The Password tab controls the password rules for updating and creating passwords. This tab controls 
what the default password will be for new users. Also, this tab will control what, if any, minimum password 
length is required and if there is a set number of days until a password will expire. 

Other options that can be set within this tab include the number of logins that can be attempted before a 
user will be locked out of their account, as well as the amount of time (in minutes) that the lockout will last. 

Changes to password rules that may invalidate specific user’s passwords will populate when clicking the 
button Show users with invalid passwords. This helps administrators know who they need to contact 
about updating their passwords. 

Outlook 
This Outlook tab controls whether Advanced Outlook Integration is used within an Infor CRM installation, 
and how attachments are saved when using the Send to CRM option within Microsoft® Outlook®. 

Accounting 
The Accounting tab contains system-level information that will allow Infor CRM to communicate with 
certain, supported, external accounting applications. This information must be configured before database 
transfer between Infor CRM and the accounting application can take place. 

Custom 
The Custom tab allows for managing options associated with specific categories, add-ons, and 
integrations. These include items such as Back Office Extensions, GoogleMail, GoogleSync, 
OutlookSync, and others. 

Items that you can view and edit vary depending on the category selected. For instance, the Back Office 
Extensions category contains items including; Tenant, Logical ID, Outbound Retry count, and others. 

 



 

220  Lesson 13: Prepare the Windows Client 
  

 © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

Check your understanding 
 

 
What pieces of Infor CRM are required in a Windows Client installation? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
How do you create a new Database connection to an Infor CRM system? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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What computers should the Infor CRM Administrator be installed on? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What benefits can be found in the Infor CRM Manage menu? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Lesson 14: Remote Network Client 
setup 
Estimated time 
2 hours 

Learning objectives 
In this lesson, you will: 

• List the programs installed in a Remote Client (Windows) installation. 
• Understand what happens on the remote machine during the synchronization process. 

Topics 
• Remote Client installation (Windows) 
• Synchronization folders on the client 
• Offline Client installation (Web) 
• Synchronization utilities 
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Remote Client installation (Windows) 
Synchronization is available for Windows and Web users. The Remote Client is used for Windows users 
using Infor CRM when disconnected from the network. 

What’s included in a typical Remote Client installation? 
In addition to some of the programs installed in a typical Network Client installation (Infor CRM client, 
Import Wizard, Mail Client, Help Files, Documentation), the following programs are installed for Remote 
Client installations: 

• Microsoft SQL Server 2012 Express: Hosts the remote database. Other prerequisite 
compatibility tools may also be required depending on the machine. 

• Infor CRM Sync Client: This required utility transfers data between the remote database and 
main office database. 

 

 

Remote client users may optionally install and configure Infor Xbar for Outlook to take 
advantage of Outlook Sync and access to Infor CRM data within Outlook. Administrators 
may copy the Infor CRM Xbar Setup.exe to a convenient location and share that location 
with Remote users. 

Import wizard implications 
Infor CRM recommends installing the Import Wizard utility on the Administrator’s workstation only and 
import data (if any) before non-administrative users sign in to Infor CRM. An import is generally a one-
time event which should be performed when you have data in an older system prior to installing Infor 
CRM. After, Infor recommends non-administrative Infor CRM users to insert additional records manually 
as they are discovered. Removing the Import Wizard from other users’ machines prevents users not 
properly trained on its use from accidentally tainting the database. 

Can I automate client installations? 
Instead of physically inserting an installation disk into each Infor CRM client user’s computer, you can 
create an automated installation (executable file) hosted in either a shared location or distributed to users 
for self-service. When building an auto-installation, any custom settings chosen are retained for each user 
executing the auto-installation file including the data link to your Infor CRM Server. Building a client 
installation is available for both the Network and Remote Clients (Windows). 
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Exercise 14.1: Install the Remote Client (Windows) 
In this exercise, you will install the Infor CRM Remote Client. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
Lee Hogan is a field sales rep who travels frequently. He requires access to Infor CRM data 
when he’s not connected to the network at the office. 

• During the Remote Client installation, you’re prompted to install prerequisites. Install 
SQL Server 2005 Backward Compatibility and Microsoft SQL Server 2012 Express. 

• Remove the Import Wizard utility since you’re installing on a user’s machine. 

Exercise steps 
1. Close all open Infor CRM programs. 

2. Double-click the Setup.exe file from the C:\ClassFiles\Infor CRM folder on your training 
workstation to launch the Infor CRM Installation Wizard. The Infor CRM Installation screen 
opens. 

3. Click Client Installations. The Client Installation screen opens. 

4. Click Install Remote Client. The welcome window opens. 

5. Click Next. 

6. Click Run if prompted with a security warning. 

If any prerequisite component for the Remote Client isn’t detected on the computer, Infor CRM 
prompts you to install those components first. Installing these prerequisites may require your 
computer to restart.  

7. Click Yes if Infor CRM prompts you with an upgrade message when pre-installation is complete. 
This message appears in the training environment because the Infor CRM Network Client is 
already installed.  

8. Click Next, when the Infor CRM Remote Client welcome screen opens.  

9. Select the Custom radio button and then click Next. The Custom Setup screen opens. 

 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/InstallTheRemoteClient(Windows).mp4
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10. Expand Program Files and remove the Import Wizard from the installation. 

 
11. Click Next. The Ready to Install the Program screen opens. 

12. Click Install. The Installing Infor CRM Remote Client screen opens.  

Note: If a Files in Use window opens, select the Automatically close and attempt to restart 
applications radio button, and then click OK. 

13. Click Finish. 

When the installation completes, you can find the following new items by clicking Start, pointing 
to All Programs, and then clicking Infor CRM. Programs denoted with an asterisk (*) were 
already installed in the training environment from a previous Infor CRM installation. 
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• Attach Remote 
• Mail client* 
• Infor CRM client * 
• SpeedSearch client* 
• Synchronization client 
• Documentation* 
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Synchronization folders on the client 
Synchronization requires a specific set of folders to exist on the Sync Server and each remote client. Let’s 
review the client folders here. 

What happens the first time you run the Sync Client? 
The first time you run the Sync Client, Infor CRM creates new subfolders under the Sync directory. This 
Sync directory is set at installation of the Sync Client under C:\ProgramData\SalesLogix. 

What is the purpose of the sync subfolders? 
The following table describes the subfolders created under the sync directory. 
 

Directory Purpose 

Archives Archives TEFs after they are sent to the main office. This is a subfolder under the 
Synchronization folder. 

Cache For a remote/offline user, cache is a temporary storage for TEFs before they are 
closed and placed in the Outfiles folder. Cache contains a subfolder named with 
the site code of the remote. 

Documents Stores attachment files retrieved by the Sync server as requested. 

FailedTrans Temporary holding place for failing transactions sent to the Host at the end of the 
synchronization cycle. When a sync error occurs during the synchronization cycle, 
a transaction containing the error and information from the TEF is written to the 
FailedTrans folder. Errors are also written to the SyncError.txt file. View failed 
transaction files using TrnViewer. 

Infiles Stores TEFs received from the main office. Files are deleted as transactions within 
the files are successfully applied to the database. 

Outfiles Stores TEFs created by Infor CRM Remote/Offline clients for the Synchronization 
Client to send to the main office. 

PortalDeployments Contains any new Web portals from the Application Architect. Portals are held in 
this folder until they are registered on the remote computer. During the registration 
process the portal is moved to its final location. 

QUEUEFiles\Failed Stores transaction queue files generated by the remote/offline user. These queue 
files are created with every database commit and typically contain a small amount 
of data. This is a subfolder of the Sync folder. QUEUEFiles and its child Failed 
folder are created by the Infor CRM system during installation. 

Sync This is a directory folder containing subfolders as well as the SyncStatus.txt, 
SyncErrors.txt, and WhatsNew.tlg. 
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WGLogs This is on the remote office only. WGLogs stores TEFs containing changes to the 
remote office database. 

 

 

Exercise 14.2: Run the Synchronization Client 
In this exercise, you will start the Sync Client. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
Lee Hogan is signing in to the Infor CRM client using his SLXRemote data link. Prior to 
making any changes, Infor recommends he start the sync client for the first time to create 
required sync folders. 

• See Lee’s sync preferences. 
• Use Network as the Connection method. 

Exercise steps 
1. Open the Infor CRM Windows Client. 

2. Type Lee in the Username field. No password is required. 

3. Verify the SLXREMOTE data link is selected.  

4. Click Sign In. 

5. Click Synchronize in the toolbar. The Saleslogix Synchronization Client window opens. 

Tip: You don’t need to sign in to the Infor CRM client to access the Sync Client. Instead, you can 
launch it by clicking Start, clicking All Programs, clicking Saleslogix, and then clicking 
Synchronization Client. 

6. Click Sync Now. The synchronization progress displays in the window. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/RunTheSynchronizationClient.mp4
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7. Click Close. 

 

Verify you can make a successful connection to SRV10 on port 8080. If not, sign in 
to the Sync server and check to see if it also has a connection issue. If so, 
troubleshoot the HTTPSync site setup. 

If a synchronization error occurs, remote users are encouraged to contact the system 
administrator. If necessary, they can view and send a copy of the log activity in the 
SyncStatus.txt file under C:\ProgramData\Saleslogix\Sync\. 

• If a transaction fails to apply during synchronization, a message in the Event Log displays the 
number of transactions failed to apply. The remote user receives a message stating how 
Sync Client is sending the failed transactions back to the Host. 

• If the remote user sends files from an Infor CRM version newer than their installed client, the 
user receives a message stating how the file is being skipped. The file remains pending until 
the user upgrades to match the file version. 

• If the message “Failed to send file” appears after the name of a TEF in the Sending files area 
of the dialog box, the disk drive where the Host Infiles is located might be full. 

Tip: View the “Resolving Synchronization Apply Problems” and “Explaining Synchronization Error 
Messages” in the Sync Server Help file for more troubleshooting tips. 
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Synchronization utilities 
As more users start using synchronization, you can take advantage of additional Infor CRM 
synchronization utilities such as Transaction Viewer/Analyzer, Sync Conflict Transaction Viewer, 
Resynchronize Database, and Remote Tasks. 

What is the purpose of the transaction viewer/analyzer? 
The Transaction Viewer and Transaction Analyzer utilities are located in C:\Program Files 
(x86)\Saleslogix. 

• TrnAnalyzer.exe compiles statistics of TEF contents used by the synchronization process.  
• TrnViewer.exe allows you to view the details of the TEF contents or save the TEF information to 

a text document. When viewing TEF files in text format you can use different text editors to view 
the information and find specific text. 

You might use one of these utilities to view and troubleshoot the contents of a TEF. 

About TEFs 
A binary transaction exchange file commonly referred to as a TEF contains changes to data transferred 
between the main office and each Infor CRM remote client or remote office database during 
synchronization. Synchronization uses TEFs to align remote and network databases and to resolve 
conflicting changes. 

TEFs contain a prefix, a site code of the machine creating the file, an Infor CRM key file value, and the 
site code of the machine designated to receive the file. 

Example: Transaction Exchange File: ZIP-ZEVR-A100002.Q5AH 

• ZIP: Prefix (indicates the kind of file). Available prefixes are ZIP, FILE, and CMD. 
• ZEVR: Site code of the machine creating the file (the FROM site code). 
• A10002: Key Base value followed by an incremental number (5 characters on remotes, 7 

characters on the host) from the Infor CRM key file of the machine creating the file. 
• Q5AH: Site code of the machine designated to receive the file (the TO site code). You can find a 

list of user site codes in the Administrator Users view (Remote Users tab). 

In all cases, either the FROM site code or the TO site code are the Infor CRM Synchronization Server 
machine. You can find the Sync Server site code in the office profile (Sync Options tab). You can find a 
list of user site codes in the Users view (Remote Users tab). 

What is the purpose of the sync conflict transaction viewer? 
The SyncConfTranViewer utility is located in C:\Program Files\Saleslogix. This utility allows you to view 
the contents of a ConfTran.stm file which stores rejected conflicts and accepted transactions on the 
Sync server. This file is typically located here: 
C:\ProgramData\Saleslogix\Sync\SRVXX\SQLEXPRESS-DBNAME where “DBNAME” is the name of 
your database. The contents of a ConfTran file includes the following values:  

• User 
• Date 
• Table 
• Field 
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• Primary value 
• Site code 

What is the purpose of the resynchronize databases utility? 
Use the Resynchronize Database feature when a remote/offline user cannot synchronize normally 
because they have not synchronized for a long period or their synchronization log files (Infiles, Outfiles, 
Archives) are destroyed. If the remote database is not corrupted, you can resynchronize to recover the 
remote user's data. Matching records are updated on the Host database and records not matching are 
inserted. 

Resynchronize Database transfers information from the remote database to the main office database. If a 
record on the remote database was modified earlier than the same record on the Host, it isn’t recovered. 

If Log Changes is enabled in the utility, all changes are logged and synced to any existing remote users 
or offices. To avoid overwriting the information you’re trying to recover from this remote, Infor CRM 
recommends opening this user's User Profile Sync tab and clearing the synchronize changes check box. 

 

 

After resynchronizing the database, you must create a new remote database for the user 
to continue using Infor CRM. 

What is the purpose of remote tasks? 
Remote tasks allow you to create and execute tasks for one or more remote offices or remote users. 
These tasks may carry out a variety of actions including sending files, executing programs, retrieving files, 
and deleting files. You can combine several actions in a single remote task and control the order in which 
they execute. The tasks are added as transactions, delivered, and performed on the remote user or 
remote office computer through synchronization. 

After remote tasks are delivered to the remote they must be manually executed. You can also automate 
remote tasks by scheduling them to run as an agent to perform the same duties on the remote database. 

 

 

Agents can perform automatic, regularly scheduled tasks for both network and 
remote/offline users. You’ll learn more about agents in a later lesson. 

 



 

232  Lesson 14: Remote Network Client setup 
  

 © 2018 Infor Education. All rights reserved. No part of this Training Workbook may be reproduced or transmitted in any form, without written permission. 

Exercise 14.3: Creating and applying a remote task 
In this exercise, you will create a remote task and initiate synchronization. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
I want to send all remote users training documentation on using Remote Client features. How 
do I create a remote task to send a PDF file to Lee Hogan and then launch the document in 
Acrobat Reader? 

• Create a remote task with two actions: 1) Create an action to send the file (PDF) to 
the user and 2) Create an action to execute the file in Acrobat Reader. 

• Apply the task by cycling the Sync server and Sync Client. 

Exercise steps 

Part 1: Create a remote task 

1. Open Infor CRM Administrator. 

2. Type admin in the Username field. No password is required. 

3. Verify the INFORCRM_EVAL data link is selected. 

4. Click Systems from the Navigation Bar.  

5. Click the Remote Tasks tab. 

6. Right-click in the workspace and then click Add Task. The Remote Task window opens. 

7. Type Getting Started in the Description text box. 

8. Select Lee Hogan from the list of Available Remotes and then click the right arrow to move him 
to the Selected Remotes list. 

9. Right-click in the Actions to perform pane and then click Add. The Add Action window opens. 

  Click here to view a demo and/or practice this task 

https://campus2.infor.com/courses/SIMS/player.htm?file=Infor%20CRM%20(Saleslogix)/v8.4/Administering/CreateAndApplyARemoteTask.mp4
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10. Select the Send radio button. 

11. Browse to C:\ClassFiles\ImpAdmin\Library\Getting Started with Infor CRM Windows 
Client.pdf in the File/Command field. This location identifies where the file currently resides. It 
can be a network or local location. 

12. Type C:\ClassFiles in the Target Directory field. This location identifies where the file is saved on 
the remote user’s computer. 

13. Click OK. 

 
14. Right-click in the Actions to perform pane and then click Add. The Add Action window opens. 

15. Select the Execute radio button. 

16. Set the File/Command to the following (including the quotation marks and a space between each 
command): 

"C:\Program Files (x86)\Adobe\Acrobat Reader DC\Reader\AcroRd32.exe" 
"C:\ClassFiles\ImpAdmin\Library\Getting Started with Infor CRM Windows Client.pdf" 
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Note: The location of Acrobat Reader may be different on your machine. Please verify the 
location first. 

17. Click OK. 

18. Click OK again to close the Remote Task window. 

19. Right-click the Getting Started task in the System Information view and then click Execute. 
This action tells Infor CRM to execute this task the next time the Sync server runs. 

20. Click Yes in the Confirm window. 

21. Press F5 to refresh. Click the Remote Tasks tab to verify the task has executed. 

Part 2: Initiate synchronization 

1. Sign in to the Synchronization Server as admin using the INFORCRM_EVAL data link. No 
password is required. The Sync Server window opens. 

2. Click Sync Now. 

3. Close the Synchronization Server once the sync is complete. 

4. Open the following folder: C:\inetpub\wwwroot\HTTPSync\Outfiles 

5. This directory contains two TEFs that the Sync Client will pick up the next time it cycles. 

 
6. Sign in to the Synchronization Client as lee using the SLXRemote data link. No password is 

required. The Saleslogix Synchronization Client window opens. 

7. Click Sync Now. 

When the sync is complete, the remote task executes the Adobe Reader and opens the delivered 
PDF. 

The Synchronization Client waits to perform cleanup until you close Adobe Acrobat Reader. 

8. Close Acrobat Reader. 

9. Close the Synchronization Client. 
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Check your understanding 
 

 
How does a remote task work? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What happens on the remote machine during the synchronization process? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Can client installations be automated? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

 

 
What is the purpose of a TEF file? 

 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 
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Course summary 
Estimated time 
5 minutes 

Course objectives 
Now that you have completed this course, you should be able to: 

• Users. 
• Teams and departments. 
• Maintenance. 
• Security: Lan and Web. 
• Enhancements and Integrations. 
• Web Client customization. 
• Installation of Client components. 

Topics 
• Course review 
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Appendices 
The following are included in this section: 

• Appendix A: Learner user accounts 
• Appendix B: Building test environments 
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Appendix A: User accounts 
Your instructor will assign you a student user ID from the table listed below to use for class exercises. 
Note: If you are taking this course as self-directed learning, refer to the Training Desktop Login 
Instructions on the Lab On Demand page. 
 

Application User name Password 

Infor CRM Admin <blank> 

SQL sysdba Ma$t3rk3y 
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Appendix B: Building test environments 
Having test environments to test installation of upgrades, new customizations, or new administrative and 
security rules is an important part of any production system. The following steps will show you how to 
create a Windows or Web development/test environment. 

 

Exercise B.1: Create a Windows development/test environment 
In this exercise, you will restore the database under a new name, modify the logging paths in 
the test database, create a connection to the test database, and create a test data link and 
install customization bundle. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 

 

Scenario 
My company’s developer handed me a customization bundle (sxb). I’ve budgeted five hours 
for testing during which time users cannot be signed in (entering data) in case I need to 
restore the database to its previous state. How do I create a test environment so I don’t take 
the production environment down for this long? 

• Backup the saleslogix_eval database as an example. Use the defaults provided by 
Microsoft SQL Server 2012. 

• Restore the database under a new name. 
• Modify the logging paths in the test database. 
• Create a connection to the test database. 
• Create a data link to the test connection and install customization bundles. 

Exercise steps 

Part 1: Restore the database under a new name 

Start by backing up the database. Since you already did this in the training environment you can use the 
same backup file: C:\Program Files\Microsoft SQL Server\MSSQL11.SALESLOGIX \MSSQL\ 
Backup\saleslogix_eval.bak.  

Now, let’s restore the database under a new name. 

1. Select Start > All Programs > Microsoft SQL Server 2012 > SQL Server Management 
Studio. The Connect to Server window opens. 

2. Verify Windows Authentication is selected in the Authentication field. 

3. Click Connect. 

4. Expand SRV10\SQLEXPRESS from the Object Explorer. 
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5. Right-click Databases and then select Restore Database. The Restore Database window 
opens. 

6. Select the Device radio button and then click the ellipses. The Select backup devices window 
opens. 

7. Verify File is selected from the Backup media type drop-down list. 

8. Click Add. The Locate Backup File – SRV10\SQLEXPRESS window opens. 

9. Select saleslogix_eval.bak. 

10. Click OK. 

11. Click OK again to close the Select backup devices window. 

12. Type inforcrm_eval_test in the Database field within the Destination pane. 

This value is important because you want to restore it under a new name which allows you to 
create a clone of the production environment so you can keep the production environment 
running seamlessly while testing. 

13. Click the Files page. 

14. Select the Relocate all files to folder check box. 

15. Click the cell in the Restore As column and change saleslogix_eval to inforcrm_eval_test.mdf 
and inforcrm_eval_test_log.ldf for the data and log file rows, respectively. 

 
This backup set points to the default file location: C:\Program Files\Microsoft SQL 
Server\MSSQL10_50.SQLEXPRESS\ MSSQL\Backup\saleslogix_eval.bak. 

16. Click the Options page. 

17. Select the Overwrite the existing database (WITH REPLACE) check box. 

18. Select the Preserve the replication settings (WITH KEEP_REPLICATION) check box. 

19. Click Script. 

20. Close the Restore Database – inforcrm_eval_test window. 

21. Click Execute. 

22. Refresh the Project Explorer when the query successfully executes.  
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Part 2: Modify the logging paths in the test database 

While you are testing, you don’t want any of your remote users to accidentally receive any new records or 
other changes you might make in the test database. Additionally, if you plan to add sample library items 
or attachments during your test, you don’t want network users to see them. Removing the production 
logging path from a few tables in our test database prevent these potential faulty data changes for 
production users. 

1. Expand inforcrm_eval_test > Tables from the Object Explorer. 

2. Right-click the sysdba.SYNCSERVER table and then click Edit Top 200 Rows. 

3. Click inside the SERVERPATH cell in the record for your sync server. 

4. Press CTRL-0 to set the field to Null. Note: Deleting the text leaves an empty string. 

 
5. Close the sysdba.SYNCSERVER table. 

6. Right-click the sysdba.BRANCHOPTIONS table and then click Edit Top 200 Rows. 

7. Click inside the ATTACHMENTPATH cell in the record for your sync server. 

8. Press CTRL + 0 to set the field to Null. 

9. Click inside the SALESLIBRARY cell in the record for your sync server. 

10. Press CTRL-0 to set the field to Null. 

11. Close the sysdba.BRANCHOPTIONS table. 

12. Close Microsoft SQL Server Management Studio. 

Part 3: Create a connection to the test database 

1. Select Start > All Programs > Saleslogix > Connection Manager on the administrator 
workstation. The Saleslogix Connection Manager window opens.  

2. Click Add. The Connection Name window opens.  

3. Type INFORCRM_EVAL_TEST in the Name used to refer to this connection field. 

4. Click OK. The Data Link Properties window opens. 

5. Select SQL Server Native Client 11.0 on the Provider tab and then click Next. 

6. Click the Connection tab. 

7. Type SRV10\SQLEXPRESS in the Select or enter a server name field.  

8. Type sysdba in the User name field. 

9. Clear the Blank password check box. 

10. Type Ma$t3rk3y in the Password field. 

11. Select the Allow saving password check box. 

12. Select inforcrm_eval_test from the Select the database drop-down list. 

13. Click Test Connection. A confirmation window opens. 
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14. Click OK. 

15. Click the All tab. 

16. Double-click the Persist Security Info value. The Edit Property Value window opens. 

17. Select True from the Property Value drop-down list. 

18. Click OK. 

19. Double-click the Integrated Security value. The Edit Property Value window opens. 

20. Click Reset Value. 

21. Click OK. 

22. Click OK again to close the Data Link Properties window. 

23. Click Apply within the Saleslogix Connection Manager window. 

24. Click OK. 

Part 4: Create a test data link and install customization bundles.  

1. Open Infor CRM Administrator. 

2. Click the ellipses in the Log on to field. The Data Link Manager window opens. 

 
3. Click Add. The Data Link Properties window opens. 
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4. Select Saleslogix OLE DB Provider. 

5. Click the Connection tab and set the following properties: 

• Server: SRV10 
• Database name: INFORCRM_EVAL_TEST 
• User Name: admin 

6. Click Test Connection to verify a valid connection. 

7. Click OK.  

8. Click OK again. The Connection Name window displays. 

9. Verify the name is set to INFORCRM_EVAL_TEST. 

10. Click OK.  

11. Click OK again. 

12. Click OK once more in the Please log on window. 

13. Click the Bundles Nav Bar. 

14. Click Install. 

Let’s stop here in the training environment as you have no customization bundles to install. 

15. Click Cancel. 

After installing bundles and releasing plugins, sign in to the Infor CRM Windows Client using the 
TEST data link to test the customizations and enter sample data without affecting production 
users. When satisfied with your test, complete the following steps: 

• Ensure all Infor CRM users are signed off production. 
• Create another backup of the production database to capture any changes made by users 

since your last backup. 
• Sign in to the Administrator using the production data link (INFOR CRM). 
• Install the bundle and release plugins. Production users can see customizations the next time 

they sign in to the Infor CRM Windows Client. 

Keep the TEST connection and data link (e.g. inforcrm_eval_test database) for future testing or 
development purposes. When required, you can simply back up the production database and 
restore it under the existing TEST database, modify the logging paths, and log in to the Infor CRM 
client to test your latest bundle or change without having to create a new connection or data link. 

 

Exercise B.2: Create a Web development/test environment 
In this exercise, you will install web customization bundles and create a test deployment. 

Notes: 

• If you are taking this course as classroom or virtual instructor-led training, observe as 
your instructor first demonstrates this exercise. 

• If you are taking this course as self-directed learning, complete the steps below. 
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Scenario 
My company’s developer handed me a customization web bundle (zip). I’ve budgeted five 
hours for testing during which time users cannot be signed in (entering data) in the event I 
need to restore the database to its previous state. How do I create a test environment so I 
don’t take the production environment down for this long? 

• Backup the saleslogix_eval database as an example. (You already did this.) 
• Restore the database under a new name. (You already did this.) 
• Modify the logging paths in the test database. (You already did this.) 
• Create a connection to the test database. (You already did this.) 
• Create a data link to the test connection. (You already did this.) 
• Install web customization bundle. 
• Create a new test website and deployment. 

Exercise steps 

 

A typical Infor CRM Web or Mobile development/test environment requires the same steps as 
an Infor CRM Windows environment backing up the database, restoring it under a new name, 
modifying the logging paths of the test database, creating a connection to the test database, 
and creating a data link to the test connection. Because you’ve already completed these 
steps in the training environment, you can move to the next step in the process. 

Part 1: Install web customization bundles 

1. Open Application Architect on the administrator workstation. 

2. Type admin in the Username field and use the INFORCRM_EVAL_TEST data link. No password 
is required. 

3. Click OK. 

4. Select View > Project Explorer from the menu bar. 

5. Right-click the VFS on INFORCRM_EVAL_TEST and then click Install Bundle. 

Let’s stop here in the training environment. You have no customization bundles to install. 

6. Click Cancel. 

After installing bundles, you would rebuild the web platform.  

Part 2: Create a test deployment 

Creating a test deployment ensure you don’t overwrite the production website with the test website files. It 
also allows you to sign in to Infor CRM Web and enter test data without affecting production users. 

1. Open the Deployment Explorer by selecting View > Deployment Explorer from the menu bar. 

2. Expand the Deployments node and double-click Core Portals. 

3. Click the SlxClient deployment. 

4. Set the Virtual Directory and Sub Directory to icrmClientTest within the IIS Portal 
Configuration pane. 

5. Click Save. 
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6. Click Deploy. 

 
When the deployment completes, a new icrmClientTest virtual directory appears in IIS under the 
Infor CRM website. The connection.config inside C:\inetpub\wwwroot\SlxClient_test references 
the Initial Catalog as INFOR_EVAL_TEST. 

Sign in to the Infor CRM Web Client using the http://srv10:3333/icrmClientTest URL to test the 
customizations and enter sample data without affecting production users. When satisfied with 
your test, complete the following steps: 

a. Ensure all Infor CRM users are signed off production. 
b. Create another backup of the production database to capture any changes made by users 

since your last backup. 
c. Sign in to the Application Architect using the production data link (INFOR CRM). 
d. Install the web bundle, build the web platform, and deploy the SlxClient portal. Production 

users see the customizations the next time they sign in to the Infor CRM Web Client: 
http://srv10:3333/slxclient 

Keep the TEST connection and data link (e.g. inforcrm_eval_test database) for future testing or 
development purposes. When required, you can simply back up the production database and 
restore it under the existing TEST database, modify the logging paths, and log in to the Infor CRM 
client to test your latest bundle or change without having to create a new connection or data link. 


	About this workbook
	Course overview
	Course description and agenda

	Lesson 1: Introduction to the Infor CRM Web Client
	The Infor CRM environment
	The training environment
	Getting to know the sample data

	Navigate within Infor CRM
	Demo: Navigating Infor CRM
	Using the Nav Bar
	Using the menu bar
	Using shortcut/context menus (right-click) 
	Editing items in a grid
	Using the toolbar
	Views in the Web Client
	Using the status bar
	Using the task pane
	Navigating records
	Lookup
	Infor CRM Help

	What’s new
	General enhancements
	Web Client enhancements
	Back Office Integration enhancements
	Ming.le Integration enhancements
	Web Client Administrator enhancements
	Mobile enhancements


	Lesson 2: User setup
	About users
	New user checklist
	About creating new users 
	What user types are available?
	What method(s) can I use for creating users?

	Create users in the Web Client
	Understand administrator and user security differences in the Web Client
	Create users manually
	Exercise 2.1: Create a user manually in the Web Client
	Scenario
	Add users from a template
	Exercise 2.2: Create a user template and new user in the Web Client
	Change a user’s profile settings
	Change a user’s type
	Exercise 2.3: Edit a user’s profile settings in the Web Client
	Scenario
	Edit user options
	Exercise 2.4: Edit a user’s options in the Web Client
	Scenario

	Create users in the Windows Client 
	Exercise 2.5: Creating users in the Windows Client

	Customize settings in the Windows Client
	Changing a user’s profile
	Manage a user’s password
	Exercise 2.6: Edit a user’s profile settings in the Windows Client

	Check your understanding

	Lesson 3: Team and department setup
	About teams and departments
	Using teams
	Team considerations
	Team restrictions
	Team hierarchy rules

	What is a Team Owner?
	Using departments
	Department considerations


	Manage teams and departments in the Web Client
	Exercise 3.1: Managing teams and departments in the Web client

	Manage teams and departments in the Windows Client
	Exercise 3.2: Managing teams and departments in the Windows client

	Check your understanding

	Lesson 4: Introduction to Infor CRM security
	How Infor CRM handles security
	Windows security
	Web security
	User security
	Security features

	Manage field security
	Exercise 4.1: Managing field security
	Scenario
	Exercise 4.2: Applying field security
	Scenario

	Account ownership
	Overview of account ownership
	Exercise 4.3: Managing account ownership
	Exercise 4.4: Exploring account ownership

	Check your understanding

	Lesson 5: Sync Server setup
	About synchronization
	Where should I install the Sync Server?
	Does synchronization require a license?
	Exercise 5.1: Adding a Sync Server license
	Scenario

	Synchronization folders on the server
	What happens the first time you run the Sync Server?
	What is the purpose of the SyncLogs subfolders?
	What is the purpose of the other Sync Server folders?
	Folder considerations for virus-checking software
	What happens when the Sync Server process is run?
	Exercise 5.2: Starting the Synchronization Server
	Scenario

	Sync Server schedules
	Why run synchronization as a service?
	How often should the synchronization service run?
	Exercise 5.3: Scheduling the Synchronization Server
	Scenario

	Conflict resolution
	What is conflict resolution?
	What happens to a rejected transaction?
	Exercise 5.4: Setting conflict resolution rules
	Scenario

	Sync transfer profiles
	Why use a network sync transfer profile?
	Why use an FTP sync transfer profile?
	Why use an HTTP sync transfer profile?
	Exercise 5.5: Creating an HTTP sync transfer profile
	Scenario

	Check your understanding

	Lesson 6: Remote/Offline database setup
	Remote/Offline user configuration
	Subscription Rules: What account records are included in a remote database?
	Attachment Filters: What documents are sent to remotes?
	What’s New Options: What changes were made since the last sync?
	History Options: Do history records expire?
	Create remote databases
	Exercise 6.1: Configuring user sync options
	Scenario
	Exercise 6.2: Creating a remote user database
	Scenario
	How do remote users receive their remote database files?
	How do remote users attach their database files?
	How do users sign in to Infor CRM when remote?
	Exercise 6.3: Attaching a remote database
	Scenario

	Check your understanding

	Lesson 7: System maintenance
	Data backup and recovery
	Can I restore the Infor CRM database on another server?
	How can I tell when users are signed on?
	Exercise 7.1: Backup and restore a database
	Scenario

	Data maintenance tools
	What tool should I use to search and replace data?
	What tool should I use to delete a group of records?
	What tool should I use to find and resolve missing or invalid references?
	What tool should I use to find and resolve duplicate records?
	Windows Client duplicate checker
	Web Client duplicate checker

	Exercise 7.2: Checking for duplicate records
	Scenario

	System upgrades
	Where do I find updates and service packs?
	What steps are involved in an upgrade?

	Customizations
	Windows customizations
	Web customizations
	Mobile customizations

	User maintenance
	What happens when a user leaves and no longer requires Infor CRM?
	Exercise 7.3: Realigning activities and changing a user’s type
	Scenario

	Check your understanding

	Lesson 8: Integrations and enhancements
	About integrations and enhancements
	Different integrations for Infor CRM
	Intelligent Open Network (ION)
	Advanced Analytics
	Back Office Extension (BOE)
	Ming.LE
	Desktop enhancements
	Xbar 


	Web Client integrations Nav Bar
	SData Sync Configuration
	Integrations
	ERP Persons
	Outbound Trans


	Lesson 9: Web security
	Web security
	About secured actions
	Exercise 9.1: Creating secured actions and assigning them to a user interface item

	About roles
	Default roles
	Exercise 9.2: Managing roles
	Exercise 9.3: Exploring roles and secured actions

	Check your understanding

	Lesson 10: Personalize the Infor CRM Web Client
	About personalization
	Personalize resources
	Literature items
	Resources
	Exercise 10.1: Creating literature items and resources
	Products
	Packages
	Exercise 10.2: Products and packages

	Personalize selections
	Competitors
	Exercise 10.3: Adding a competitor
	Lead sources
	About qualifications
	Exercise 10.4: Adding lead sources and qualifications
	Pick lists
	Exercise 10.5: Modifying and adding pick lists
	Groups
	Groups with conditions
	Conditions tab

	Groups without conditions

	Group Manager
	Groups
	Shares
	Usage

	Exercise 10.6: Groups and group manager

	Check your understanding

	Lesson 11: Customize the Infor CRM Web Client
	About customizations
	Form Manager customizations
	Form Manager Nav Bar
	Form Designer
	Exercise 11.1: Customizing forms with Form Designer

	Entity Manager customizations
	Entity Manager
	Exercise 11.2: Exploring Entity Manager

	Development level customizations
	Make your own entities
	Make your own forms
	Create custom relationships
	Use .NET or other languages for customer business rules
	Customization example

	Check your understanding

	Lesson 12: Windows security
	Windows security
	Managing administrative roles
	Exercise 12.1: Create and assign an administrator roles
	Scenario

	Set user security in the Windows Client
	Feature Security: Prevent users from adding or deleting records
	Function Security: Prevent users from using interface items
	Exercise 12.2: Set custom feature and function security

	Check your understanding

	Lesson 13: Prepare the Windows Client
	Install the Windows Client
	What’s included in a typical Windows Client installation?
	Can I automate client installations?
	What settings should I adjust in the client after installation?
	Exercise 13.1: Installing an Infor CRM Windows Client
	Scenario

	Establish a database connection
	Exercise 13.2: Create a database connection
	Scenario
	Exercise 13.3: Installing Infor CRM Administrator
	Scenario

	Explore the Manage toolbar
	Database
	Global Join Manager 
	Pick lists
	Lookups
	Currency
	Calculated fields
	Exercise 13.4: Exploring the Manage menu
	Scenario

	Explore the Tools toolbar
	Integrity Checker
	Systems Summary report
	Options
	Client view
	Client events
	Client plugins
	System
	Database
	Conflicts
	Passwords
	Outlook
	Accounting
	Custom


	Check your understanding

	Lesson 14: Remote Network Client setup
	Remote Client installation (Windows)
	What’s included in a typical Remote Client installation?
	Import wizard implications

	Can I automate client installations?
	Exercise 14.1: Install the Remote Client (Windows)
	Scenario

	Synchronization folders on the client
	What happens the first time you run the Sync Client?
	What is the purpose of the sync subfolders?
	Exercise 14.2: Run the Synchronization Client
	Scenario

	Synchronization utilities
	What is the purpose of the transaction viewer/analyzer?
	About TEFs
	What is the purpose of the sync conflict transaction viewer?
	What is the purpose of the resynchronize databases utility?
	What is the purpose of remote tasks?
	Exercise 14.3: Creating and applying a remote task
	Scenario

	Check your understanding

	Course summary
	Appendices
	Appendix A: User accounts
	Appendix B: Building test environments
	Exercise B.1: Create a Windows development/test environment
	Scenario
	Exercise B.2: Create a Web development/test environment
	Scenario



